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What’s new

What’s new in Compressor
Compressor 5.0 includes the following features and enhancements:

Apple Immersive Video packaging
Prepare Apple Immersive Video files for playback and HTTP live streaming on 
Apple Vision Pro. See Create an Apple Immersive Video package.

Apple Creator Studio
Compressor is now included in Apple Creator Studio, a subscription-based collection 
of apps for video, music, and creative imaging. See What is Apple Creator Studio? 
Compressor is also available as a one-time purchase.

System requirements
The minimum system requirement for Compressor 5.0 is macOS Sequoia 15.6. For more 
information, see the Apple Support article About Apple Creator Studio.

https://support.apple.com/125029#specs
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Get started

What is Compressor?

Compressor is an application that transcodes media files into a variety of formats.

Export and display anything
•	 Export video for viewing on Apple devices in standard-definition (SD), high-definition 

(HD), and 4K formats (including H.264, HEVC, and MV-HEVC).

•	 Export spatial video and Apple Immersive Video packages for viewing on 
Apple Vision Pro.

•	 Export 360° video viewable on video-sharing websites or in a virtual-reality (VR) 
headset.

•	 Export a wide variety of audio and video formats compatible with social platforms  
and podcasting.

•	 Export HDR video for viewing on HDR-capable TVs and displays.

•	 Add audio and video effects like watermarks, text overlays, fade-in and fade-out, and 
overall gain.

•	 Prepare iTunes Store packages and IMF packages for distribution.
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Leverage built-in presets and destinations
Compressor comes with built-in presets that you can use to transcode files into the most 
common media formats.

Compressor also provides preconfigured destinations that transcode files and then 
perform actions on the transcoded files.

Customize your output for efficiency
In addition to transcoding source files, you can use Compressor to:

•	 Create custom presets and destinations tailored to your unique transcoding workflows, 
or create a custom location to configure your own filename formats.

•	 Create custom transcoding presets for use in Final Cut Pro and Motion projects.

•	 Create watch folders and Compressor droplets that allow you to initiate custom 
transcoding jobs by dragging and dropping files right on your desktop.

Compressor workflow
The basic process of transcoding files in Compressor is described below.

Import your media into Compressor
The first step in the transcoding process is to add one or more source files to Compressor. 
You can add media files from your computer or a connected storage device. Each source 
file is called a job. Each transcoding session, containing one or more jobs, is called a batch. 
See Intro to importing media.

Apply transcoding instructions
After you add source media, apply transcoding instructions to it. Compressor provides 
a variety of preconfigured transcoding instructions called presets, which you can use 
to convert files to the most common media formats. You can also use destinations, 
which combine presets and a post-transcoding action. See Intro to applying transcoding 
instructions.

Preview and transcode your media
After you apply transcoding instructions, you can preview the output, then click the  
Start Batch button to begin the transcoding process. You can monitor the progress of  
the transcoding in Active view. After transcoding is complete, you can see information 
about the presets or destinations you used in Completed view. See Intro to previewing  
and transcoding.

You can also automate your workflow with droplets and watch folders, or work with more 
complex file types like stereoscopic media, 360° video, captions, and more.
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Compressor interface
The Compressor window has three views: Current, Active, and Completed. You can switch 
between these views by clicking a view button at the top of the window.

Current view is the default view in Compressor, where you can set up your transcoding 
jobs, configure Watch Folders, and find and customize presets, destinations, and locations.

 Tip: You can return to Current view with all panes closed by choosing Window > Reset 
to Default Layout.

Set up and preview transcoding jobs in the Batch pane
In the Batch pane of Current view, you can prepare and submit transcoding jobs in batches.

The Batch pane has two basic areas, one for previewing your media files and the other for 
displaying the transcoding batches to be processed in a given session.

•	 Preview area: A viewer with playback controls that shows how your media file will look 
and sound after transcoding. In this area you can also add metadata and markers to be 
included in the transcoded file.

•	 Batch area: A list under the preview area that displays information about the 
transcoding jobs in your current batch.

At the bottom of the batch area is the Start Batch button, which tells Compressor to 
start transcoding all the jobs in your batch. See Transcode a batch.

Configure watch folders in the Watch Folders pane
In the Watch Folders pane of Current view, you can set up watch folders in the macOS 
Finder and configure Compressor to automatically transcode files when they’re added  
to the folders.
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The Watch Folders pane displays the list of watch folders you’ve added to Compressor, 
along with the transcoding jobs that each watch folder applies to the files added to them.

For more information on creating watch folders, see Create and use watch folders.

Find presets, destinations, and locations in the Presets/
Locations pane
In Current view, you can click the Presets & Locations button  at the top-left corner of 
the Compressor window to expand the Presets/Locations pane.
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With the Presets/Locations pane expanded, you can click Presets or Locations to display 
the individual panes.

•	 Presets pane: A list of all the built-in destinations and presets in Compressor, as well as 
any custom destinations or presets that you created.

•	 Locations pane: A list of all the built-in save locations in Compressor, and any custom 
save locations that you created.

You can apply presets, destinations, and locations to a job by dragging an item from these 
lists to the job in the batch area. See Intro to applying transcoding instructions.

Monitor transcoding progress in Active view
When you begin transcoding a batch, the Active view in Compressor displays status 
information about batches (and their constituent jobs) currently being transcoded. In this 
view, you can monitor progress bars as well as pause or cancel the transcoding process.
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Review completed transcoding jobs in Completed view
In Completed view, you can view information about batches and jobs that have been 
successfully transcoded, as well as information about jobs that failed to transcode.

A list of batches is shown on the left side of the window. Click a disclosure triangle beside 
a batch to see its constituent jobs and output files.

View and modify information about a selected item in the 
Inspector pane
When you select an item anywhere in Compressor, you can view more information about 
it or customize its parameters in the Inspector pane. Click the Inspector button  in the 
upper-right corner of the Compressor window to expand this area.
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The contents of the inspector pane change depending on what kind of item is selected.

•	 When you select a batch (by clicking the background of the batch area or selecting 
a batch in Active or Completed view), the Batch inspector appears, displaying basic 
information about the current batch.

•	 When you select a job in the batch area, the Job inspector appears; this area displays 
a summary of the source file’s transcoding format, an SDR or HDR badge that specifies 
whether the source file is a standard-dynamic-range or high-dynamic-range video,  
and controls for adding metadata and modifying job actions. See View and modify  
job properties.

Note: If you select a job in Active or Completed view, you can view information about 
the job, but you can’t modify any of its properties.

•	 When you select a preset in the Presets/Locations pane or the batch area, the General, 
Video, and Audio inspectors appear. These three panes contain adjustable properties 
that you can use to customize the preset. See View and modify a preset’s properties.

•	 When you select a destination in the Presets/Locations pane or the batch area, the 
Destination inspector appears, where you can adjust the destination description and its 
associated job action. See View destination properties and Add and modify job actions.

•	 When you select a location in the Presets/Locations pane or the batch area, the 
Location inspector appears, where you can adjust the save location and associated 
filename format. See Create custom locations and filename formats.

•	 If you add captions to a job, selecting the captions file in the batch area opens the 
Closed Captions inspector or Subtitles inspector.

Set up a simple transcoding job in Compressor
When you add a source file to Compressor and apply output instructions, you create a 
transcoding job. You can submit a single job for transcoding, or add more source files  
and output instructions, then submit a batch of jobs for transcoding.

1.	 In Compressor, click the Add File button in the batch area.

2.	 In the file window that appears, select a media file, then click Add.
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3.	 In the Presets window that appears, select one or more presets    or destinations    
from the list, choose a save location from the pop-up menu, then click OK.

The new job is displayed in the batch area with the transcoding instructions and a 
thumbnail of the source file. If you chose multiple presets or a destination with multiple 
outputs, each output appears in a separate row.

4.	 Optionally, do any of the following:

•	 Modify preset properties or add more presets.

•	 Add a job action to be performed after transcoding.

•	 Change the output’s save location.

•	 Adjust the output’s filename.

•	 Add additional jobs by importing more source media and applying transcoding 
instructions.

•	 Preview your media to see how output will look and sound after transcoding.

5.	 Click the Start Batch button in the lower-right corner of the batch area and, if 
necessary, follow the instructions to complete the transcoding process.

The Compressor window switches to Active view, where you can monitor the 
transcoding process. After transcoding is complete, you can see information  
about the presets or destinations you used in Completed view.

Subscribe to Apple Creator Studio

What is Apple Creator Studio?
Compressor is part of Apple Creator Studio, a subscription-based collection of apps 
designed to help you bring your ideas to life faster and easier than ever. The suite includes 
powerful apps for video, music, and creative imaging, as well as premium content and 
features for Apple productivity apps.
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Learn more about Apple Creator Studio
The Apple Creator Studio subscription includes Final Cut Pro, Logic Pro, Pixelmator Pro, 
Motion, Compressor, and MainStage. The subscription also unlocks premium content and 
intelligent features in Keynote, Pages, and Numbers.

To learn more:

•	 From Compressor: Choose Compressor > Learn About Apple Creator Studio.

•	 On the web: See the Apple Creator Studio webpage and the Apple Support article About 
Apple Creator Studio.

•	 In the App Store: Open the App Store app, search for “Apple Creator Studio,” then click 
Apple Creator Studio in Results.

Apple Creator Studio apps and features
An Apple Creator Studio subscription includes the following:

Category Apps included User guides

Video Final Cut Pro

Motion

Compressor

•	 Final Cut Pro User Guide for Mac/iPad

•	 Motion User Guide

•	 Compressor User Guide

Music Logic Pro

MainStage

•	 Logic Pro User Guide for Mac/iPad

•	 MainStage User Guide

Creative imaging Pixelmator Pro •	 Pixelmator Pro User Guide for Mac/iPad

Productivity Premium content and 
features for:

Keynote

Pages

Numbers

•	 Keynote User Guide for Mac/iPhone/iPad

•	 Pages User Guide for Mac/iPhone/iPad

•	 Numbers User Guide for Mac/iPhone/iPad

To subscribe to Apple Creator Studio, see Subscribe to Apple Creator Studio.

Subscribe to Apple Creator Studio from Compressor
You can try Apple Creator Studio for free. To begin your free trial, simply sign up for a 
monthly or annual subscription using your Apple Account. You can cancel your subscription 
at any time.

You can share your subscription with up to five other family members. See Set up Family 
Sharing in the Mac User Guide.

For details about Apple Creator Studio, see the Apple Support article About 
Apple Creator Studio.

https://www.apple.com/apple-creator-studio
https://support.apple.com/125029
https://support.apple.com/125029
https://support.apple.com/guide/final-cut-pro/welcome/mac
https://support.apple.com/guide/final-cut-pro-ipad/welcome/ipados
https://support.apple.com/guide/motion/welcome/mac
https://support.apple.com/guide/compressor/welcome/mac
https://support.apple.com/guide/logicpro/welcome/mac
https://support.apple.com/guide/logicpro-ipad/welcome/ipados
https://support.apple.com/guide/mainstage/welcome/mac
https://support.apple.com/guide/pixelmator-pro/mac
https://support.apple.com/guide/pixelmator-pro/ipad
https://support.apple.com/guide/keynote/welcome/mac
https://support.apple.com/guide/keynote-iphone/welcome/ios
https://support.apple.com/guide/keynote-ipad/welcome/ipados
https://support.apple.com/guide/pages/welcome/mac
https://support.apple.com/guide/pages-iphone/welcome/ios
https://support.apple.com/guide/pages-ipad/welcome/ipados
https://support.apple.com/guide/numbers/welcome/mac
https://support.apple.com/guide/numbers-iphone/welcome/ios
https://support.apple.com/guide/numbers-ipad/welcome/ipados
https://support.apple.com/guide/mac-help/mh3d6eb198/mac
https://support.apple.com/guide/mac-help/mh3d6eb198/mac
https://support.apple.com/125029
https://support.apple.com/125029
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Subscribe to Apple Creator Studio

When you open the Apple Creator Studio version of Compressor for the first time, you can 
sign up for a free trial.

1.	 Open Compressor, click Continue, then follow any onscreen instructions.

2.	 Click Accept Free Trial (or another available option), then follow the onscreen 
instructions to subscribe using your Apple Account.

Note: If you’re currently subscribed to Apple Creator Studio but still see Accept Free 
Trial (or another option), scroll down, click Already Subscribed? and follow the onscreen 
instructions.

3.	 To start transcoding, set up a transcoding job in Compressor.

Cancel or change your Apple Creator Studio subscription

1.	 Open Compressor, then choose Compressor > Manage Subscriptions.

The App Store opens, displaying your subscriptions.

Note: If you don’t see your subscriptions, make sure you’re signed in to your 
Apple Account in the App Store.

2.	 In the Subscriptions list, click Apple Creator Studio, then do any of the following:

•	 Modify your subscription plan: Click a different subscription option, then follow the 
onscreen instructions.

•	 Cancel your subscription or free trial: Click Cancel Subscription to end your free trial 
or paid subscription, then follow the onscreen instructions.

 Tip: To change or update your payment method in the App Store, click your name in 
the lower-left corner, click Account Settings, click Payment Methods, then follow the 
onscreen instructions.

If you cancel your subscription, you’ll continue to have full access to all app features until 
the end of your billing period.

Use the subscription apps and one-time-purchase apps on the same Mac

Compressor and several other Apple Creator Studio apps are also available individually 
as one-time purchases. Both the one-time-purchase apps and the Apple Creator Studio 
subscription apps can be installed on the same Mac, and you can edit your projects in 
either app version.

For the best experience, subscribe to Apple Creator Studio using the same Apple Account 
you use for iCloud. Some Apple Creator Studio apps sync projects, documents, and 
content between devices using iCloud.
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Import media

Intro to importing media in Compressor
The first step in transcoding media in Compressor is to import the files you want  
to transcode.

You can import a variety of different media formats, including:

•	 Standard video and audio

•	 Image sequences

•	 Surround sound audio

•	 ProRes RAW video

•	 Third-party formats with media extensions

•	 Canon Cinema RAW Light video

Once you’ve added source media, you can view or modify the job properties associated 
with specific source files in the Job inspector, then apply transcoding instructions and 
preview and transcode your media.

Import video and audio in Compressor
When you import source media to Compressor, you create a transcoding job to which you 
can add multiple presets or destinations that specify how your media will be transcoded.

Add jobs to a batch

In Compressor, do either of the following:

•	 Drag and drop source media directly into the batch area.
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•	 Click  under the batch area, choose Add File, select one or more media files, then 
click Add.

The batch area displays a new job for each source file you add.

Remove a job from a batch

•	 In Compressor, select the the source filename at the top of the job, then press the 
Delete key.

After you import source media, you can view and modify job properties, apply transcoding 
instructions, and transcode the batch.

Import an image sequence in Compressor
You can create an image sequence job in Compressor by importing a sequence of still 
images as an image sequence source file. Each image in the image sequence represents a 
single video frame.

1.	 In Compressor, do one of the following:

•	 Choose File > Add Image Sequence.

•	 Click  at the bottom of the batch area, then choose Add Image Sequence.

2.	 In the file window that appears, select a folder of image sequence files, then click Add.

A new image sequence job appears in the batch area of the Compressor window.

 Tip: You can view a list of the images in your image sequence job in the Image 
Sequence Files area of the Job inspector.
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3.	 In the Image Sequence Properties area of the Job inspector, do either of the following:

•	 Adjust the frame rate: Choose a frame rate for the image sequence file from the 
“Frame rate” pop-up menu, or type a custom value in the text field.

•	 Add audio: Next to “Audio file,” click Choose, select a file, then click Open.

After you import source media, you can view and modify job properties, apply transcoding 
instructions, and transcode the batch.

Import surround sound audio in Compressor
You can create a surround sound audio job in Compressor by manually assigning audio files 
to surround sound channels, or by appending audio filenames with channel identifiers that 
allow Compressor to automatically map the files to the correct surround sound channels.

Create a surround sound source file by manually assigning channels

1.	 In Compressor, do one of the following:

•	 Choose File > Add Surround Sound Group.

•	 At the bottom of the batch area, click , then choose Add Surround Sound Group.

The channel assignment dialog opens.

2.	 To assign a source audio file to each channel, click the icon for a specific channel, 
select a source audio file intended for that channel, then click Open.

3.	 To include a video file, click the Add Video button, select a video file, then click Open.

4.	 When you’re done setting up the surround sound group, click Add.

A new surround sound source media file appears in a job in the batch area.
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Create a surround sound source file using channel identifier codes

You can add channel identifier codes to the filenames of surround sound files in the macOS 
Finder, then add the files in Compressor.

1.	 In the macOS Finder, append the filename of each audio file with the appropriate 
channel identifier code:

•	 -L: Left front channel

•	 -R: Right front channel

•	 -C: Center front channel

•	 -Ls: Left surround channel

•	 -Rs: Right surround channel

•	 -S: Center surround channel

•	 -LFE: Low-frequency effects channel (subwoofer, LFE)

For example, if the audio file for your left front channel is named “final audio_left.aiff,” 
name the file “final audio_left-L.aiff.”

Note: Compressor will recognize source files with or without a file extension (.aiff or 
.wav, for example).

2.	 Import all of the renamed source audio files at the same time as one job.

A new job appears in the batch area.

Reassign or remove audio files in a surround sound job

1.	 In Compressor, select the surround sound job, then open the Job inspector.

2.	 In the Surround Sound Properties area of the Job inspector, do any of the following:

•	 Remove a file assigned to a channel: Click  next to the file you want to remove.

•	 Assign a different file to a channel: Click the channel icon (a speaker icon or 
subwoofer icon), then choose a new audio file from the menu that appears.
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•	 Remove all audio files: Click the Clear All button. This also removes the video file 
assigned to the surround sound source file.

Add video to a surround sound job

1.	 In Compressor, select the surround sound job, then open the Job inspector.

2.	 In the Surround Sound Properties area of the Job inspector, click the Add Video button.

3.	 In the file window that appears, select a video file, then click Open.

Once a video file has been added, its filename replaces the Add Video button.

After you import source media, you can view and modify job properties, apply transcoding 
instructions, and transcode the batch.

Import other video files

Import third-party formats with media extensions in 
Compressor
The Media Extensions feature built into macOS lets you use third-party media formats that 
aren’t natively supported in Compressor.

Note: The Media Extensions feature requires macOS Sequoia or later.

Install and turn on media extensions for third-party media formats

1.	 Download and install the media extension for the third-party media format you want  
to use.

2.	 Choose Apple menu  > System Settings.

3.	 Click General in the sidebar, then click Login Items & Extensions.
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4.	 In the Extensions section, click By Category (if available), then click the Info button next 
to Media Extensions.

5.	 Turn on any format readers, decoders, or processors for the media extension you 
installed (you may need to scroll down), then click Done.

6.	 Quit Compressor (if it’s open), then reopen Compressor.

You can now work with video encoded in that third-party media format.

Note: After turning on a third-party RAW processing plug-in, you can adjust RAW 
processing parameters.

View the status of media extensions in the Job inspector

1.	 Import a video source file that’s encoded in a third-party media format.

A new job appears in the batch area.

2.	 Select the job to view its properties in the Job inspector.

The Media Extensions section of the Job inspector displays any media extensions that 
are required to decode media in the selected job.

A green dot indicates that the media extension is being used to decode the selected 
source media. If a red triangle appears next to the media extension, there’s an issue. 
Click the Extension Settings button to open the Extensions section in System Settings 
and resolve the issue.

After you import source media, you can view and modify job properties, apply transcoding 
instructions, and transcode the batch.

Import Canon Cinema RAW Light video in Compressor
Compressor can import camera RAW video files in Canon format; however some additional 
steps may be required before import. The format requires installation of a vendor-specific 
plug-in. To learn which cameras work with Final Cut Pro, see the Apple Support article 
Cameras supported by Final Cut Pro.

1.	 From the Canon website, download the appropriate Canon plug-in for Final Cut Pro, 
then install the software on your Mac.

2.	 Import the media into Compressor.

Note: Canon Cinema RAW Light files have the filename extension .crm.

After you import source media, you can view and modify job properties, apply transcoding 
instructions, and transcode the batch.

Import and adjust RAW video in Compressor
You can import a variety of RAW video formats in Compressor, including Apple ProRes RAW 
and formats supported by third-party RAW processing extensions. After RAW processing is 
enabled, you can modify available RAW processing parameters.

For ProRes RAW video captured on supported iPhone models, Compressor’s RAW 
processing controls in the Job inspector allow you to apply denoising powered by  
machine learning (requires a Mac with Apple silicon).

https://support.apple.com/109504
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Import ProRes RAW footage and enable RAW processing

The first time you import ProRes RAW footage into Compressor, you must enable the 
Apple ProRes RAW media extension.

1.	 In Compressor, import a ProRes RAW video file.

2.	 Select the job containing ProRes RAW footage in the Compressor batch area.

3.	 In the RAW processing area of the Job inspector, click Extension Settings.

The Systems Settings app opens and shows available Media Extensions.

4.	 Turn on the Apple ProRes RAW Processor extension, then click Done.

You can now adjust RAW processing parameters in the Compressor Job inspector.

To enable RAW processing for formats other than ProRes RAW, see Import third-party 
formats with media extensions.

Adjust RAW processing parameters

Once you’ve enabled the Apple ProRes RAW Processor extension or another applicable 
third-party RAW processing extension, you can adjust RAW processing parameters  
in Compressor.

1.	 In Compressor, select a job containing RAW footage in the batch area.

2.	 In the job inspector, navigate to the RAW Processing section.

If you don’t see RAW processing parameters, you may need to enable the Apple ProRes 
RAW Processor extension or another third-party RAW processing extension.

3.	 View or adjust any of the available RAW processing parameters.

Note: The available parameters depend on the type of RAW format you’re working with. 
Third-party RAW formats may have different controls than those described below.

4.	 For ProRes RAW footage, adjust any of the following controls:

•	 ISO: Use the pop-up menu to override the ISO setting used to capture the RAW video.

•	 Exposure Bias: Drag the slider to fine-tune the ISO setting up or down by up to  
one stop.

•	 As-Shot White Balance: Deselect the checkbox to enable the Color Temperature slider.

•	 Color Temperature: Drag the slider to adjust the white balance camera setting along 
the blue-amber axis.

•	 RAW to Log: Use the pop-up menu to choose the method of encoding brightness and 
color information when converting the RAW video file.
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5.	 For ProRes RAW footage shot on iPhone, choose iPhone ProRes RAW from the 
Processing pop-up menu to view and adjust additional controls:

•	 Tint: Drag the slider to adjust the white balance camera setting along the 
green-magenta axis. Use to correct color casts that are not addressed by Color 
Temperature alone. This slider is available when As-Shot White Balance is 
deselected.

•	 Demosaic: Use the pop-up menu to choose the method for transforming RAW 
sensor data into a standard full-color RGB image. Choose Standard to apply the 
same demosaicing algorithm used in Standard processing, or Custom to enable the 
following controls:

•	 Color Noise: Drag the slider to correct color casts.

•	 Edge Contrast: Drag the slider to increase contrast between objects.

•	 Detail Enhancement: Drag the slider to increase overall image sharpening.

•	 ML Denoise: Use the pop-up menu to apply a machine-learning model to reduce 
the amount of noise in the image (at the expense of preview performance and 
transcoding speed)—Low, Medium, or High.

Note: This feature requires a Mac with Apple silicon.

6.	 To reset RAW processing parameters, do either of the following:

•	 Reset a single parameter: Click  next to the parameter you want to reset to its 
initial value.

•	 Reset all RAW processing parameters: At the bottom of the RAW Processing section, 
click the “Revert to” pop-up menu and choose an option.

After you import RAW footage and adjust available RAW processing parameters, you can 
view and modify other job properties, apply transcoding instructions, preview the media in 
non-RAW formats, and transcode the batch.

View and modify job properties in Compressor
When you add a source file to Compressor and apply transcoding instructions, you create a 
transcoding job. Jobs are displayed in the batch area of the Compressor window.

1.	 Select the job in the Compressor batch area.

2.	 If necessary, click  to reveal the inspector pane.

The selected job’s properties are displayed in the Job inspector. The properties that 
appear in the Job inspector vary depending on the type of source file in the job. See 
Job properties.

3.	 In the Job inspector, optionally adjust the available controls like timecode and duration, 
color space, and metadata annotations.
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Job properties in Compressor
When you import source media, Compressor detects various properties of the source 
media and displays them in the Job inspector. If you think the properties identified by 
Compressor are incorrect, you can modify them in the inspector.

Note: Not all properties are available for all job types.

Job summary
The top section of the Job inspector displays the source file’s name, location, video and 
audio encoding information, and duration.

If the source is a standard-dynamic-range video file, an SDR badge appears in the upper-
right corner of the summary area; if the source is a high-dynamic-range video file, an HDR 
badge appears in the upper-right corner.

When the Stereoscopic pop-up menu in the Job inspector is set to anything other than Off/
Monoscopic, a 3D badge appears next to the SDR or HDR badge.

Note: You can’t adjust the job summary directly, but it will automatically update to match 
any adjustments you make to the job properties below.

Media Extensions
Displays any media extensions that are being used to decode media in the selected job. 
See Import third-party formats with media extensions.

Timing
Controls that adjust the starting timecode, In point, and duration of the output file. See 
Modify timing and timecode.

File Properties
Controls that adjust the source media’s language and geographic information.

•	 Language: Use the pop-up menu to set the default language for the selected job.

•	 Country: After you’ve set a language, use the pop-up menu to set the country for the 
selected job.
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Image Sequence Properties
Controls that adjust the frame rate and audio file for an image sequence job. See Import an 
image sequence.

Surround Sound Properties
Controls that adjust the names of the files assigned to surround sound channels. See 
Import surround sound audio.

Video Properties
Controls that adjust how Compressor interprets various video properties of the source file.

Important: Updating these values in the Job inspector does not convert the field order or 
color space of your file during transcoding. To apply transcoding instructions that convert 
the field order or color space of your output, use the corresponding properties in the Video 
inspector when a preset is selected. See Video properties.

•	 Field order: This property determines what type of interlacing is present in the source 
file (if any). See Use deinterlacing.

•	 Color space: This property defines how Compressor interprets the color space of the 
source file. See Modify color space and HDR metadata.

Note: If you specify a log profile in the “Camera log” pop-up menu (described below),  
or you’re using ProRes RAW source footage with a value specified in the RAW to Log 
pop-up menu, the “Color space” pop-up menu is unavailable.

•	 Camera log: Use this pop-up menu to choose a log profile that corresponds with 
the source file, including Apple Log and Apple Log 2. Compressor will try to pick the 
appropriate camera log based on metadata in the source file, but you can manually 
override Compressor’s selection.

RAW Processing
Controls that display as-shot camera settings of RAW footage and allow you to adjust 
various RAW camera settings. See Import and adjust RAW video in Compressor.

Projection Properties
Controls that adjust how Compressor interprets stereoscopic or projection properties 
of the source media when you’re working with spatial video or 360° video. See Modify 
stereoscopic and spatial properties in Compressor and Work with 360-degree video.

Immersive Properties
When you import a set of immersive files, the Projection Properties area of the Job 
inspector is replaced by Immersive Properties. See Create an Apple Immersive Video 
package.

Job Annotations
Controls that adjust the annotation metadata in your output file. See Work with metadata.
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HDR Metadata
Controls that adjust the HDR metadata that’s passed to your export file. See Modify color 
space and HDR metadata.

Audio Properties
Controls that adjust audio track assignments in the source clip. Each track is displayed 
with an activation checkbox to include or exclude the audio track from the job, as well  
as a pop-up menu that determines the audio channel layout of the audio track. 

You can also add descriptive audio tracks in this section of the Job inspector. 

Image Sequence Files
An ordered list of image files in an image sequence job. See Import an image sequence.

Action
Controls for adding an automated job action to be performed after transcoding. See Add 
and modify job actions.

You can also use the “Save captions to disk” checkbox to save a separate captions file to 
your computer when you transcode a job that has captions. See Export captions.
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Apply transcoding instructions

Intro to applying transcoding instructions in 
Compressor
After you import source media in Compressor, apply transcoding instructions by doing any 
of the following:

•	 Add transcoding presets.

•	 Add a job action.

•	 Apply a destination to a job.

You can also make a variety of adjustments to your transcoding instructions:

•	 Choose a new save location or change an output’s filename.

•	 Modify frame size, frame rate, and color space.

•	 Add video and audio effects.

•	 Adjust metadata annotations.

After applying transcoding instructions, you can preview and transcode the batch.

Add presets

Add and remove transcoding presets in Compressor
A preset is a group of preconfigured transcoding instructions that you apply to a job  
in Compressor. For most transcoding jobs, you can use the built-in presets that come  
with Compressor.

Add a preset

1.	 After you add a job to a batch in Compressor, click Add on the right side of the job’s 
Preset/Location/Filename row.

2.	 In the window that appears, select one or more transcode presets , choose a save 
location from the pop-up menu, then click OK.
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Adding a preset to a job creates an output row, which also shows the output’s save 
location and filename.

 Tip: You can also add a preset by dragging it from the Presets pane onto a job in the 
batch area.

Remove a preset

To remove a preset in Compressor, do either of the following:

•	 Select the preset’s output row, then press Delete.

•	 Position the pointer over the preset’s output row, then click Remove (on the right side of 
the row).

View and modify a preset’s properties in Compressor
When you select a preset in Compressor, you can view its general, video, and audio 
properties and modify those properties as needed.

View a preset’s general, video, and audio properties

1.	 In Compressor, do either of the following:

•	 Select a built-in or custom preset in the Presets pane.
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•	 Select the output row for an applied preset in the batch area.

When a preset is selected, its properties are shown in the inspector pane.

2.	 To view general, video, or audio properties of the selected preset, click General, Video, 
or Audio at the top of the inspector pane.

Every preset has a General inspector that displays basic properties, including preset 
name, description, output extension, and so on. Video presets have a Video inspector 
and, if the transcoding format encodes audio, an Audio inspector. Audio presets have  
an Audio inspector but no Video inspector.

Modify an applied preset’s properties

1.	 In Compressor, select an applied preset’s output row in the batch area.

The properties of the selected preset are displayed in the inspector pane.

2.	 To view general, video, or audio properties, click General, Video, or Audio at the top of 
the inspector pane.
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3.	 To modify a property, adjust its control in the inspector pane.

Note: When you make adjustments to an applied preset, the adjustments are only 
made for the transcoding job to which the preset is applied. To save a preset with 
modifications that you use frequently, create a custom preset.

Built-in presets in Compressor
Use the built-in presets in Compressor, grouped by category in the Presets pane, to 
convert any file from its source format to other commonly used formats. For instance,  
you can use presets in the Podcasting category when exporting audio and video podcasts, 
or presets in the Social Platforms category when exporting content for social media.

Note: Some of Compressor’s built-in presets are grouped into destinations at the top of the 
Presets pane. See Built-in destinations.

Built-in preset group Contains Use to

Apple Devices •	 Apple Devices 4K

•	 Apple Devices 4K (HEVC 8-bit)

•	 Apple Devices 4K (HEVC 10-bit)

•	 Apple Devices 4K (HEVC 10-bit, 
HLG, Dolby Vision 8.4)

•	 Apple Devices HD (Best Quality)

•	 Apple Devices HD (Most 
Compatible)

•	 Apple Devices SD

•	 Apple Vision Pro (MV-HEVC, 
Stereoscopic)

Create Apple Device-compatible 
files for distribution, including HEVC 
(designed to optimize HDR content 
for Apple devices) and MV-HEVC 
(for outputting spatial video files to 
be viewed on Apple Vision Pro).

Audio Formats •	 AAC

•	 AC3

•	 AIFF

•	 Apple Lossless

•	 CAF

•	 EC3

•	 FLAC

•	 MP3

•	 WAV

Create audio files in the most 
commonly used formats.

Motion Graphics •	 Animated Image (Large)

•	 Animated Image (Small)

•	 Open EXR Image Sequence

•	 QuickTime Animation

•	 QuickTime ProRes with Alpha

•	 TIFF Image Sequence

Create files for use with motion 
graphics applications.

MPEG Files •	 MPEG-2 422 Program stream, 
15 Mbps

•	 MPEG-2 Program stream, 
15 Mbps

•	 MPEG-2 Transport stream, 
15 Mbps

Create broadcast-quality, high-
resolution, high bit rate video files.
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Built-in preset group Contains Use to

MXF •	 Apple ProRes 422

•	 Apple ProRes 422 HQ

•	 Apple ProRes 422 LT

•	 Apple ProRes 422 Proxy

•	 Apple ProRes 4444

•	 Apple ProRes 4444 XQ

•	 AVC Intra 100

•	 XDCAM HD 422

Create high-quality audio and video 
files packaged with metadata for 
use in post-production workflows.

Podcasting •	 AAC for Audio Podcasting

•	 H.264 for Video Podcasting

•	 MP3 for Audio Podcasting

Create files for audio and video 
podcasting.

ProRes •	 Apple ProRes 422

•	 Apple ProRes 422 HQ

•	 Apple ProRes 422 LT

•	 Apple ProRes 422 Proxy

•	 Apple ProRes 4444

•	 Apple ProRes 4444 with Alpha

•	 Apple ProRes 4444 XQ

•	 Apple ProRes 4444 XQ with Alpha

Create high-quality, high-
performance files for use with 
Final Cut Pro and post-production 
workflows.

Proxy •	 H264 Proxy eighth size

•	 H264 Proxy half size

•	 H264 Proxy quarter size

•	 HEVC Proxy eighth size

•	 HEVC Proxy quarter size

•	 HEVC Proxy half size

•	 ProRes Proxy eighth size

•	 ProRes Proxy half size

•	 ProRes Proxy quarter size

Create proxy files for use with 
Final Cut Pro and post-production 
workflows.

Social Platforms •	 4K

•	 HD 720p

•	 HD 1080p

•	 Large 540p

•	 SD 480p

•	 Small

•	 Up to 4K

Create QuickTime movie files for 
video-sharing websites like Vimeo.

Uncompressed •	 Uncompressed 10-bit 4:2:2

•	 Uncompressed 8-bit 4:2:2

Create uncompressed QuickTime 
movie files.

If you have complex or custom transcoding specifications, you can make adjustments to 
built-in presets by modifying a preset’s properties or creating a custom preset.
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Create custom presets in Compressor
You can create your own custom presets based on an existing built-in or custom preset, or 
from scratch.

Before you create a custom preset, view the related built-in presets to see if any of those 
meet your needs. If one does, or if it comes close, you can duplicate that preset, then 
modify any properties that you need to change.

Create a custom preset by duplicating an existing preset

1.	 In the Presets pane in Compressor, select the preset you want to duplicate.

2.	 Click  at the bottom of the Presets pane, then choose Duplicate.

A copy of the preset appears in the Custom area of the Presets pane.

3.	 To name your custom preset, double click the copy of the preset, type a new name, 
then press Return.

4.	 To modify the properties of your new custom preset, adjust the controls in the General, 
Video, or Audio sections of the inspector pane.

Create a custom preset from scratch

You can also create a custom preset without duplicating a built-in preset. Because it’s easy 
to accidentally introduce transcoding errors, this method is recommended for advanced 
users only.

1.	 In the Presets pane in Compressor , click  at the bottom of the pane, then choose 
New Preset.

2.	 In the dialog that appears, choose a transcoding format from the pop-up menu, enter a 
name and description for the preset, then click OK.

The new preset appears in the Custom area of the Presets pane.

3.	 To modify the properties of your new custom preset, adjust the controls in the General, 
Video, or Audio sections of the inspector pane.

Create a custom preset from an existing video file

You can quickly make a custom preset that automatically matches the settings of an 
existing video file on your computer.

1.	 From the macOS Finder, drag a video file into the Custom area of the Presets pane in 
Compressor.

A new custom preset called Created from [filename] appears in the Presets pane.

2.	 To modify the properties of your new custom preset, adjust the controls in the General, 
Video, or Audio sections of the inspector pane.

Delete a custom preset

•	 In the Presets pane in Compressor, select a custom preset, then press Delete.
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Save and share custom presets in Compressor
You can save a custom preset as a file for use on another Mac.

Save a custom preset

•	 Drag a preset from the Presets pane in Compressor to the desktop on your Mac.

 Tip: You can also drag the custom preset directly to the body of an email message  
in Mail. The preset is saved as a file with the filename extension .compressorsetting.

Share a custom preset

•	 Copy, email, or AirDrop the preset file to another Mac.

Add a shared preset to Compressor

•	 Drag the preset file from the macOS finder into the Custom area in the Presets pane  
of Compressor.

Preset formats in Compressor
Compressor provides a variety of transcoding formats to create files playable in a variety 
of media platforms. Each of the built-in presets in the Presets pane uses a specific 
transcoding format compatible with industry standards.

You can see which format a preset is based on by looking at the summary information at 
the top of the inspector.

All of the built-in presets in Compressor, as well as any custom presets you create, are 
based on one of the following formats:

•	 Apple Devices: Encodes .mfv and .mov files designed to optimize output for playback 
on various Apple devices.

•	 Common Audio Formats: Encodes .aiff, .caf, .flac, and .wav audio files.

•	 Dolby Digital: Encodes .ac3 or .ec3 files that contain multiple audio channels, including 
5.1 surround sound.

•	 H.264 for Blu-ray/AVCHD: Encodes H.264 files for Blu-ray and Advanced Video Codec 
HD (AVCHD) for DVD authoring.

Note: Compressor does not directly support burning to disc, but third-party disc-
burning apps can use output files transcoded by Compressor.



33Compressor User Guide

•	 Image Sequence: Encodes a variety of image sequence file types used in motion 
graphics, including TIFF, OpenEXR, JPEG, PNG, animated PNG (APNG), and animated 
GIF.

•	 MP3: Encodes a .mp3 audio file.

•	 MPEG-2: Encodes MPEG-2 stream files for DVD and Blu-ray authoring in a third-party 
authoring application.

•	 MPEG-4: Encodes .mp4 or .m4a files that are widely compatible with many different 
platforms and are often used for distribution on the internet.

•	 MXF: Encodes a .mxf file that holds video or audio media along with metadata that 
describes the enclosed media’s attributes.

•	 QuickTime Movie: Encodes a .mov file appropriate for many uses, including a proxy 
workflow in Final Cut Pro.

The format of a preset determines which general, video, or audio properties are shown in 
the inspector pane.

Properties of presets

General properties of presets in Compressor

When you select a preset, its general properties appear in the General inspector.

Important: Not all properties or options are available for all transcoding jobs. The options 
shown depend on the type of source media you’re transcoding, the preset’s format, the 
configuration of other properties, and the hardware and software you’re using.

General property Preset formats Description

Name All preset formats Displays the name of the preset.

Description All preset formats Displays the description of the preset.

Extension All preset formats Displays the extension of the output file.

Allow export segmentation Apple Devices, Image 
Sequence, MPEG-2, 
MPEG-4, MXF, QuickTime 
Movie

Select this checkbox to have Compressor process 
the output file using a shared computer group. See 
Transcode with multiple computers.

Default location All preset formats For custom presets, use the pop-up menu to choose a 
default save location for transcoded files.

https://support.apple.com/guide/final-cut-pro/verb8e5f6fd/
https://support.apple.com/guide/final-cut-pro/verb8e5f6fd/
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General property Preset formats Description

Format Apple Devices, MPEG-2, 
MPEG-4, MXF, QuickTime 
Movie

Use this pop-up menu to specify whether the output 
includes video and audio, or video only.

For MPEG-2 presets, use this pop-up menu to choose 
an MPEG-2 stream type:

•	 Program stream: Contains only one content channel 
and its associated audio.

•	 Elementary stream: Contains only one content 
channel and no audio.

•	 Transport stream: Can contain several MPEG-
2 content channels and associated audio. All 
the channels are multiplexed together, allowing 
the playback device to choose which to play. 
Compressor supports creating single-channel 
transport streams that can also include associated 
audio.

Optimize for network use Apple Devices, MPEG-4, 
QuickTime Movie

Select this checkbox to create a file that will start 
playing after only a small portion of the file has been 
downloaded from the network.

File type/Image type Common Audio Formats, 
Dolby Digital, Image 
Sequence

Choose a file type or image type from the pop-up 
menu.

Stream usage H.264, MPEG-2 For H.264 presets, use the pop-up menu to set 
whether the output file is transcoded for Blu-ray Disc 
or AVCHD.

For MPEG-2 presets, use this pop-up menu to choose 
an MPEG-2 stream usage option:

•	 Generic: Allows complete access to all MPEG-2 
properties. This is the only option that supports 
the MPEG-2 640 x 480 video format in addition to 
the standard-definition (SD) and high-definition 
(HD) video formats. It’s also the only option that 
supports creating transport and program streams. It 
supports the complete bit rate range of 2.0 Mbps to 
40.0 Mbps.

•	 DVD: Restricts the encoding properties to those 
allowed by the SD DVD specification. These include 
the NTSC and PAL video formats and a bit rate range 
of 2.0 Mbps to 9.0 Mbps.

•	 Blu-ray: Restricts the encoding properties to those 
allowed by Blu-ray video discs. These include the 
SD and HD video formats and a bit rate range of 
10.0 Mbps to 40.0 Mbps.

Color palette Image Sequence Use this pop-up menu (available when “Image type” is 
set to GIF or PNG) to choose the number of colors used 
in the transcoded files (or choose Not Indexed to use 
all available colors). Select Local to use a new color 
palette for each frame, or Global to use a shared color 
palette across all frames.

Color dithering Image Sequence Use this pop-up menu (available when “Image type” is 
set to GIF or PNG and Color palette is set to a limited 
number of colors) to choose a dithering algorithm, or 
no dithering.
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General property Preset formats Description

Animated Image Sequence Select this checkbox (available when “Image type” 
is set to GIF or PNG) to export a single, animated 
file containing all frames (rather than a collection of 
individual files for each frame).

Playback Image Sequence When Animated is selected, use these controls to set 
how many times the animated GIF or PNG loops during 
playback.

Create unique output 
directory

Image Sequence When Animated is not selected, select this checkbox to 
create a folder to hold the output files; the files saved 
will be named “frame-0,” “frame-1,” “frame-2,” and so 
on.

Add leading zeros to frame 
numbers

Image Sequence When Animated is not selected, select this checkbox 
to have Compressor add leading zeros to output 
filenames (“filename-000000,” “filename-000001,” 
“filename-000002,” and so on).

Add Apple metadata MPEG-2 Select this checkbox to have Compressor include 
specific MPEG-2 authoring information in the output 
file. The resulting file will be read faster by other 
applications.

Include chapter markers 
only

MPEG-2 Select this checkbox to include chapter markers, but 
not unnamed compression markers, in MPEG-2 output. 
When this checkbox is deselected, all markers are 
included in the output file. See Add markers.

Enhanced podcast MPEG-4 Select this checkbox to have Compressor embed 
podcasting information (annotations, markers, and 
artwork) into the output media file. See Work with 
metadata and Add markers.

The General inspector may also show options for retiming, captions, and metadata.

Video properties of presets in Compressor

When you select a preset, its video properties appear in the Video inspector.

Important: Not all properties or options are available for all transcoding jobs. The options 
shown depend on the type of source media you’re transcoding, the preset’s format, the 
configuration of other properties, and the hardware and software you’re using.

Video property Preset formats Description

Enable video pass-through MXF, QuickTime Movie Select this checkbox to copy the source video to the 
destination file, without modification. Selecting this 
checkbox disables all the other presets in the video 
properties area.

Frame size All video-enabled preset 
formats

Use this pop-up menu to set the frame size (resolution) 
of the output file. See Modify frame size.

Center crop for output 
ratio

All video-enabled preset 
formats

Select this checkbox to ensure that when you change 
the aspect ratio in the Frame size pop-up menu, the 
video remains centered in the new aspect ratio.

Pixel aspect ratio All video-enabled preset 
formats

Use this pop-up menu to set the ratio between the 
encoded width and the display width.
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Video property Preset formats Description

Frame rate All video-enabled preset 
formats

Use this pop-up menu to set the frame rate for the 
output file, or enter a custom frame rate in the field 
next to the pop-up menu (if available). See Modify 
frame rate and duration.

Field order All video-enabled preset 
formats

Use this pop-up menu to set the output scanning 
method for interlaced footage. See Use deinterlacing.

Color space All video-enabled preset 
formats

Use this pop-up menu to convert the source media 
to a new color space. Choose Automatic to allow 
Compressor to choose the best color space based on 
the selected preset, or “Same as Source” to use the 
color space of the source file. You can also choose a 
manual preset to override the default. See Modify color 
space and HDR metadata.

Preserve camera log 
encoding

All video-enabled preset 
formats

Select this checkbox to ensure that the output file 
maintains the log encoding specified by the source file. 
This option is only available if a camera log is specified 
in the Job inspector. See Job properties.

Camera LUT All video-enabled preset 
formats

Use this pop-up menu to choose the camera lookup 
table (LUT) applied to the source file. This option is 
only available if a camera log is specified in the Job 
inspector and the “Preserve camera log encoding” 
checkbox is deselected.

Cinematic All video-enabled preset 
formats

Use this pop-up menu (available for source video 
recorded in Cinematic mode with the iPhone Camera 
app) to specify whether or not to render the Cinematic-
mode effect in the transcoded file.

Note: Cinematic mode rendering requires macOS 12 or 
later. For details on how to preserve Cinematic mode 
metadata when transferring video from iPhone to Mac, 
see the Motion User Guide.

Stereoscopic All video-enabled preset 
formats

Use this pop-up menu to choose how Compressor uses 
the left- and right-eye views in stereoscopic video. 
See Modify stereoscopic and spatial properties in 
Compressor.

360° metadata Apple Devices, MPEG-4, 
QuickTime Movie

Use this pop-up menu to choose the type of 360° 
metadata, if any, to be included in the output file. See 
Work with 360-degree video.

Codec Apple Devices, MPEG-4, 
MXF, QuickTime Movie

Choose one of the available transcoding methods.

Note: HEVC encoding in Compressor requires macOS 
10.13 or later.

Spatial Video Apple Devices When Codec is set to MV-HEVC, use this pop-up menu 
to determine whether to output the file as spatial 
video for playback on Apple Vision Pro. See Modify 
stereoscopic and spatial properties in Compressor.

Encoder type Apple Devices, MPEG-4, 
QuickTime Movie

When Codec is set to HEVC, use this pop-up menu to 
choose a faster (standard quality) or slower (higher 
quality) encoder.

https://support.apple.com/guide/motion/motn5aea30bb/
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Video property Preset formats Description

Profile Apple Devices, MPEG-4, 
QuickTime Movie

Use this pop-up menu to set the level of complexity 
included in the transcode.

When Codec is set to H.264 for MPEG-4 and 
QuickTime Movie presets, choose between high-quality 
output (which may not be compatible with H.264 
playback devices), the Baseline profile (primarily for 
video conferencing and mobile applications), and 
the Main profile (similar to Baseline, with additional 
support for standard-definition video requirements).

When Codec is set to HEVC or MV-HEVC, choose the 
color depth of the output file.

Entropy mode MPEG-4, QuickTime Movie When Codec is set to H.264, use this pop-up menu 
to set the entropy mode to CABAC (which provides 
higher-quality output) or CAVLC (which is faster and 
more compatible for playback on older devices).

Avg. Bit rate MPEG-4, QuickTime Movie Choose a bit rate for your video:

•	 Custom: Allows you to manually enter an average bit 
rate in the text field.

•	 Computer playback: Creates a larger file with higher 
quality.

•	 Social Platforms: Creates a smaller file suitable for 
uploading to a website.

•	 HTTP Live Streaming (HLS): Creates a file suitable 
for live streaming over the internet.

•	 Proxies: Creates a proxy file suitable for editing in 
Final Cut Pro (see Create optimized and proxy files 
in the Final Cut Pro User Guide for Mac).

•	 Automatic: Compressor sets an average bit rate.

Key frame interval MPEG-4, QuickTime Movie Use this pop-up menu to choose the interval between 
keyframes in your output file: All creates a keyframe 
at every frame; Every lets you enter a custom interval 
in the value field; Automatic lets Compressor set the 
interval.

Quality QuickTime Movie When Codec is set to Animation or Photo-JPEG, use 
this slider to set the quality level of your output file. 
When Codec is set to HEVC and the “Preserve alpha” 
checkbox is selected, use this slider to set the quality 
level of your output file’s alpha channel.

Anamorphic MPEG-2 If a standard-definition source file’s storage aspect 
ratio doesn’t match its display aspect ratio, use this 
pop-up menu to correct the image so the output 
doesn’t appear squeezed or stretched.

https://support.apple.com/guide/final-cut-pro/verb8e5f6fd/
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Video property Preset formats Description

Encoding mode MPEG-2 Choose an MPEG-2 encoding mode from the pop-up 
menu:

•	 Single Pass CBR: This is the fastest MPEG-2 
encoding mode. It provides good quality, especially 
at bit rates between 5 and 9 Mbps.

•	 Single Pass VBR: This mode aims to maintain 
constant quality (at the expense of constant bit rate) 
for the transcoded video file. For most standard-
definition media files at bit rates of 3.5 Mbps and 
above, this mode provides good to excellent quality 
and transcodes quickly.

•	 Single Pass VBR (Best): This mode provides the best 
possible quality output for standard-definition video 
at bit rates of 3 to 3.5 Mbps and above.

•	 Two Pass VBR: This mode uses two passes—one 
pass to analyze the entire source video stream, and 
a second pass to compress the file. This mode takes 
longer and provides a better-quality file than the 
one-pass modes, and is recommended for source 
media files with a substantial difference between the 
most and the least complex scenes.

•	 Two Pass VBR (Best): This mode provides the best 
possible quality output, and outstanding quality 
at bit rates of 3 to 3.5 Mbps and above for high-
definition and standard-definition video.

Motion estimation MPEG-2 Use this pop-up menu to set the amount of motion 
processing performed on the file. Choose Good when 
there’s relatively low motion between frames, Better 
when there’s slightly more complex motion, and Best 
for the most complex motion and for interlaced source 
files.

GOP structure MPEG-2 Use this pop-up menu to choose an MPEG-2 GOP 
(group of pictures) structure:

•	 IP: Use IP only if your media contains fast motion 
that isn’t encoded with sufficient quality using an 
IBBP or IBP structure.

•	 IBP: Use IBP only if your media contains fast motion 
that isn’t encoded with sufficient quality using an 
IBBP structure.

•	 IBBP: Recommended for the majority of MPEG-2 
encoding situations.

GOP size MPEG-2 Use this slider to specify how many frames are 
contained within a GOP (group of pictures). The 
values available in the slider are determined by the 
“GOP structure” property. The maximum GOP size in 
Compressor is 15 frames (NTSC) or 12 frames (PAL and 
720p). The minimum GOP size for all video formats is 6 
frames (closed GOP) or 7 frames (open GOP).

Automatically select bit 
rate

H.264, MPEG-2 Select this checkbox to have Compressor automatically 
compute the best bit rate for the output file, based on 
the duration of the source file. To manually adjust the 
bit rate, deselect the checkbox and drag the “Average 
bit rate” and “Maximum bit rate” sliders (or enter 
values in the adjacent fields).
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Video property Preset formats Description

Multi-pass Apple Devices, H.264, 
MPEG-4, QuickTime Movie

Select this checkbox to turn on multi-pass encoding, 
which applies an additional analysis of video frames to 
produce a high-quality output file.

Include Dolby Vision 8.4 
Metadata

Apple Devices, MPEG-4, 
QuickTime Movie

Select this checkbox to have Compressor include Dolby 
Vision 8.4 metadata in the output file.

Bit rate Apple Devices Select the Automatic checkbox to have Compressor 
calculate the appropriate bit rate for the output file, 
based on the frame size of the source file and device 
compatibility. If the checkbox is not selected, set the 
bit rate by dragging the slider or entering a value in the 
text field.

Frame sync Apple Devices Select the Automatic checkbox to have Compressor 
calculate the frame rate.

Note: When Frame sync is enabled, the value in the 
seconds field defaults to zero (.0), but the actual value 
is determined during the encoding process.

If the checkbox is not selected, drag the slider or enter 
a value in the text field to set the key frame interval at 
which you want keyframes created in your output file.

Allow frame reordering MPEG-4, QuickTime Movie Select this checkbox to potentially provide a better-
quality output file by allowing Compressor to reorder 
video frames during transcoding.

Important: If you select “Allow frame reordering,” 
your output file may be more efficiently compressed 
but may not be compatible with decoders on older 
hardware.

Preserve alpha QuickTime Movie Select this checkbox to preserve any alpha channel 
information from your source file and pass the alpha 
channel to the output file.

Add clean aperture 
information

QuickTime Movie Select this checkbox to define clean picture edges in 
the output file. This property adds information to the 
output file to define how many pixels to hide, ensuring 
that no artifacts appear along the edges. When you 
play the output file in QuickTime Player, the pixel 
aspect ratio is slightly altered. This process doesn’t 
affect the actual number of pixels in the output file—it 
only controls whether information is added to the file 
that a player can use to hide the edges of the picture.

Scale image to preserve 
aspect ratio

Image Sequence Select this checkbox to scale the output files to use 
square pixels and maintain the original aspect ratio 
(which results in an increase or decrease in the number 
of horizontal and vertical pixels).

Compression Image Sequence Use this pop-up menu to choose an image compression 
method.

Color depth Image Sequence Use this pop-up menu to set the color depth of the 
output file.

YUV 422 color encoding MPEG-2 Select this checkbox to use YUV 422 color encoding 
for superior chroma quality.



40Compressor User Guide

Video property Preset formats Description

Start timecode MXF Use this pop-up menu to set a forced timecode start 
point for the output file. The Automatic option uses 
the default timecode of the source file (typically, 
00:00:00:00). Other options set the timecode start to 1 
hour or 10 hours.

Drop frame MXF Available when “Frame rate” is set to 29.97 fps or 
59.94 fps and “Start timecode” is set to 00:00:00:00, 
01:00:00:00 or 10:00:00:00. Select this checkbox 
to force the timecode to stay in sync with real-time 
duration during playback.

The Video inspector also shows options for cropping, padding, and rotating, setting 
parameters for retiming and resizing quality, and adding video effects.

Audio properties of presets in Compressor

When you select a preset, its audio properties appear in the Audio inspector.

Important: Not all properties or options are available for all transcoding jobs. The options 
shown depend on the type of source media you’re transcoding, the preset’s format, the 
configuration of other properties, and the hardware and software you’re using.

Audio property Preset formats Description

Enable audio pass-through QuickTime Movie Select this checkbox to copy the source audio to the 
destination file, without modification.

Channel layout All audio-enabled preset 
formats

Use this pop-up menu to manually set the type of audio 
channel layout. See Audio channel layouts.

Sample rate All audio-enabled preset 
formats

Use this pop-up menu to set the sample rate of the 
transcoded audio.

Sample size All audio-enabled preset 
formats

Use this pop-up menu to manually set the sample size 
of the audio signal.

Codec QuickTime Movie Use this pop-up menu to choose an audio codec.

Sample format QuickTime Movie When the audio Codec property is set to Linear PCM, 
use this pop-up menu to select whether to output your 
audio in Big Endian or Little Endian format.

Format MPEG-4 Use this pop-up menu to choose an MPEG-4 Advanced 
Audio Coding (AAC) or Apple Lossless format for 
MPEG-4 audio encoding.

Quality Apple Devices, MPEG-4, 
QuickTime Movie

Use this pop-up menu to select the quality of the  
audio output.

Target system Dolby Digital Use this pop-up menu to choose the system on which 
you’ll play the output file. Compressor limits options 
in other related properties to those appropriate for the 
target system.



41Compressor User Guide

Audio property Preset formats Description

Bit rate Apple Devices, Dolby 
Digital, MP3, MPEG-4, 
QuickTime Movie

Use this pop-up menu to set the bit rate of the  
audio output.

For stereo encoding, rates of 192 kbps and 224 
kbps are typical and will produce good results. For 
Dolby Digital 5.1 encoding, a rate of 384 kbps is 
recommended. For Dolby Digital Plus encoding, a rate 
of 192 kbps is recommended.

Use variable bit rate 
encoding

MP3 Select the checkbox to have Compressor encode the 
file using a dynamic bit rate that varies according to 
the complexity of audio. Variable bit rate encoding can 
reduce the size of the output file.

Bit rate strategy Apple Devices, MPEG-4, 
QuickTime Movie

Use this pop-up menu to select the method used to 
encode the audio:

•	 Constant Bit Rate: Uses the value set in “Bit rate” to 
determine the bit rate for the encoded audio.

•	 Average Bit Rate: Uses the value set in “Bit rate” 
to determine the target average bit rate for the 
encoded audio. This option provides a more 
consistent bit rate than variable bit rate.

•	 Variable Bit Rate Constrained: Uses the value set in 
“Bit rate” to determine the maximum bit rate for the 
encoded audio.

•	 Variable Bit Rate: Encodes the audio using a variable 
bit rate determined by Compressor. Choosing this 
option disables the “Bit rate” menu.

Include Dolby 5.1 Audio 
Track

Apple Devices Select the checkbox to add surround sound as a Dolby 
Digital audio track for playback on Apple TV.

Include Lt Rt downmix 
track

QuickTime Movie Select this checkbox (available when “Channel layout” 
is set to more than two tracks) to add an additional 
stereo track to the transcoded file that includes a 
stereo-mix version of the audio with the encoded 
surround information included.

Compression Common Audio Formats For FLAC file types, use this pop-up menu to manually 
set the amount of compression used to encode the 
audio signal.

Joint stereo MP3 Select the checkbox to have one channel carry 
information that’s identical on both channels, and 
another channel carry unique information. At bit rates 
of 160 kbps and below, this preset can improve the 
sound quality of your converted audio.

Smart encoding 
adjustments

MP3 Select the checkbox to have Compressor analyze the 
source file and the preset’s encoding properties to 
maximize the quality of the output file.

Filter frequencies below 
10 Hz

MP3 Select the checkbox to have Compressor remove 
inaudible frequencies from the source file and output a 
smaller and more efficient file without perceptible loss 
of quality.

Channels as MXF Use this pop-up menu to set the distribution of audio 
channels. "Mono tracks” uses a separate track for each 
audio channel, while “Multitrack” combines all audio 
channels into a single track.
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Audio property Preset formats Description

Bit stream mode Dolby Digital Use this pop-up menu to define the audio service 
contained within the Dolby Digital or Dolby Digital Plus 
bitstream.

Surround mode Dolby Digital For Mono and Stereo (L R) channel layouts, this 
property tells the playback device whether the two-
channel encoded bitstream contains a Dolby Surround 
(Lt/Rt) program that requires Dolby Pro Logic decoding. 
Choose an option from the pop-up menu:

•	 Not Indicated: Does not send the playback device 
information about whether the bitstream was 
encoded in Dolby Surround.

•	 Not Encoded: Tells the playback device that the 
bitstream contains information not encoded in Dolby 
Surround.

•	 Surround Encoded: Tells the playback device that 
the bitstream contains information encoded in Dolby 
Surround.

Surround EX mode Dolby Digital For 5.1 (L R C LFE Ls Rs), 5.0 (L R C Ls Rs), 4.1 (L R 
LFE Ls Rs), and 4.0 (L R Ls Rs) layouts, this property 
tells the playback device whether the audio has been 
encoded in Dolby Digital Surround EX. Choose an 
option from the pop-up menu:

•	 Not Indicated: Does not send the playback device 
information about whether the bitstream was 
encoded in Dolby Surround EX.

•	 Not Encoded: Tells the playback device that the 
bitstream contains information not encoded in Dolby 
Surround EX.

•	 Surround Encoded: Tells the playback device that 
the bitstream contains information encoded in Dolby 
Surround EX.

Stereo downmix Dolby Digital Use this pop-up menu to set how to downmix a 
surround signal to a stereo signal. See Audio channel 
layouts.

Important: The LFE signal may be discarded by the 
Dolby Digital downmix process.

Lo/Ro center, Lo/Ro 
surround, Lt/Rt center, Lt/
Rt surround (for surround 
sound output)

Dolby Digital Use these pop-up menus to set the decibel level 
at which the surround and center channels are 
downmixed.

DRC line mode Dolby Digital Use this pop-up menu to set the dynamic range 
compression-processing mode.

DRC RF mode Dolby Digital Use this pop-up menu to set the dynamic range 
compression-processing mode for RF devices (TV  
sets, cable set top boxes, or other devices that have  
RF connections).

LFE low-pass filter Dolby Digital Select this checkbox to apply a 120 Hz low-pass  
filter to the low-frequency effects (LFE) channel  
during output.
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Audio property Preset formats Description

DC filter Dolby Digital Select this checkbox to apply a DC (direct current) 
high-pass filter to all input channels. Although this 
filter provides a simple way to remove DC offsets,  
note that most mixed audio material is already free  
of DC offsets.

Surround channels: 90 
phase-shift

Dolby Digital This checkbox, which applies a 90-degree phase shift 
to the surround channels, is selected by default. The 
shift in phase unlinks the front and back channels and 
prevents the L and Ls signals from canceling each 
other out if a surround-compatible downmix is later 
applied to the decoded signal.

Surround channels: 3dB 
attenuation

Dolby Digital Select this checkbox to apply a 3 dB cut to the 
surround channels during output. This option 
is intended for multichannel output (like a film 
soundtrack) that’s being transferred to a consumer 
home theater format. Cinema surround channels are 
mixed 3 dB “hot” (higher) relative to the front channels 
to account for cinema amplifier gains.

Dialog normalization Dolby Digital Enter a value in the field to set the loudness of the 
program in your sound files relative to full modulation. 
The playback device uses this information to maintain 
similar loudness among different AC-3 streams. The 
goal is to give all AC-3–encoded audio files the same 
listening level, regardless of the source file.

The Audio inspector also shows options for adding audio effects.

Add job actions

Add and modify job actions in Compressor
A job action is an automated action performed on a media file after it’s transcoded, usually 
for the purpose of sending your video out into the world. For example, Compressor can  
add the finished file to an email message and send it to a recipient of your choosing, 
including yourself.

When a job contains a job action, a gear icon is shown in the top-right corner of the job.

Note: A job action is automatically included in each of the built-in destinations provided 
with Compressor. See Add a destination to a job.
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Add a job action to a job

1.	 Select a job in the Compressor batch area.

2.	 In the Action area of the Job inspector, click the “When done” pop-up menu, then 
choose a job action.

Additional properties may appear, depending on the job action you select. Add the 
appropriate information to any additional fields.

Note: If you see the alert icon  next to the name of the job action in the batch area, 
there’s an issue with the source file or the action properties. Click the alert icon for 
more information. See Review errors and warnings.

For information about the properties of each job action, see Job actions.

Remove a job action

1.	 Select the job in the Compressor batch area.

2.	 In the Action area of the Job inspector, click the “When done” pop-up menu and choose 
“Save only.”

Job actions in Compressor
Compressor comes with a set of job actions that are automatically applied with 
destinations, or that can be manually applied with presets. A job action performs  
an automated action after transcoding.

The job actions available in Compressor and their associated properties are  
described below.

Job action Description Properties

Add to Photos Adds a copy of the exported file to 
the Photos app.

•	 Title: Enter a title for the copy of the file in the 
Photos app.

Add to TV Home 
Videos

Adds a copy of the exported file 
to the Home Videos library in the 
Apple TV app.

•	 Title: Enter a title for the copy of the file in the Home 
Videos library.

Open with 
Application

Opens the transcoded file in 
another application upon export.

•	 Open with: Choose the application for opening the 
transcoded file.

Prepare for 
Apple Immersive 
Video streaming

Processes transcoded  
Apple Immersive files, then  
uploads the processed files to 
the location you specify. To learn 
more about Apple Immersive Video 
packaging, see Create an  
Apple Immersive Video package

•	 Segment duration: Enter a minimum number of 
seconds per segment for the segment duration.

•	 Location for Immersive HLS folder: Click the  
Choose button to assign a save location for the  
Apple Immersive Video assets.
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Job action Description Properties

Prepare for HTTP 
Live Streaming

Processes the transcoded files 
using the instructions you provide 
and then uploads the processed 
files to the server you specify. 
To learn more about HTTP Live 
Streaming, see the HTTP Live 
Streaming Overview and other 
related documents, available in the 
Apple Developer Documentation.

•	 Output type: Set the format output for this job 
action. MPEG-2 TS sets the output format to MPEG-
2 transport stream; Fragmented MP4 sets the output 
format to fragmented MP4 (only available if you have 
macOS 10.14 or later installed).

•	 Destination for Live Stream assets: Click the 
Choose button to assign a save location for the live 
streaming assets.

•	 Segment duration: Enter a minimum number of 
seconds per segment for the segment duration.

•	 Create Read Me file with sample HTML: Select this 
checkbox to create a sample HTML file for hosting 
the HTTP live-streaming content.

Run Automator 
Workflow

Applies an Automator workflow to 
an output file after transcoding.

•	 Workflow: Click the Choose button to set the 
Automator workflow that the job action triggers.

Send Email Sends an email with an attachment 
of the transcoded file from the Mail 
app.

•	 To: Enter recipient email addresses in this field.

•	 Subject and Message: Enter relevant text in these 
fields.

Social Platforms Saves social media-compatible 
output to your Mac. You can then 
upload your media directly on the 
social platform.

There are no properties for this job action.

For information about adding or modifying a job action in a job, see Add and modify  
job actions.

Apply a destination

Add a destination to a job in Compressor
A destination in Compressor consists of one or more presets combined with an automated 
job action that’s performed after transcoding.

For basic transcoding jobs, you can use the built-in destinations that come  
with Compressor.

1.	 After you add a job to a batch, click Add on the right side of the job’s Preset/Location/
Filename row.

2.	 In the window that appears, select the destination  you want to apply, choose a save 
location from the pop-up menu, then click OK.

The presets contained in the destination appear as output rows in the batch area, and 
the job action is displayed in the top-right corner of the job.

 Tip: You can also apply a destination by dragging it from the Presets pane onto a job 
in the batch area.

After applying a destination to a transcoding job, you can modify or remove individual 
presets, or modify the job action.

https://developer.apple.com/documentation/HTTP-Live-Streaming
https://developer.apple.com/documentation/HTTP-Live-Streaming
https://developer.apple.com/documentation
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View destination properties in Compressor
When you select a built-in or custom destination in Compressor, you can view its properties 
and associated job action.

•	 In Compressor, select a destination in the Presets pane, then review its name, 
description, and associated job action in the inspector pane.

Note: You can’t modify the properties of Compressor’s built-in destinations;  
you can only modify the properties of your custom destinations. See Create a  
custom destination.

Built-in destinations in Compressor
Built-in destinations, available in the Presets pane in Compressor, combine one or more 
presets and a post-encode job action, which automates tasks such as emailing, copying, 
and moving transcoded files.

Built-in destination Contains Use to

Add to TV Home Videos Preset: Apple Devices HD (Best 
Quality)

Job action: Add to TV Home Videos

Create an Apple device-compatible 
H.264 file, then automatically add 
the file to your Home Videos library 
on Apple TV.

Prepare for Apple Immersive Video 
streaming

Presets: 

•	 Apple Immersive Audio

•	 Apple Immersive Video High

•	 Apple Immersive Video Low

Job action: Prepare for  
Apple Immersive Video streaming

Create a set of MP4 and AIVU files 
suitable for playback and HTTP live 
streaming on Apple Vision Pro, then 
specify a save location for the Apple 
Immersive Video package. See 
Create an Apple Immersive Video 
package.

Prepare for HTTP Live Streaming Presets: 

•	 Audio for HTTP Live Streaming

•	 Broadband High

•	 Broadband Low

•	 Cellular High

•	 Cellular Low

•	 Wi-Fi High

•	 Wi-Fi Low

Job action: Prepare for HTTP Live 
Streaming

Create a set of MPEG-4 files, then 
process your transcoded files and 
upload them to the server you 
specify. The files are compatible 
with a variety of devices, such as 
smartphones and media players.

Prepare for HTTP Live Streaming 
(HEVC)

Presets: 

•	 Audio (High)

•	 Audio (Low)

•	 Audio (Standard)

•	 HEVC Broadband HD (and 4G LTE 
and higher)

•	 HEVC Cellular large (3G or lower)

•	 HEVC Cellular medium (3G or 
lower)

•	 HEVC Cellular small (3G or lower)

Job action: Prepare for HTTP Live 
Streaming

Create a set of HEVC video files and 
MPEG-4 audio files, then process 
your transcoded files and upload 
them to the server you specify. The 
files are compatible with a variety of 
devices, such as smartphones and 
media players.
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Create a custom destination in Compressor
You can create a custom destination from scratch, or by duplicating an existing destination.

Create a custom destination by duplicating an existing destination

1.	 In the Presets pane in Compressor, select the destination  that you want to duplicate.

Note: Make sure you select the destination name (next to the disclosure triangle), rather 
than any of the presets that appear under the destination name.

2.	 Click  at the bottom of the pane, then choose Duplicate.

The new destination appears in the Custom area of the Presets pane.

3.	 To modify the properties of your new destination, do any of the following:

•	 In the Destination inspector, select text in the Name field or Description field, then 
type a new name or description.

•	 In the Destination inspector, adjust the job action properties in the Action area.

•	 In the Presets pane, click the disclosure triangle next to the custom destination, 
select a preset under the destination name, then in the inspector adjust any of the 
preset’s properties. See View and modify a preset’s properties.

Because you’re modifying a custom destination, the properties that you provide for 
the job action will be saved for future use.

Create a custom destination from scratch

1.	 In Compressor, click  at the bottom of the Presets pane, then choose  
New Destination.

2.	 In the dialog that appears, do the following:

a.	 Select one or more transcode presets or a destination from the list.

b.	 Click the “Job action” pop-up menu, then choose an option.

c.	 Optionally, enter a name and a description in the relevant fields.

d.	 Click OK.

The new destination appears in the Custom area of the Presets pane.

3.	 To modify the properties of your new destination, do any of the following:

•	 In the Destination inspector, select text in the Name field or Description field, then 
type a new name or description.

•	 In the Destination inspector, adjust the job action properties in the Action area.

•	 In the Presets pane, click the disclosure triangle next to the custom destination, 
select a preset under the destination name, then in the inspector adjust any of the 
preset’s properties. See View and modify a preset’s properties.

Because you’re modifying a custom destination, the properties that you provide for 
the job action will be saved for future use.

Delete a custom destination

•	 In Compressor, select a custom destination in the Presets pane, then press Delete.
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Adjust the filename and save location

Change an output’s filename in Compressor
When you apply a preset to a job, Compressor assigns a default name to the output file: 
the source filename appended with the extension of the format used during transcoding 
(.mov or .mp4, for example). If you want, you can change that name.

•	 In the Filename column of an output row, double-click the name of a file, enter a new 
name, then press Return.

Note: If you see an alert icon  to the left of the filename, the filename assigned to that 
output row has already been used. Click the alert icon to view a description of the error. 
See Review errors and warnings.

If you want to change Compressor’s default filename format, you can create a custom 
location with your preferred filename format, then set it as your default location in  
General settings.

Change an output’s save location in Compressor
A location in Compressor specifies where the transcoded file is saved after transcoding. 
The default save location is Source—the same folder that contains the source file you’re 
transcoding. However, you can manually change the save location of any job in a batch,  
or set a new default location for specific custom presets.

Change a single output’s save location

1.	 In the batch area in Compressor, Control-click the output row you want to modify.

2.	 In the shortcut menu, choose Location, then do either of the following:

•	 Choose a built-in or custom location: Click a location in the list.

•	 Choose a different location: Click Other, navigate to a new location on your system, 
then click Choose.

 Tip: If you often save to a location that’s not one of the built-in locations in 
Compressor, you can create a custom location.

The new save location is displayed in the Location column of the batch area.

Set a new default save location for a custom preset

1.	 In Compressor, select a custom preset in the Presets pane.

2.	 In the General Properties area of the General inspector, click the “Default location”  
pop-up menu, then choose a new location for the preset.

Whenever you use this custom preset, its output file will be saved to the new location.
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Built-in locations in Compressor
Use the built-in locations in Compressor, available in the Locations pane, to specify the 
save location of a transcoded file.

Note: By default, Compressor saves transcoded files to Source. You can change this in 
General settings.

Built-in location Use to

Desktop Save the transcoded file to the desktop.

Movies Save the transcoded file to the Movies folder.

Source Save the transcoded file to the same location as the source media file.

When you select a built-in location in the Locations pane, its properties are displayed in the 
Location inspector.

Create custom save locations and filename formats in 
Compressor
If you frequently save files somewhere other than Compressor’s built-in locations, or you 
want to automate the naming of output files, you can create a custom location. Built-in and 
custom locations are shown in the Locations pane.
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Create a custom location

1.	 In Compressor, click  at the bottom of the Locations pane.

2.	 In the window that appears, select a location on your computer or on a connected 
device, then click Choose.

The new location appears in the Custom area of Locations pane.

3.	 To modify the properties of the location, do any of the following in the  
Location inspector:

•	 Type a new name in the Name field.

•	 Add naming tokens in the “Filename format” field. For instructions on how to modify 
the filename format, see the next task.

•	 To change the save location, click the Choose Location button, specify a new 
location, then click Choose.

Set a custom location’s filename format

When you add a preset to a job, Compressor automatically assigns an output filename 
based on the filename format shown in the Location inspector. You can change an output’s 
filename at any time, or you can save a filename format of your choosing by creating a 
custom location and adjusting its filename format.

1.	 In Compressor, select a custom location in the Locations pane.

The “Filename format” field in the Location inspector displays naming tokens that 
determine the output filename.

2.	 To modify the filename format, do any the following:

•	 Move existing tokens: Drag tokens to reorder them, or cut and paste them to a new 
position in the field.

•	 Add a token: Click a position in the field to specify where you want to place a new 
token, then click the “Add element” pop-up menu and choose a token from the list.

•	 Add text: Click a position in the field to specify where you want the additional text, 
then type the text.

As you change the output filename instructions, the sample filename is updated.

Delete a custom location

•	 In the Locations pane in Compressor, select a custom location and then press Delete.
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Make adjustments

Modify timing and timecode properties in Compressor
You can adjust the starting timecode of a job in Compressor, as well as which portion of the 
source media gets transcoded.

1.	 Select the job in the Compressor batch area.

2.	 In the Timing area of the Job inspector, modify any of the following properties:

•	 Start: The starting timecode of the job. Adjusting this value automatically updates 
the job’s In point to the same value.

•	 In point: The point in the source media where the transcoded output will start. 
Adjusting this value automatically updates the job’s duration.

•	 Duration: The duration of the transcoded file. Adjusting the duration changes the 
job’s Out point.

You can change these values by typing directly into their fields, clicking the arrows next 
to the fields, or dragging over the values themselves.

3.	 To use drop frame timecode, select the Drop frame checkbox.

Note: Adjusting these properties affects how Compressor interprets the source file itself. 
To adjust the duration for a specific output row, see Modify frame rate and duration.

Transcode specific time ranges in Compressor
You can limit transcoding to a specific time range in a job by setting In and Out points.

1.	 Select a job in the Compressor batch area.
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2.	 In the preview area, do one of the following to mark In and Out points:

•	 In the timeline, drag the In point  to where you want the transcoding to begin, then 
drag the Out point  to where you want the transcoding to end.

•	 Click  to preview the media file. When the playhead reaches the location where 
you want to place an In point, press I. When the playhead reaches the location where 
you want to place an Out point, press O.

Only the portion of the source file that you identified will be transcoded when you submit 
the batch.

Note: If you want to transcode multiple portions of the same source media, you need to 
create a different job for each section you want to transcode.

Modify frame size in Compressor
You can modify the properties of applied or custom presets to set the frame size of your 
output and to specify how source media fills the frame.

Note: If you modify the properties of an applied preset in the output row of a job, the 
modifications apply to only that output. If you modify the properties of a custom preset, 
your modifications are saved for future use.

Set the frame size

1.	 In Compressor, select an applied or custom preset.

2.	 In the Video Properties section of the Video inspector, click the “Frame size” pop-up 
menu and choose a frame size (resolution) from the list (or enter custom values in the 
text field to the right).

Frame size options are divided into four categories:

•	 Automatic: Adjusts the output based on the size of the input, and, in some formats, 
can be constrained “up to” a maximum resolution (in horizontal, vertical, or square 
aspect ratios).

•	 Percentage: Adjusts the output based on a percentage of the input’s size.

•	 Manual: Forces the output to a specific resolution.

•	 Constrained: Constrains the output to a specific aspect ratio.
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Crop the source image

You can use cropping controls to remove part of the original source image.

1.	 In Compressor, select an applied or custom preset.

2.	 In the Cropping, Padding, and Rotation section of the Video inspector, do any of  
the following:

•	 Manually set cropping dimensions: In the Cropping property, enter a value in the Top, 
Bottom, Left, and Right fields to crop the source image by that many pixels.

•	 Choose a cropping preset: Click the Cropping pop-up menu, then choose a preset 
aspect ratio.

Note: If the aspect ratio you choose doesn’t match the aspect ratio selected in the 
“Frame size” pop-up menu, you may see black bars around the edges of your picture 
after the file is transcoded.

•	 Remove letterbox bars: Click the Cropping pop-up menu, then choose Letterbox 
Area of Source. This instructs Compressor to detect the black edges around the 
image in your source file and automatically enter crop values to remove them.

•	 Drag the frame edges: In the preview area, click , then drag inward from any frame 
edge to crop the image.

Pad the source image

Padding adds black to the edges of the source image to fit it into a different-size frame.

1.	 In Compressor, select an applied or custom preset.
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2.	 In the Cropping, Padding, and Rotation section of the Video inspector, do any of  
the following:

•	 Manually set padding dimensions: In the Padding property, enter a value in the Top, 
Bottom, Left, and Right fields to pad the source image by that many pixels.

•	 Choose a padding preset: Click the Padding pop-up menu, then choose a preset 
aspect ratio.

•	 Preserve the original frame size: Click the Padding pop-up menu, then choose 
Preserve Source Aspect Ratio. This ensures that the source clip remains at its native 
aspect ratio. If the “Frame size” pop-up menu is set to a different aspect ratio, black 
borders will be added to the transcoded output file.

Rotate or flip the source image

1.	 In Compressor, select an applied or custom preset.

2.	 In the Cropping, Padding, and Rotation section of the Video inspector, do one of  
the following:

•	 Rotate the source image: Click the Rotation pop-up menu, then choose whether you 
want to rotate the image 90 degrees, 180 degrees, or 270 degrees.

•	 Flip the source image: Click the Flip pop-up menu, then choose whether you want to 
flip the image horizontally, vertically, or both.

Note: The Rotation property is always applied before the Flip property.
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Conform the source image to a specific frame size

You can use Compressor to conform video to specific frame sizes for editing or 
distribution. For example, you may have vertical video from an iPhone that you need  
to distribute as horizontal video, or you may want to create square video for social  
media distribution.

1.	 In Compressor, select an applied or custom preset.

2.	 In the Video Properties section of the Video inspector, click the “Frame size” pop-up 
menu, then choose an aspect ratio from the Constrained section.

3.	 Enter the dimensions of the conforming video frame in the text fields next to the “Frame 
size” pop-up menu.

4.	 In the Cropping, Padding, and Rotation section of the Video inspector, do one of  
the following:

•	 Fill the frame: Choose None from the Cropping and Padding pop-up menus.

•	 Crop the frame: Choose a setting from the Cropping pop-up menu that matches the 
frame size entered in step 3. Compressor crops to the center of your video to fill the 
frame. To reposition the crop, choose None from the Cropping pop-up menu, then 
drag the crop box in the Viewer.

•	 Pad the frame: Click the Padding pop-up menu, then choose Preserve Source Aspect 
Ratio. Compressor pads your video to fill the frame.

You can also set the method for resizing quality in the Video inspector. See Set retiming 
and resizing quality.

Modify frame rate and duration in Compressor
You can modify the properties of applied or custom presets to set the frame rate of your 
output and modify the duration of a transcoded file.

Note: If you modify the properties of an applied preset in the output row of a job, the 
modifications apply to only that output. If you modify the properties of a custom preset, 
your modifications are saved for future use.



56Compressor User Guide

Set the frame rate

1.	 In Compressor, select an applied or custom preset.

2.	 In the Video Properties section of the Video inspector, do one of the following:

•	 Click the “Frame rate” pop-up menu, then choose an option.

Automatic, the default value, matches the frame rate of the transcoded file to that 
of the source file if possible. If the source file’s frame rate isn’t supported within the 
limitations of the transcode presets, Compressor picks the best match.

You can also choose any of several commonly used frame rates, including 
23.976 fps, 24 fps, and so on. Presets that use the Apple Devices, Image Sequence, 
MPEG-4, or Quicktime Movie formats support frame rates up to 120 fps.

•	 Type a custom frame rate in the field to the right of the “Frame rate” pop-up menu.

Note: Some preset formats don’t permit custom frame rates.

Frame rate conversion can have a subtle or dramatic effect depending on how big a 
difference there is between the original and new frame rates, and also depending on the 
specific nature of the footage being converted. Footage with a lot of movement yields a 
much more visible change than footage with little movement in the frame.

Frame rate conversion may also add visible artifacts in the transcoded file; from stuttering 
(sometimes called “juddery”) playback, to repeated frames, ghost images, or other 
unnatural-looking elements. These effects can be somewhat mitigated by adjusting the 
method for retiming quality. See Set retiming and resizing quality.

Adjust the duration of a transcoded file

1.	 In Compressor, select an applied or custom preset.

2.	 In the Retiming section of the General inspector, modify the Duration property in one of 
the following ways:

•	 Enter a specific percentage of the source footage duration in the percentage field, or 
choose a preset value from the pop-up menu.

Note: Choosing a preset from this pop-up menu doesn’t change the frame rate of 
the output file. If you want to create a file at a frame rate other than the source’s 
original rate, see the previous task.

•	 Click to select the button next to the timecode field and enter a specific duration for 
the outgoing file. The percentage field above automatically updates.

Note: This option is available only when you’re modifying an applied preset.

•	 Click to select “Set so source frames play at [frame rate] fps.” The frame rate used 
in this option is the value set in the “Frame rate” property in the Video inspector.

3.	 Adjust the method for retiming quality as needed.

If the source media contains audio, retiming modifies the audio speed as well, thereby 
keeping audio and video in sync. Compressor also automatically corrects the pitch so  
the audio doesn’t sound artificially high or low.

Important: If you modify retiming properties in a preset that uses the QuickTime Movie 
format and choose “Enable audio pass-through” in the Audio inspector, the audio speed is 
not changed. Consequently, audio in the output file will not maintain sync with the video.
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Set retiming and resizing quality in Compressor
When you modify the timing, frame rate, or frame size of an applied or custom preset, you 
can choose the methods Compressor uses to retain quality in the transcoded file.

Note: If you modify the properties of an applied preset in the output row of a job, the 
modifications apply to only that output. If you modify the properties of a custom preset, 
your modifications are saved for future use.

1.	 In Compressor, select an applied or custom preset.

2.	 In the Quality section of the Video inspector, change any of the properties below.

Quality property Description

Resize filter Choose an option from this pop-up menu to set the resizing method:

Nearest Pixel (Fastest): Samples the nearest neighboring pixel when 
resizing an image. This option provides the fastest processing time, but 
it’s more likely to show aliasing artifacts and jagged edges.

Linear: Adjacent pixel values are averaged using a linear distribution of 
weights. Produces fewer aliasing artifacts than Nearest Pixel, with a small 
increase in processing time.

Gaussian: Adjacent pixel values are averaged using a Gaussian distribution 
of weights. This provides a medium trade-off between processing time 
and output quality.

Lanczos 2: Adjacent pixel values are averaged using a truncated sinc 
function. This option is slower than Gaussian but provides sharper results.

Lanczos 3: Similar to Lanczos 2 but averages more pixel values. This 
option is slower than Lanczos 2 but may produce better results.

Bicubic: Adjacent pixel values are averaged using a bicubic function. The 
processing time and output are most similar to Lanczos 2 and Lanczos 3.

Anti-aliased (Best): Provides the highest output quality, but can take 
substantially longer to process.

Retiming quality Choose an option from this pop-up menu to set the retiming method:

Fast (Nearest Frame): Linearly interpolates frames using nearest-neighbor 
frames.

Good (Frame Blending): Blends neighboring frames using a filter to 
produce good-quality interpolation.

Better (Optical Flow): Uses optical flow to interpolate using areas of 
movement between neighboring frames to produce high-quality output.

Best (Machine Learning): Uses a bidirectional optical flow algorithm based 
on machine learning, resulting in reduced artifacts and better occlusion 
handling. This option requires a Mac with Apple silicon.

Reverse Telecine: Removes the extra fields added during the telecine 
process to convert the film’s 24 fps to NTSC’s 29.97 fps. See Use reverse 
telecine.

Adaptive details Select this checkbox to use advanced image analysis to distinguish 
between noise and edge areas during output.

Anti-aliasing level Sets the softness level in the output image. Drag the slider to increase 
or decrease softness. This property improves the quality of conversions 
when you’re scaling media up. For example, when transcoding SD video to 
HD, anti-aliasing smooths jagged edges that might appear in the image.
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Quality property Description

Details level Sets the amount of detail in the output image. Drag the slider to set the 
value. This sharpening control lets you add detail back to an image being 
enlarged. Unlike other sharpening operations, the “Details level” property 
distinguishes between noise and feature details, and generally doesn’t 
increase unwanted grain. Increasing this value may introduce jagged 
edges, however, which can be eliminated by increasing the “Anti-aliasing 
level” slider.

Dithering Select this checkbox to add a certain type of noise to images to prevent 
large-scale distracting patterns such as color banding. If your image has 
excessive noise after rendering, deselect this checkbox.

Modify video color space and HDR metadata in Compressor
When you add a source video to Compressor, the app identifies the file’s native color space 
and displays a badge (either SDR or HDR) in the job summary.

Some presets let you change that color space in the output video. Presets with 10-bit color 
allow you to choose a wide-gamut HDR color space for the output file.

Review or override the native color space assigned by Compressor

1.	 Select a job in the Compressor batch area.

2.	 In the Video Properties area of the Job inspector, review the option shown in the “Color 
space” pop-up menu.

If the source file has metadata identifying its native color space, Compressor adds 
an asterisk (*) next to the color space shown in the pop-up menu. If the source file is 
untagged or tagged with an unrecognized color space, Compressor assigns a color 
space based on its assessment of the media and then adds a dagger (†) next to the item 
the pop-up menu.

3.	 If you think Compressor inaccurately interpreted the color data in the source file, 
change the assigned color space by choosing a different option from the pop-up menu.

Note: Changing this property to another option doesn’t convert the exported file to a 
different color space, it just changes how Compressor interprets the source media.  
To transcode to a different color space, see Transcode a video file to a different  
color space.



59Compressor User Guide

View or modify HDR metadata

When a user plays the exported video on a TV or display that supports HDR, the device 
detects the metadata and automatically adjusts its color levels. (HDR transcoding in 
Compressor requires macOS 10.13 or later.)

1.	 Select a job in the Compressor batch area.

2.	 In the HDR Metadata area of the Job inspector, view or modify the available properties 
as needed:

•	 Include HDR metadata: To include HDR metadata in your output file, select this 
checkbox. (If Compressor detects HDR metadata in the source file, it automatically 
checks this box.)

•	 Primaries: Use this pop-up menu to select a standard preset color space, or choose 
Custom to set your own chromaticity coordinate values.

•	 Red, Green, Blue, White point: Displays chromaticity coordinates (an x value and a 
y value) for each of the three primary colors and for the white point of the targeted 
display (an HDR-capable device).

•	 White Point: Use this pop-up menu to select a standard preset white point, or 
choose Custom to enter your own in the value fields.

•	 Luminance: Displays the minimum and maximum luminance of the targeted display in 
nits (candelas per square meter).

•	 MaxCLL: Displays the value, in nits, of the brightest pixel in the video file (Maximum 
Content Light Level).

•	 MaxFALL: Displays the value, in nits, of the maximum average light level for any 
single frame in the video file (Maximum Frame Average Light Level).

Transcode a video file to a different color space

Some transcoding presets let you change the color space of the output video.

Note: If you modify the properties of an applied preset in the output row of a job, the 
modifications apply to only that output. If you modify the properties of a custom preset, 
your modifications are saved for future use.

1.	 In Compressor, select an applied or custom preset.

2.	 In the Video Properties section of the Video inspector, click the “Color space” pop-up 
menu and choose an option. (The options may vary based on the preset’s format.)

•	 Automatic: The color space assigned by Compressor (in the “Color space” pop-up 
menu in the Job inspector).

•	 Rec. 601 (NTSC): An older, standard-gamut color space designed for interlaced 
analog video signals in North America and Japan.

•	 Rec. 601 (PAL): An older, standard-gamut color space designed for interlaced analog 
video signals in Europe.

•	 Rec. 709: The standard-gamut, 8-bit color space used by high-definition TV 
displays, the Blu-ray Disc format, and most TV broadcasters.

•	 Rec. 2020: A wide-gamut color space developed for future consumer display  
devices but useful today for mastering (to future-proof your projects) and for  
4K and 8K TV projects.
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•	 Rec. 2020 PQ: The Rec. 2020 color space using the perceptual quantizer (PQ), 
a mathematical transfer function that converts image signal values in a video file 
to absolute light levels on an HDR-capable display. Designed to approximate the 
sensitivity of human eyes, PQ allows for better levels of contrast at all light levels. 
Use this option to output files in the HDR10 format.

•	 Rec. 2020 HLG: The Rec. 2020 color space using hybrid log-gamma, a mathematical 
transfer function that converts image signal values in a video file to scene-relative 
light levels. HLG, which was developed by the BBC and the NHK (Japan Broadcasting 
Corporation), requires no metadata and is also compatible with SDR displays.

•	 P3 D65 PQ: Combines the Display P3 color space (the wide color gamut used by 
newer Apple devices and by wide-gamut 4K TVs) with the perceptual quantizer (PQ) 
function to convert color and luminosity values to high-dynamic-range levels of 
contrast.

•	 sRGB (IEC 61966-2-1): The industry-standard color space for computer displays, 
similar to Rec. 709. This standard is used for most digital still images in formats such 
as JPEG, GIF, PNG, TIFF, BMP, and so on.

Note: If you transcode a standard-gamut source file to a wide-gamut color space, you 
won’t improve the video’s appearance. Similarly, if you transcode an 8-bit, standard-
dynamic-range file using a 10-bit HDR option, you won’t change the video’s appearance 
(because Compressor can’t create additional resolution that wasn’t there to begin with).

Add video and audio effects

Add and remove effects in Compressor

Compressor provides a variety of video and audio effects that you can add to a given 
preset to improve the quality of the transcoded file or introduce stylistic elements like 
fades or watermarks. For a full list of available effects, see Video effects and Audio effects.

Because effects are processed one by one by Compressor during transcoding—starting 
with the first item in the list—it’s important that you add the effects in the order you want 
them applied. For example, it’s sensible to add a text overlay effect last in your list of 
effects so that its text color isn’t modified by other effects.

Note: If you add an effect to an applied preset in the output row of a job, the effect applies 
to only that output. If you add an effect to a custom preset, the effect is applied whenever 
you apply the preset.

Add a video or audio effect

1.	 In Compressor, select an applied or custom preset.

2.	 Do either of the following:

•	 Add a video effect: In the Video Effects section at the bottom of the Video inspector, 
click the Add Video Effect pop-up menu, then choose an option.

•	 Add an audio effect: In the Audio Effects section at the bottom of the Audio 
inspector, click the Add Audio Effect pop-up menu, then choose an option.

After you choose an effect from the pop-up menu, its adjustable properties appear at 
the bottom of the inspector. You can apply multiple video and audio effects.
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3.	 Preview effects that you’ve added by clicking  in the preview area.

Because effects may interact in unexpected ways, be sure to preview the transcoded 
file each time you add an effect.

Note: Depending on your system, the source media file type and the number of effects 
in the job, the preview area showing the filter presets may update at a lower frame rate 
than the source frame rate.

Turn an effect off or on

After adding an effect to a preset, you can turn its properties off or on. This can be useful 
when previewing an effect.

1.	 In Compressor, select the relevant preset.

2.	 Do either of the following:

•	 Turn a video effect on or off: In the Video Effects section at the bottom of the Video 
inspector, click the activation checkbox next to the effect name.

•	 Turn an audio effect on or off: In the Audio Effects section at the bottom of the Audio 
inspector, click the activation checkbox next to the effect name.

Remove an effect from a preset

1.	 In Compressor, select an applied or custom preset.

2.	 Do either of the following:

•	 Remove a video effect: In the Video Effects section at the bottom of the  
Video inspector, click the Add Video Effect pop-up menu, then choose a 
checkmarked item.

•	 Remove an audio effect: In the Audio Effects section at the bottom of the  
Audio inspector, click the Add Audio Effect pop-up menu, then choose a 
checkmarked item.

The effect’s properties are removed from the list below the pop-up menu.

Video effects in Compressor

When you add a video effect to a preset in Compressor, you can choose from the effects 
listed below.

Video effect Description

Black/White Restore Compresses the solid black and white areas in the video. This effect can 
restore nearly black colors to pure black and restore nearly white colors 
to pure white without affecting colors in the rest of the image. Drag the 
sliders to set the black and white values between 0 and 100.

Brightness and Contrast Brightens or darkens the overall color and luminance of the video. Drag 
the sliders to set brightness and contrast values between –100 and 100.

Color Correct Highlights, Color 
Correct Midtones, Color Correct 
Shadows

Corrects white balance inaccuracies and creates color effects on the 
bright, midtone, or dark areas of the video. Drag the sliders to set red, 
green, and blue values between –100 and 100.
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Video effect Description

Custom LUT Applies a custom lookup table (LUT) to the video. This effect has the 
following properties:

•	 LUT file: Click the Select button to specify a LUT file to use for the 
effect.

•	 Color space: Use this pop-up menu to select the target color space for 
the video.

Fade In/Out Adds a dissolve and a matte color at the beginning and end of the clip. 
This effect has the following properties:

•	 Fade in duration/Fade out duration: Enter a time in the text field to set 
the duration of the fade-in and fade-out effects.

•	 Fade in opacity/Fade out opacity: Drag the sliders to set the opacity of 
the clip’s video at the first and last frames. A value of 0.0 sets the clip 
video to be completely covered by the matte color; a value of 0.5 sets 
the clip to be 50 percent covered by the matte color; and so on.

•	 Fade color: Click the color well to set the fade-in and fade-out color.

Gamma Correction Controls the range of brightness in an image. This effect can be used to 
remove detail from an underexposed clip or to reduce the saturation of an 
overexposed clip. Drag the slider to set gamma values between 0.1 and 
4.0.

Noise Removal Reduces random flecks of noise in the video file, including noise 
introduced by codecs, allowing you to blur areas of low contrast 
while leaving high-contrast edges sharp. This effect has the following 
properties:

•	 Apply to: Use this pop-up menu to set the channels from which noise is 
filtered. Choose “All channels” to filter noise from all channels including 
the alpha channel. Choose “Chroma channels” to filter noise from the 
two chroma channels (U and V) in YUV.

•	 Iterations: Choose the number of noise-smoothing passes from this 
pop-up menu. The file resulting from the first pass is used for the 
second pass, and so on, so that the more times a pass is performed, 
the fuzzier the image becomes.

•	 Algorithm: Choose a noise-smoothing algorithm from this pop-up menu. 
Choose Average to modify each pixel’s color by taking an average 
of pixels around it, including its own color value. Choose Replace to 
modify each pixel’s color by taking an average of pixels around it, while 
ignoring its own color value. Choose Merge to modify each pixel’s color 
by taking a weighted average of surrounding pixels and itself (with the 
pixel’s own color value given greater weight).

Sharpen Edge Sets the contrast around object edges. This effect can counteract the 
softening caused by noise removal or blurred source material and increase 
the perception of sharpness in the video. Drag the slider to set sharpening 
between 0.0 and 100.0.

Text Overlay Superimposes text onto the image. This effect has the following 
properties:

•	 Position: Choose a position for the text overlay from the pop-up menu.

•	 Alpha: Drag the slider to set the text opacity between 0 (completely 
transparent) and 1 (completely opaque).

•	 Overlay text: Type text in this field.

•	 Text color: Click the color well to set the text color.

•	 Font: Click the Select button to set the font, style, and size.

•	 Automatic font size: Select this checkbox to have Compressor 
automatically choose the size of the font based on the frame size of the 
source material.
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Video effect Description

Timecode Generator Superimposes the clip’s timecode onto the video. This effect has the 
following properties:

•	 Position: Choose a position for the timecode overlay from the pop-up 
menu.

•	 Alpha: Drag the slider to set the text opacity between 0 (completely 
transparent) and 1 (completely opaque).

•	 Label: Optionally, type text that you want to appear to the left of the 
timecode number.

•	 Start timecode at 00:00:00:00: Select this checkbox to have the 
timecode start at zero. When the checkbox is not selected, the 
timecode starts at the video’s timecode.

•	 Text color: Click the color well to set the text color.

•	 Font: Click the Select button to set the font, style, and size.

•	 Automatic font size: Select this checkbox to have Compressor 
automatically choose the size of the font based on the frame size of the 
source material.

Watermark Superimposes a still image or a movie file onto the video. This effect has 
the following properties:

•	 Position: Choose a position for the watermark from the pop-up menu.

•	 Scale by: Drag the slider to set the watermark image’s scaling between 
1 (actual size) and 10 (10 times the actual size).

•	 Alpha: Drag the slider between 0 (completely transparent) and 1 
(completely opaque) to adjust the watermark’s opacity.

•	 Repeat: If you are using a video clip for the watermark image, select 
this checkbox to loop the playback of the watermark clip throughout the 
duration of the source file.

•	 Watermark: Click the Select button to specify a still image or video file 
to use for the watermark.

Audio effects in Compressor

When you add an audio effect to a preset in Compressor, you can choose from the effects 
listed below.

Note: Audio effects are not available in some presets when the “Enable audio pass-
through” checkbox is selected in the Audio inspector.

Audio effect Description

Apple: AUGraphicEQ Configures a wide variety of frequencies throughout the audible frequency 
range. Click Options to open the graphic equalizer window, then choose 
either a 31-band version or a 10-band version from the pop-up menu at 
the bottom. Adjust frequencies by doing any of the following:

•	 Drag a slider to adjust the level of a frequency band.

•	 Select a frequency slider and then type a number in the dB field (in the 
lower-right corner of the graphic equalizer window).

•	 Click Flatten EQ to set all bands to a 0.0 dB value.

•	 Drag to select multiple bands and then adjust the group.

•	 Hold down the Control key while dragging across the bands to “draw” 
an equalization curve.
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Audio effect Description

Dynamic Range Controls audio levels by enhancing the quieter parts and lowering the 
louder parts. This is also referred to as audio level compression. This 
effect has the following properties:

•	 Soften above: Drag the slider to set the level at which audio is reduced 
to the level set by the “Overall gain” control.

•	 Noise threshold: Drag the slider to set the level at which the effect is 
applied. Audio at and above the noise threshold is dynamically boosted 
to the level set by the “Overall gain” control, and audio below the noise 
threshold is not modified.

•	 Overall gain: Drag the slider to set the average level of the dynamically 
compressed audio.

Fade In/Out Adds an audio fade-in effect at the beginning of the clip and a fade-out at 
the end of the clip. This effect has the following properties:

•	 Fade in duration/Fade out duration: Enter a time in the text field to set 
the duration of the fade-in and fade-out effects.

•	 Fade in gain/Fade out gain: Drag the sliders between –100.0 (silence) 
and 0.0 (the audio’s volume) to set the audio volume at the start and 
end of the clip.

Peak Limiter Sets the level of the loudest audio allowed in the clip. Drag the Gain slider 
to set the level above which louder peaks are reduced.

Add markers in Compressor
A marker flags a specific timing location in a source file. You can use Compressor to 
append markers to your job with editing notes or other descriptive information.

Markers can be output when using presets based on the Apple Devices (with H.264 codec), 
MPEG-2, MPEG-4, and QuickTime Movie preset formats. When you output the source file to 
an H.264, MPEG-2, or MPEG-4 video format, each marker forces the creation of an I-frame. 
Added I-frames improve compression quality, but can increase overall file size.

Important: Although you can set and configure markers for all jobs, only jobs that use the 
output file formats listed above will output a file that includes markers.

Add a marker to a source file

1.	 In Compressor, select the job that contains the source file to which you want to  
add markers.

2.	 In the preview area, identify where to place the marker by doing one of the following:

•	 Drag the playhead  to where you want to add a marker.

•	 Enter a timecode value in the playhead timecode field.
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3.	 To add a marker, click  (or press M).

An orange chapter marker appears in the source file’s timeline in the preview area.

4.	 To change the marker type, click the Type pop-up menu in the Marker inspector, then 
choose a different marker type.

Compression markers and edit markers do not have editable properties. For chapter 
markers and podcast markers, you can adjust the following properties:

•	 Name: Enter a name for the marker. During playback of a transcoded file, chapter 
marker names are displayed on Apple playback devices, in QuickTime Player, and  
in DVD menus. Podcast marker names are not displayed.

•	 URL: Enter a web address. When viewing the transcoded file, you can click the URL 
to open a web browser and view a website.

•	 Image: Select an image to be displayed at the marker point. You can set no image, 
use the frame on which the marker is placed, or upload a different image file.

Change the default marker type

When you add a new marker, it’s automatically set as a chapter marker. You can change 
this default so new markers are always added as one of the other types of markers.

•	 In the Compressor preview area, click the arrow next to the Marker button , then 
choose an item in the Default Marker category.

Hide markers

Compressor can show or hide different types of markers.

•	 In the Compressor preview area, click the the arrow next to the Marker button , then 
choose Chapter/Podcast Markers, Compression Markers, or Edit Markers in the Show 
category to remove the checkmark.

To reveal a type of markers, select the same item in the pop-up menu so that the 
checkmark reappears.
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Remove markers

1.	 Select a job in the Compressor batch area, and then select a marker in the preview area.

You can also select markers by clicking  or  in the preview area.

2.	 Do one of the following:

•	 Remove all markers in the source file: Click the arrow next to the Marker button , 
then choose Remove All Markers.

•	 Remove one marker: Select a marker, then click .

Add markers using a chapter marker list

You can import a list of timecode points into Compressor to create chapter markers.

The file containing the list of timecode points must follow these rules:

•	 The list of timecode values must be a plain text file. For best results, create the list with 
TextEdit and save the files using the .chp or .txt extension.

•	 Each marker must be on a new line that starts with a timecode value in the format 
00:00:00:00.

•	 After the timecode value, you can include a name for the marker. You can use a space or 
tab character to separate the timecode value from the marker name.

•	 Any lines that do not begin with a timecode value are ignored. This makes it easy for 
you to add comments to the list.

•	 The timecode values do not have to be listed in chronological order.

After creating the list, import it into Compressor:

1.	 In Compressor, select the job that you want to add markers to.

2.	 In the preview area, click the arrow next to the Marker button , then choose Import 
Chapter List.

3.	 In the window that appears, select your chapter marker file and click Open.

The markers are added to the source file as chapter markers. You can view them in the 
preview area.

Marker types in Compressor
Compressor can create the following types of markers:

Marker type Description

Chapter markers Generate named index points for for DVDs, QuickTime movies, or video 
podcasts, and thumbnail images for QuickTime movies. You can also 
assign a URL to a chapter marker to have that URL appear during playback 
of a podcast. Chapter markers are also included in submissions to the 
iTunes Store as part of an iTunes Store package. Chapter markers appear 
orange in the Compressor preview area.

Compression markers Generate an I-frame, but do not generate thumbnails, chapter-track 
entries, or other metadata. Add them to a video if a section appears to 
have lower image quality than the surrounding frames. Compression 
markers appear blue in the Compressor preview area.
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Marker type Description

Edit markers Function identically to compression markers and are commonly used by 
compression artists to force an I-frame at an edit point to ensure higher 
image quality at that moment in the video. Edit markers appear red in the 
Compressor preview area.

Podcast markers Like chapter markers, podcast markers can have artwork and a URL 
assigned to them. Podcast markers are usually used to provide a 
slideshow (with URLs) for users to view when playing audio podcasts. 
However, podcast marker names do not appear in the slideshow, and users 
can’t navigate to a podcast marker in the transcoded file. Podcast markers 
appear purple in the Compressor preview area.

Set a poster frame in Compressor
The poster frame is a still image that represents a video or audio media file.

Note: When viewing the output file in Apple TV Home Videos, if no poster frame is set, 
Apple TV Home Videos automatically uses the frame 10 seconds from the movie’s first 
frame as the poster frame.

Set the poster frame for a job

1.	 In Compressor, select the job that contains the source file that you want to set a poster 
frame for.

2.	 In the preview area, position the timeline playhead  at the frame you want to be the 
poster frame.

3.	 Click the arrow next to the Marker button , then choose Set Poster Frame.

A poster frame marker  appears in the timeline.

After you set a poster frame, you can jump to that frame at any time by clicking the arrow 
next to the Marker button , then choosing Go to Poster Frame.

Remove the poster frame

•	 In the Compressor preview area, click the arrow next to the Marker button , then 
choose Clear Poster Frame.

Work with metadata annotations in Compressor
You can embed metadata into files transcoded using the Apple Devices, Apple ProRes, 
MP3, MPEG-4, and QuickTime presets. Use metadata to annotate a media file with 
information that’s important for your workflow or for the person viewing your output file. 
You can add any of the annotation fields provided in Compressor, import metadata that’s 
used in another media file (like a QuickTime movie), or pass through existing metadata.



68Compressor User Guide

Add annotations to a media file

1.	 In Compressor, select the job that contains the source file you want to annotate.

2.	 In the Job Annotations area of the Job inspector, click the Fields pop-up menu, choose 
an annotation type, then enter text in the field that appears.

3.	 Repeat step 2 for each annotation type you want to add.

Note: You can also import metadata annotations from an external QuickTime movie or 
from an XML dictionary property list by clicking the Fields pop-up menu, then choosing 
Import. Compressor recognizes the following metadata categories in QuickTime movie 
files and XML property list files:

com.apple.quicktime.album

com.apple.quicktime.artist

com.apple.quicktime.author

com.apple.quicktime.comment

com.apple.quicktime.copyright

com.apple.quicktime.creationdate

com.apple.quicktime.description

com.apple.quicktime.director

com.apple.quicktime.displayname

com.apple.quicktime.genre

com.apple.quicktime.information

com.apple.quicktime.keywords

com.apple.quicktime.location.ISO6709

com.apple.quicktime.producer

com.apple.quicktime.publisher

com.apple.proapps.reel

com.apple.quicktime.software

com.apple.quicktime.title

com.apple.quicktime.collection.user

com.apple.quicktime.rating.user

com.apple.quicktime.year

The annotations you added are shown in fields below the pop-up menu.

Note: If you see the message “Some source file annotations cannot be displayed,” your job 
contains metadata—lyrics, for example—that Compressor cannot display. See the next task.
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Modify pass-through metadata

You can choose how to handle metadata in your transcoding presets.

Note: If you add an effect to an applied preset in the output row of a job, the effect applies 
to only that output. If you add an effect to a custom preset, the effect is applied whenever 
you apply the preset.

1.	 In the Compressor batch area, select an applied or custom preset.

2.	 In the Metadata section of the General inspector, choose an option:

•	 Use Job Annotations: Includes the metadata from the Job Annotations listed in the 
Job Inspector. This is the default preset.

•	 Pass through source file metadata: Passes the existing metadata from the source file 
to the transcode. Ignores Job Annotations listed in the Job Inspector.

•	 Remove all metadata and annotations: Passes no metadata to the transcode.

•	 Include metadata from the source file that cannot be displayed as a job annotation: 
Available when Use Job Annotations is selected. Includes the metadata from the Job 
Annotations listed in the Job inspector and passes the existing metadata from the 
source file to the transcode.

View annotations after transcoding

After Compressor transcodes a media file that has metadata, there are several ways to see 
the annotations:

•	 In the macOS Finder, select the transcoded media file, choose File > Get Info, then click 
the disclosure triangle next to More Info.

•	 Open the media file in QuickTime Player, then choose Window > Show Movie Inspector.

QuickTime Player displays several (but not all) categories of Compressor metadata at 
the top of the inspector.

•	 After importing the media file into Final Cut Pro, select the clip and open the Info 
inspector. For more information, see the Final Cut Pro for Mac User Guide.

https://support.apple.com/guide/final-cut-pro/ver64e70f49/
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Preview and transcode

Intro to previewing and transcoding in Compressor
After you import source media and apply transcoding instructions in Compressor, there are 
only a few steps left in the transcoding process:

•	 Preview transcoding jobs.

•	 Review batch details and any errors or warnings.

•	 Transcode the batch.

You can also send content from Final Cut Pro or Motion directly to Compressor for 
transcoding. See Transcode Final Cut Pro and Motion projects.

Preview jobs in Compressor
Before you process a job, you can preview what your transcoded files will look like. The 
preview area has a number of tools to help you visualize how your final output will appear.



71Compressor User Guide

Preview how a transcoded file will look and sound

1.	 In Compressor, select an applied preset’s output row in the batch area.

2.	 Do either of the following:

•	 Click  in the preview area if it isn’t already highlighted.

•	 Click View (in the upper-right corner of the preview area), then, under Display 
options, choose Source and Output.

A divider appears in the preview area, with the source media on the left side and the 
transcoded file on the right side.

 Tip: Click and drag the divider in the middle of the preview area to see more or less 
of the source media.

3.	 Click .

The source file video plays on the left side of the preview area, and a preview of the 
transcoded file plays on the right side. The transcoded audio plays through your 
computer speakers (or through connected speakers or headphones).

Customize the preview area

Use any of the following controls to customize the preview area:

•	 Change the timecode display: Click the disclosure arrow to the right of the timecode in 
the preview area, then select Timecode, Seconds, or Frames.

•	 Choose which aspect ratio to use in the preview: Click View, then, under Aspect Ratio, 
choose Source or Output.

•	 Zoom in or out of the preview area: Click the Zoom pop-up menu (in the upper-right 
corner of the preview area), then choose a zoom level.

Note: When the preview area is zoomed to a level greater than 100%, you can’t view 
the entire image at once. However, you can scroll the preview area to see compression 
or scaling artifacts in detail by dragging the inner box of the navigation control (in the 
upper-right corner of the zoomed-in preview area).

•	 Change the background of the preview area: Click View, then, under Background, 
choose an option:

•	 Black to Media Edge: The preview area background is dark gray. (If the source media 
file has an alpha channel, the transparent area is black.)

•	 Black: The preview area background is black.

•	 White: The preview area background is white.

•	 50% Gray: The preview area background is light gray.

•	 Checkerboard: The preview area background is a checkerboard pattern.
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Change which eye to assign a stereoscopic video preview

When you preview stereoscopic video, you can specify which eye’s view you want to see in 
the preview area.

1.	 In a stereoscopic job in the Compressor batch area, do one of the following:

•	 Select the source media.

•	 Select the output row that includes the preset you want to preview.

Note: If you’re previewing stereoscopic video that uses separate files for each eye, 
make sure the Comparison button  in the preview area is turned off.

2.	 Click the View menu (in the upper-right corner of the preview area) and choose “Left 
eye” or “Right eye.”

Note: The default eye view is labeled “hero.”

If the stereoscopic source media uses separate left- and right-eye files, changing the 
View option switches between the two files. For frame-packed stereoscopic source media, 
changing the View option shows you the portion of the image designated for the left or 
right eye.

Note: Working with MV-HEVC encoded video requires a Mac with Apple silicon and macOS 
14 or later. Other systems treat MV-HEVC stereoscopic video as monoscopic HEVC files, 
using only the hero eye.

View caption text in the preview area

If you’ve added captions to your job, you can view that text in the preview area.

1.	 In the Compressor batch area, select the output row for the job containing closed-
caption data.

2.	 In the preview area, click .

When this button is highlighted, captions are shown in the preview area.

3.	 To stop displaying captions, click  again.

For specific information about previewing iTunes Store packages, see Build an  
iTunes Store package.
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Review batch details in Compressor
After applying transcoding instructions in Compressor, you can review all of the relevant 
details in the batch area.

•	 Source file: The media file that you want to transcode.

•	 Preset: The transcoding instructions that specify how the file will be processed. 
Compressor provides a variety of built-in presets that you can use to output files  
in common media formats, or you can create a custom preset.

•	 Location: The place on your computer or a connected device where the transcoded file 
will be saved. You can use one of the built-in locations, or specify a new location.

•	 Filename: The title of the transcoded file. You can use the default filename (the name  
of the source file) or enter a new filename.

•	 Job action: An optional post-transcoding action you can add to a job. Each of the  
built-in destinations already contains a job action. See Job actions.

•	 Captions file: A supplemental text file in the CEA-608, iTT, or SRT format that you  
can optionally add to a job to create synchronized closed captions or subtitles. See 
Import captions.
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Review errors and warnings in Compressor
The Errors & Warnings window in Compressor lists any errors or warnings that may prevent 
a batch from being properly processed. If you see an alert icon (  or ) in the batch area, 
there are one or more problems with the batch.

1.	 In Compressor, click an alert icon in the batch area.

Alerts showing a yellow yield sign  are warnings that won’t prevent a batch from 
being started but may result in errors or unexpected results. Alerts showing a red  
stop sign  are errors that must be fixed before a batch can be started.

2.	 In the Errors & Warnings window, click an alert message to highlight the affected item in 
the batch area. 

Note: Some errors visible in the Errors & Warnings window don’t have a corresponding 
alert icon in the batch area.

3.	 Fix errors and address alerts as needed.

For more information about reviewing errors in captions files, see View caption  
error warnings.

Transcode a batch in Compressor
After you’ve configured jobs in your batch with the presets, job actions, locations, and 
filenames that you want, you can transcode the batch.
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View batch properties

•	 In Compressor, click the batch row at the top listing all of the source files in the batch.

The batch properties are displayed in the Batch inspector:

•	 Name: Identifies how the batch will appear in Active and Completed views once you 
start the batch. To change the batch name, type a new name in this field.

•	 Jobs: Displays the number of jobs in the batch.

•	 Outputs: Displays the number of files that will be output when transcoding the batch.

Transcode a batch

•	 In Compressor, click the Start Batch button in the lower-right corner of the batch area 
and, if necessary, follow the instructions to complete the transcoding process.

Monitor transcoding progress

In Active view, you can see the status of transcoding jobs that are in progress.

1.	 In Compressor, click the Active button at the top of the Compressor window.
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2.	 Select a batch, job, or output row to view more details in the inspector.

3.	 On the right side of a batch, job, or output row, click  to pause transcoding,  to 
resume transcoding, or  to cancel transcoding.

View information about completed jobs

In Completed view, you can see how a file was transcoded.

1.	 In Compressor, click the Completed button at the top of the Compressor window.

2.	 Select a batch, job, or transcoded file to view more details in the inspector.

3.	 Optionally, do either of the following:

•	 Click  on the right side of an output file’s row to view the file in the macOS Finder.

•	 Click  on the right side of a batch or job row to create a new job or batch with the 
same source media and transcoding instructions.

Transcode Final Cut Pro and Motion projects in 
Compressor
If you have Final Cut Pro or Motion installed on the same computer as Compressor, you 
can send sequences or clips from Final Cut Pro or Motion directly to Compressor for 
transcoding. You cannot mix projects and clips in a batch share—your selection must be 
projects only or clips only.

Important: To export from Final Cut Pro or Motion using Compressor, update to the latest 
version of each app and make sure the apps are compatible. Both apps must be either part 
of Apple Creator Studio or one-time purchase.

For more information, see the Final Cut Pro User Guide and the Motion User Guide.

https://support.apple.com/guide/final-cut-pro/ver1ff89071/mac
https://support.apple.com/guide/motion/motn189cf6cf/mac
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Automate your workflow

Create a preset group in Compressor
If you regularly need to add specific set of presets at once, you can create a preset group.

1.	 In the Presets pane in Compressor, click , then choose New Group.

2.	 In the dialog that appears, type a name for the group and click OK.

The group appears in the Custom area of the Presets pane.

3.	 To add a preset to your group, drag it to the group name in the Presets pane.

Note: You can only add custom presets to a preset group. If you want to add one of 
Compressor’s built-in presets to your preset group, you can duplicate it.

Chain jobs in a batch in Compressor
You can chain jobs together, using the output of a job as the source for subsequent jobs in 
a batch.

1.	 In the Compressor batch area, Control-click the output row that you want to use as a 
source, then choose New Job With Selected Output from the shortcut menu.

A new job with a link icon appears at the bottom of the batch area.

2.	 Add presets or other transcoding instructions to the new linked job as needed.
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Use a watch folder to automatically transcode files
You can designate any folder on your Mac or on a connected device to be a watch folder 
that automatically transcodes any media files you add to it.

Note: Watch folders can be used to transcode frame-packed stereoscopic source files with 
accurate metadata; however, they cannot be used to transcode other stereoscopic formats.

Open the Watch Folders pane

•	 Click Watch Folders at the top of the Current view in the Compressor window.

Note: Watch folders continue to process files even if Compressor is running in the 
background or you’re viewing another part of the Compressor window. If you’re viewing 
the batch area, a spinning folder icon indicates when a watch folder is currently 
processing files.

Add a watch folder

1.	 In the Watch Folders pane of Compressor, do one of the following:

•	 Click Add in the top right-corner.

•	 If you don’t have any watch folders yet, click the Add Watch Folder button in the 
middle of the pane.

2.	 In the window that appears, select a folder, then click Add.

This is the folder where you can add the source media that you want to transcode 
automatically.

3.	 In the window that appears, select one or more presets    or destinations    from the 
list, choose a save location from the pop-up menu, then click OK.

These are the transcoding instructions that Compressor will automatically apply to any 
files you add to the watch folder, and the location where the transcoded files are saved.
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Add and remove presets from a watch folder

In the Watch Folders pane, you can add and remove presets the same way you add and 
remove presets in the batch area.

1.	 In the Watch Folders pane of Compressor, click Add on the right side of the watch 
folder’s Preset/Location/Filename row.

2.	 In the window that appears, select one or more presets, choose a save location from the 
pop-up menu, then click OK.

 Tip: You can also add a preset by dragging it from the Presets pane to a watch folder 
in the Watch Folders pane.

3.	 To remove a preset from a watch folder, do either of the following:

•	 Select the preset’s output row, then press Delete.

•	 Position the pointer over the preset’s output row, then click Remove (on the right 
side of the row).

Add a job action to a watch folder

You can add a job action to a watch folder to be performed on the output files  
after transcoding.

1.	 In the Watch Folders pane of Compressor, select a watch folder.

When a watch folder is selected, its properties are shown in the inspector pane.

2.	 In the Action area of the inspector, click the “When done” pop-up menu, then choose a 
job action.

Additional properties may appear, depending on the job action you select. See  
Job actions.

Activate or deactivate a watch folder

Watch folders need to be activated to monitor and process files.

Note: A watch folder must have at least one preset applied to it to be activated.

In the Watch Folders pane of Compressor, do one of the following:

•	 Click the checkbox to the left of the watch folder name.

•	 Select the watch folder, then click the Status pop-up menu in the inspector and  
choose Activated.

To deactivate a watch folder, click the checkbox again, or set the status in the pop-up 
menu to Deactivated.
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View and modify watch folder properties

1.	 In the Watch Folders pane of Compressor, select a watch folder.

When a watch folder is selected, its properties are shown in the inspector pane.

2.	 Adjust any of the following properties:

•	 Status: Activate or deactivate the watch folder. When a watch folder is active, you 
can no longer modify any of its properties.

•	 Name: Change the name of the watch folder in Compressor. This doesn’t change the 
name of the folder in the macOS Finder, but it affects the name of the automatically 
created output folder if you choose Automatic for the output location.

•	 Location: Choose a location for your watch folder. The current location of the watch 
folder is displayed below the Select button.

•	 Process using: If you’ve configured computer groups in Shared Computers 
settings, you can select one of your groups here. The default is This Computer. For 
information on setting up computer groups, see Transcode with multiple computers.

•	 When activating a Watch Folder, start processing files already present: By default, 
Compressor ignores files that are already in a watch folder before it’s activated. 
This way, you can leave files in the watch folder without the files being transcoded 
multiple times. However, if you dragged or saved files into a watch folder and want 
them to be processed when you activate the folder, select this checkbox.

Create and use droplets in Compressor
You can save one or more presets or a destination as a standalone application called a 
droplet. Using the droplet, you can easily transcode files by dragging them to the droplet 
icon in the macOS Finder.

Create a droplet

1.	 In the Presets pane in Compressor, select one or more presets, preset groups, or a 
destination that you want to save as a droplet.

If you selected more than one preset, a destination that contains two or more presets, 
or a group of presets, every preset in your selection will be included in the droplet. For 
example, if you submit two source media files to a Droplet containing three presets, 
Compressor creates six different output media files.

2.	 Click , then choose Save as Droplet.

3.	 In the window that appears, do the following:

•	 Enter a name for the droplet in the Save As field.

•	 Click the Where pop-up menu, then choose a location for the droplet.

•	 Click the Location pop-up menu, then choose a save location for the droplet.

4.	 Click Save.

Your newly created droplet appears as an icon in the location you chose in the 
Where menu.
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Transcode files using a droplet

1.	 From the macOS Finder, drag one or more media files onto the droplet you created  
in Compressor.

When you release the mouse button, the Droplet window opens.

2.	 In the Droplet window, optionally do either of the following:

•	 Click the Location pop-up menu, then choose a new save location.

•	 Click the “Process on” pop-up menu, then choose a computer or group  
of computers.

3.	 Click Start Batch.

The transcoded file appears in the location you specified.

Files you transcode using a droplet are visible in Active view and Completed view in the 
main Compressor window.
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Advanced transcoding

Create an Apple Immersive Video package in 
Compressor
You can use Compressor to prepare immersive media for viewing on Apple Vision Pro.

Note: Apple Immersive Video packaging requires a Mac with Apple silicon, macOS Sequoia 
15.6 or later, and at least 32 GB of memory (64 GB is recommended).

Import immersive media

1.	 In Compressor, do one of the following:

•	 Choose File > Add File.

•	 At the bottom of the batch area, click , then choose Add File.

2.	 Select an immersive video file, then click Add.

An immersive video file is a QuickTime movie file (.mov) containing two video tracks of 
the same duration with tags denoting right- and left-eye views, both of which have an 
Apple Immersive projection type.

 Tip: You can also drag an immersive video file directly into the batch area.

3.	 In the batch area, select the source file, then use the Choose buttons in the Immersive 
Properties area of the Job inspector to upload the following:

•	 Audio: An uncompressed BWF (Broadcast Wave File) or WAV file with immersive 
audio captured by spatial recording devices.

•	 Lens Data: An AIME (Apple Immersive Metadata Essence) bundle of lens data files 
that are referred to by the FCPXML file.

•	 FCPXML: A file in the Final Cut Pro XML format with metadata containing temporal 
rendering information that’s not burned into the source media.
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Apply immersive transcoding instructions

1.	 Apply the “Prepare for Apple Immersive Video streaming” destination to a job containing 
immersive source media.

Compressor applies the Prepare for Apple Immersive Video streaming job action and 
three presets:

•	 Apple Immersive Audio: Uses APAC encoding on the uncompressed WAV or BWF file 
to produce a compressed MP4 spatial audio file.

•	 Apple Immersive Video High: Produces a higher-quality AIVU file with an MV-HEVC 
encoded video, APAC encoded audio, and a temporal metadata track.

•	 Apple Immersive Video Low: Produces a lower-quality AIVU file with an MV-HEVC 
encoded video, APAC encoded audio, and a temporal metadata track.

Note: If you don’t need to prepare your immersive media for streaming, you can add  
one or more Apple Immersive presets individually. For instance, you can apply the  
Apple Immersive Video High preset, transcode the batch, then AirDrop the AIVU file  
to your Apple Vision Pro.

2.	 Adjust properties in the General and Video inspectors as needed.

Note: AIVU files are restricted to a frame rate of 90 fps. Frame size can be set to 
4320 x 4320 or 3600 x 3600.

Preview immersive media

After you import immersive media and apply transcoding instructions as described in the 
tasks above, there are several ways to preview immersive media.

Note: Realtime playback of immersive media requires 2000 MB/s or faster storage  
read speed.

1.	 In the Compressor batch area, select the output row that includes the immersive media 
you want to preview.

2.	 Click the View menu (in the upper-right corner of the preview area) and under 
Immersive, choose an option:

•	 180º: Displays an approximately fisheye view with all of the content that will be 
shown to a given eye.

•	 Forward Angle: Displays a constrained rectilinear view similar to what a user would 
see in Apple Vision Pro, but in 2D and constrained to a 90º field of view.

Note: Compressor does not support immersive audio preview. When previewing 
immersive media, you hear a mono downmix proxy.

For details on other preview options, including switching between eyes, see  
Preview jobs.
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Transcode the immersive media

1.	 In Compressor, configure the output location of your immersive job by doing either of 
the following:

•	 If you applied the “Prepare for Apple Immersive Video streaming” destination: Select 
the job in the batch area, navigate to the Action area (at the bottom of the Job 
inspector), then click Choose to determine the save location for your streaming files.

•	 If you applied a standalone Apple Immersive Video preset: Set the save location 
in the output row, then optionally apply the Add to Photos job action to send the 
immersive output to the Photos app.

2.	 Click Start Batch.

If you applied the Add to Photos job action, your AIVU file is exported to the location 
shown in the batch area, and also to the Photos app. On Apple Vision Pro, make 
sure you’re signed in to your Apple Account, then open the Photos app to view your 
immersive media.

Work with stereo 3D video

Encode spatial video for Apple Vision Pro in Compressor
Compressor can transcode stereoscopic 3D source video captured in a variety of formats 
to produce a spatial video for editing in Final Cut Pro or playback on Apple Vision Pro.

Note: Working with MV-HEVC spatial video requires a Mac with Apple silicon and macOS 14 
or later.

Import stereoscopic source media

There are three stereoscopic file types that you can use to create spatial video  
in Compressor:

•	 A pair of separate video files corresponding to left- and right-eye views

•	 A frame-packed stereoscopic video file in which the left- and right-eye views are 
displayed next to each other or one on top of the other

•	 An MV-HEVC-encoded spatial video recorded with the Camera app on iPhone 15 Pro, 
iPhone 16, iPhone 16 Pro, or Apple Vision Pro

1.	 In Compressor, do one of the following:

•	 Choose File > Add File.

•	 At the bottom of the batch area, click , then choose Add File.
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2.	 Do one of the following:

•	 Import a frame-packed encoded stereoscopic video: Select the source file, then 
click Add. In the Job inspector, click the Stereoscopic pop-up menu, then choose 
Side by Side or Over/Under, depending on the frame-packing format of the  
source file.

•	 Import a separate video file for each eye: Select the left-eye video, then click Add.  
In the Job inspector, click the Stereoscopic pop-up menu and choose Separate Files. 
Click Choose next to Right, select the right-eye video, then click Open.

•	 Import an MV-HEVC-encoded spatial video: Select the source file, then click Add.

3.	 Set or override stereoscopic job properties of your source media as needed.

Apply Apple Vision Pro MV-HEVC transcoding instructions

1.	 In the Compressor batch area, click Add on the right side of the Preset/Location/
Filename row under the stereoscopic source media, then choose the Apple Vision Pro 
(MV-HEVC, Stereoscopic) preset.

2.	 In the Video inspector, make sure the Stereoscopic pop-up menu is set to Both Eyes 
(Multiview); this automatically sets the Codec pop-up menu to MV-HEVC.

Note: These settings are required to output spatial video compatible with 
Apple Vision Pro.

3.	 Adjust other properties in the General, Video, and Audio inspectors as needed.

For more information on stereoscopic and spatial properties, see Modify stereoscopic 
and spatial properties in Compressor.

4.	 Click Start Batch.

Compressor exports the transcoded file to the location shown in the batch area. You can 
also send the file to the Photos app for easy sharing and viewing on Apple Vision Pro 
(described below).

Send spatial video output to the Photos app

1.	 Set up a transcoding job with stereoscopic source media and add the Apple Vision Pro 
(MV-HEVC) encoding preset.

2.	 Select the source file in the batch area, then scroll down to the Action section of the 
Job inspector.

3.	 Click the “When done” pop-up menu, then choose Add to Photos.

4.	 In the Title field, enter a name for the video.

5.	 Click Start Batch.

Your spatial video file is exported to the location shown in the batch area, and also to 
the Photos app.

On Apple Vision Pro, make sure you’re signed in to your Apple Account, then open the 
Photos app to view your spatial video.
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Modify stereoscopic and spatial properties in Compressor
There are two places to adjust the properties of stereoscopic video and spatial video  
in Compressor:

•	 Job inspector: When you import stereoscopic or spatial source media, Compressor 
detects any stereoscopic or spatial metadata present in the file and displays that 
information in the Job inspector. If the source video has no stereoscopic or spatial 
metadata, or if that metadata is incorrect, you can assign it in the Job inspector.

•	 Video inspector: When you apply a preset to a stereoscopic job, Compressor configures 
stereoscopic and spatial properties for the transcoded file accordingly. If necessary, 
you can modify these properties in the Video inspector.

Adjust stereoscopic and spatial properties of source media

When you import stereoscopic source media, Compressor automatically tries to determine 
the associated stereoscopic properties. You can set or override these properties in the  
Job inspector.

1.	 Select a stereoscopic job in the Compressor batch area.

2.	 In the Projection Properties area of the Job inspector, set or override the following 
stereoscopic properties:

•	 Stereoscopic: Specifies the format of the stereoscopic media. Choose an option:

•	 Off (Monoscopic): The source media is not formatted for stereoscopic viewing.

•	 Side by Side: The source media is a single frame-packed stereoscopic file in 
which left- and right-eye images are displayed side by side.

•	 Over/Under: The source media is a single frame-packed stereoscopic file in 
which the left-eye layer is the top of the image and the right-eye layer is the 
bottom of the image.

•	 Separate Files: The source media is a pair of separate files—one for the left eye, 
and one for the right eye.

When Stereoscopic is set to Separate Files, Left and Right eye options become 
available (and the job’s source file is automatically assigned to the left eye). To 
assign a source file for the right eye, click Choose next to Right, then select a file.

Note: The Separate Files option uses audio in the left-eye file and ignores audio in 
the right-eye file.

•	 Hero Eye: Choose whether the left or right eye should be used as the hero eye 
(default eye) when transcoding to a stereoscopic format.

•	 Spatial Metadata: Select this checkbox to set or override the spatial metadata 
included in the source file. When this checkbox is selected, three spatial metadata 
options appear:

•	 Field of View: The horizontal field of view of the lenses used to capture  
the images.

•	 Baseline: The horizontal distance between the two camera lenses used to capture 
the images (also known as the interaxial distance).
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•	 Horizontal Disparity: The amount of horizontal shift in left- and right-eye images 
to set the perceived depth of a 3D scene. When horizontal disparity is negative, 
content in the footage appears closer; when it’s positive, content seems  
farther away.

•	 Projection: Use this pop-up menu to set the projection mode for 360° video. See 
Work with 360-degree video.

Note: If the source media is MV-HEVC stereoscopic video (recorded on an iPhone 15 Pro, 
iPhone 16, iPhone 16 Pro, or Apple Vision Pro), the Projection Properties are determined 
from the file’s metadata, and all controls in the Projection Properties area are dimmed. 
Working with MV-HEVC encoded video requires a Mac with Apple silicon and macOS 14 or 
later. Other systems treat MV-HEVC stereoscopic video as monoscopic HEVC files, using 
only the hero eye.

Modify stereoscopic and spatial properties of custom and applied presets

To configure the stereoscopic or spatial settings of your transcoded output, you can 
modify the settings of an applied or custom preset in the Video inspector.

1.	 In Compressor, select a custom preset in the Presets pane or select an applied preset in 
the batch area.

2.	 In the Video Properties section of the Video inspector, click the Stereoscopic pop-up 
menu, then choose an option to set the left- and right-eye format:

•	 Automatic: Compressor assigns a stereoscopic or monoscopic output setting based 
on the source media. For monoscopic output, Compressor uses the hero eye if it can 
be determined from the file’s metadata; otherwise, the left eye is chosen.

•	 Left Eye Monoscopic: Uses the left-eye view of the stereoscopic source to output a 
monoscopic video.

•	 Right Eye Monoscopic: Uses the right-eye view of the stereoscopic source to output 
a monoscopic video.

•	 Over/Under: Sets the transcoded video to a frame-packed stereoscopic output in 
which the left-eye view is the top of the image and the right-eye view is the bottom 
of the image.

•	 Side by Side: Sets the transcoded video to a frame-packed stereoscopic output in 
which the left- and right-eye views are shown next to each other.

•	 Both Eyes (Multiview): Uses both eye views of the stereoscopic source to output a 
stereoscopic video. Choosing this option automatically sets the codec to MV-HEVC. 

3.	 In the Video Properties section of the Video inspector, click the Spatial Video pop-up 
menu, then choose to include or exclude spatial metadata in the transcoded video:

•	 Automatic: Automatically applies any spatial metadata contained within the  
source file.

•	 Off: Does not include spatial metadata in the transcoded video.

•	 On: Includes custom spatial metadata in the transcoded video. When Spatial Video 
is set to On, you can modify the source file’s default field of view, baseline, and 
horizontal disparity. (Adjusting these values changes the viewing experience on 
Apple Vision Pro in a way that may cause stereo discomfort.)
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View and modify 360° video properties in 
Compressor
360° video (sometimes called spherical video) is footage captured by special cameras that 
point lenses in all directions to create a panoramic sphere of video.

Compressor acts as a finishing tool that lets you add or modify the 360° video metadata 
used by VR headsets and other presentation devices to display 360° video in the correct 
format (including monoscopic or stereoscopic view), and export the finished video as a 
media file ready for distribution.

Note: Compressor is not an editing tool for 360° video. To “stitch” the separate camera 
views together, you must use the 360° camera manufacturer’s software. To assemble a 
sequence, you must use a 360° video-capable application like Final Cut Pro. See Intro to 
360° video in Final Cut Pro for Mac.

There are two places to adjust the properties of 360° video in Compressor:

•	 Job inspector: When you import a 360° video source file, Compressor detects any 360° 
metadata present in the file and displays that information in the Job inspector. If the 
source video has no 360° metadata or if that metadata is incorrect, you can assign it  
in the Job inspector.

•	 Video inspector: When you apply a preset to a 360° video job, Compressor configures 
360° properties for the transcoded file accordingly. If necessary, you can modify these 
properties in the Video inspector.

https://support.apple.com/guide/final-cut-pro/vere7590a327/
https://support.apple.com/guide/final-cut-pro/vere7590a327/
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Adjust 360° properties of source media

When you import a 360° video source file, Compressor automatically tries to determine the 
associated 360° properties. You can set or override these properties in the Job inspector.

1.	 Select a 360° video job in the Compressor batch area.

2.	 In the Projection Properties area of the Job inspector, make sure Projection is set  
to 360°.

3.	 If necessary, add or modify the following 360° properties:

•	 Source software: Identifies the software tool used to add metadata to the source 
file. If the source file had no metadata and you used Compressor to add it, this field 
displays “Apple CompressorKit.”

•	 Orientation: Displays the coordinates—Tilt (X), Pan (Y), and Roll (Z), in degrees—of 
the source video’s view origin (the initial angle that viewers will see in a VR headset 
before they turn their heads). Enter new coordinates to change the initial orientation.

•	 Projection mode: Sets the type of spatial mapping used to store the 360° video. 
There are two options:

•	 Equirectangular: The most common form of spatial mapping for 360° video, 
equirectangular projection squeezes and distorts the spherical data like a flat 
map of the world represents the surface of the spherical earth.

•	 Cubic: A less common form of spatial mapping, cubic projection represents the 
spherical data as an unfolded cube with six faces.

•	 Pixel bounds: When “Projection mode” is set to Equirectangular, this property 
becomes available, allowing you to modify the boundaries of the equirectangular 
frame if necessary. Enter values in the Left and Top fields to crop a specific number 
of pixels from the left edge and top edge of the image. Enter new values in the Width 
and Height fields to change the dimensions of the equirectangular frame.

•	 Layout and Padding: When “Projection mode” is set to Cubic, these fields become 
available, allowing you to adjust the six faces of the unfolded cube. The integer 
value in the Layout field specifies the order of the six unfolded cube faces (the 
default value of 0 specifies the face order used in the Spherical Video V2 metadata 
standard: right, left, up, down, front, back). The value in the Padding field specifies 
the width (in pixels) of borders around the edges of each cube face.

Note: If you modify 360° properties, the image in the Compressor preview area  
stays the same. The preview area displays the 360° source file’s video with its  
native properties.
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Modify 360° properties of custom and applied presets

To configure the 360° properties of your transcoded output, you can modify the settings of 
an applied or custom preset in the Video inspector.

1.	 In Compressor, select a custom preset in the Presets pane or select an applied preset in 
the batch area.

2.	 In the Video Properties section of the Video inspector, click the “360° metadata”  
pop-up menu and choose an option:

•	 Automatic: Compressor chooses the metadata format based on the properties in the 
Job inspector and the other settings of the preset. The format chosen is listed to the 
right of the pop-up menu.

•	 None: No 360° metadata is attached to your output file.

•	 Spherical Video V1: The 360° metadata format most commonly used by video 
sharing sites.

•	 Spherical Video V2: A more up-to-date 360° metadata format.

360º image © 2015 Jaunt, Inc.

Work with audio

View and modify audio tracks in Compressor
Some jobs in Compressor can contain multiple audio tracks. You can view these tracks, 
enable or disable them, or reconfigure them into alternative formats, if necessary, to 
ensure they’re correct in your transcoded output files.

Change the channel configuration of a source audio track

1.	 Select a job in the Compressor batch area.

2.	 In the Audio Properties section of the Job inspector, click the pop-up menu 
corresponding to the audio track you want to modify, then choose a channel 
configuration.

Depending on the number of channels in the audio track, different options appear in the 
pop-up menu. For example, a track with two channels can be configured as Stereo, Dual 
mono, 1.1, and so on. A track with one channel can be configured as Left, Right, Center, 
Left Surround, Right Surround, and so on.

3.	 Repeat step 2 as necessary for any other tracks.

Disable a source audio track

1.	 Select a job in the Compressor batch area.

2.	 In the Audio Properties section of the Job inspector, deselect the checkbox to the left 
of the audio track you want to disable.

The track is turned off and excluded when you transcode any files in the batch.

 Tip: iTunes Store packages have specific audio requirements. You can use the methods 
described above to ensure that your audio is properly assigned for a successful submission 
to the iTunes Store.
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Audio channel layouts in Compressor
Most of the audio presets in Compressor provide mono and stereo channel configuration; 
some provide additional channel output options, including surround (5.1) channel 
configuration. Several of Compressor’s presets offer multiple audio channel configurations:

•	 QuickTime Movie presets: QuickTime Movie presets include additional audio channel 
layouts, including 3.0, 4.0, and 5.1.

•	 Dolby Digital audio presets: Dolby Digital (AC-3) presets include even more audio 
channel layouts, including 3.0, 3.1, 4.0, 4.1, and 5.1.

The illustration below shows the available audio channel layouts.
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The channel codes describe the location of the channel:

•	 L: Left front channel

•	 R: Right front channel

•	 C: Center front channel

•	 Ls: Left surround channel

•	 Rs: Right surround channel

•	 Cs: Center surround channel

•	 LFE: Low-frequency effects channel (subwoofer, LFE)

Note: Compressor can’t convert stereo audio files into 5.1 surround sound channels. If you 
want to output a 5.1 surround sound audio file, you must first create the six channels of 
audio required and then import those surround sound files into Compressor. Then you can 
use Compressor to output the surround sound source media file.

After you import a surround sound source file, you can transcode that file into any of the 
channel layouts above.

Compressor analyzes audio files during import to determine the source file’s channels. 
When you apply a preset to the source file, Compressor automatically adjusts the channel 
layout of the preset to provide logical results. For many presets, you can choose Automatic 
from the “Channel layout” pop-up menu (in the Audio inspector) to have Compressor 
determine the logical channel layout based on the source file.

Compressor also maps channels intelligently during output. For example:

•	 If you assign a mono channel layout to a stereo source file: The output file will be 
automatically downmixed.

•	 If you assign a surround channel layout to a stereo source file: The output file will have 
only left and right channels—mapped to the left front (L) and right front (R) channels of 
the source file—while the other channels are unassigned.

•	 If you assign a left front or left rear surround channel to a stereo source file: 
Compressor maps the source file to the left channel (and ignores the right channel).

Add descriptive audio tracks in Compressor
You can create video content for people who are blind or have low vision by adding 
descriptive audio tracks. Compressor can extract the descriptive audio tracks from audio 
file types like WAV or AIFF, or from video file types like MOV. In Compressor, you can 
embed descriptive auto tracks such as language tracks in the QuickTime Movies,  
Apple Devices, and MPEG-4 formats. For more information about descriptive audio,  
see the American Council of the Blind’s Audio Description Project website.

Add descriptive audio tracks

1.	 Select a job in the Compressor batch area.

2.	 In the Audio Properties area of the Job inspector, click Choose next to Descriptive 
Audio, select a file containing descriptive audio tracks, then click Open.

The audio tracks from the file are extracted and listed with the other audio tracks. Audio 
tracks with descriptive audio are indicated with .

https://www.acb.org/adp/
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Remove descriptive audio tracks

1.	 Select a job in the Compressor batch area.

2.	 In the Audio Properties area of the Job inspector, click  to remove all descriptive 
audio tracks.

Work with captions

Import captions in Compressor
Captions are lines of text superimposed over video and synchronized to the video  
and audio. Compressor lets you import a variety of caption files, as well as edit and  
export captions.

In a standard transcoding job in Compressor, you can add a single set of CEA-608 closed 
captions, iTT subtitles, or SRT subtitles by adding a .scc file, a .itt file, or a .srt file to the 
job. If a source video file already has embedded CEA-608 closed captions, when you add 
the source file to a batch, Compressor extracts the captions for you.

You can also add captions to an iTunes Store package. See Build an iTunes Store package.

Note: Compressor is not a captions-authoring tool. To create CEA-608 closed captions, 
iTT subtitles, or SRT subtitles from scratch, use Final Cut Pro or a third-party captions-
authoring app to output a .scc text file, a .itt text file, or a .srt text file, then import the 
captions file into Compressor.
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Add a captions text file to a job

After you add a job to Compressor, you can add a captions text file.

1.	 In the Compressor batch area, click Set on the right side of the Captions row, then click 
Choose File.

2.	 In the window that appears, select a CEA-608 closed-caption file (with a .scc filename 
extension), an iTT subtitle file (with a .itt filename extension), or an SRT subtitle file 
(with a .srt filename extension), then click Open.

The row under the Captions heading in the batch area displays the filename of the 
imported captions file.

Note: If you import a source file that already contains embedded CEA-608 captions, 
Compressor automatically adds the caption file to the job with the same name as the 
source video file.

Replace or delete the captions text file in a job

In the Compressor batch area, do one of the following:

•	 Replace a captions text file: Click Set on the right side of the Captions heading row, 
click Choose File, then select a different captions file.

The new file appears in the row under the Captions heading.

•	 Delete a captions text file: Move the pointer over the row containing the captions 
filename, then click Remove on the right side of the row.
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View caption error warnings

When a set of captions has timing conflicts or other formatting errors, Compressor 
highlights the problem captions in red in the inspector pane.

1.	 In the Compressor batch area, select the captions file.

2.	 In the Captions inspector, click the warning button at the top of the captions list.

The warning button is highlighted, and captions without errors are temporarily removed 
from the list.

3.	 Click the error icon to the left of a red caption in the list.

The Errors & Warnings window appears, showing all errors in the job.

After adding captions to a job in Compressor, you can edit the captions, export captions 
files, and preview your captions.

Edit caption properties in Compressor
You can edit caption content, placement, formatting, and timing in the Captions inspector. 
Because CEA-608, iTT, and SRT captions have different specs, they each have slightly 
different controls.

Specify the caption language properties

Before transcoding, you need to specify the language and country of the captions. For iTT 
subtitles, you must also choose a subtitle type.

1.	 In the Compressor batch area, select the captions file.

2.	 In the Captions inspector, choose options from the Language pop-up menu and Country 
pop-up menu.

 Tip: You must choose a language before you can choose a country. If you don’t 
choose a language and country, your transcoding job won’t process.
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3.	 For iTT subtitles only: In the Captions inspector, click the Purpose pop-up menu and 
choose a subtitle type:

•	 Translation (Full): Use for a full translation of all words spoken in the video (in the 
language you chose in step 1). During playback, viewers can turn these subtitles  
on or off.

•	 Forced: Use when a person in the video speaks a language different from the main 
language of the video—for example, for a French speaker in an otherwise English-
language film. Forced subtitles can’t be turned off because they’re necessary to 
understand the content of the video.

•	 Deaf and Hard of Hearing (SDH): Use for a full translation of all the words spoken 
in the video, as well as for song lyrics and sound effects (owl hooting, scream in 
distance, and so on). During playback, viewers can turn subtitles for the deaf or  
hard of hearing (SDH) on or off.

Modify text color and style

The captions formatting controls let you change the color and font style of caption text. 
CEA-608 closed captions have additional formatting controls that let you choose text 
background colors.

1.	 In the Compressor batch area, select the captions file.

2.	 In the Captions inspector, click the caption that you want to modify.

3.	 In the Caption Text field, select the text you want to modify.

4.	 In the Formatting area, select a font style (bold, italic, or underscore) from the  
Format row.

5.	 In the Formatting area, do any of the following:

•	 For CEA-608 closed captions: Select a color swatch from the Text Color row, select 
a color swatch from the Text Background row, then select an opacity swatch from 
Background Opacity row.

 Tip: If you don’t want a text background color, select the leftmost opacity swatch 
(0 percent opacity).

•	 For iTT and SRT subtitles: Click the Text Color well, then select a new color in the 
Colors window.

The modified caption is updated in the preview area.
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Edit caption content and placement

1.	 In the Compressor batch area, select the captions file.

2.	 In the Captions inspector, click the caption that you want to modify.

The playhead in the preview area jumps to the timecode start position of the caption 
you selected, and the caption text appears in the Caption Text field in the inspector.

Note: The caption should also appear superimposed over the video in the preview area. 
If the caption isn’t visible in the preview area, click . If the caption still isn’t visible 
in the preview area, try dragging the playhead a few frames to the right (if the caption 
style is animated, the caption may require several frames to appear onscreen).

3.	 Click in the Caption text field, then edit the text.

Onscreen, each CEA-608 closed caption appears on a single line, and each line is 
limited to 32 characters.

Each iTT subtitle can span dozens of characters—from the left margin of the frame to 
the right margin—but each subtitle is limited to two lines.

Note: There are no text placement controls for SRT subtitles. SRT subtitles are always 
centered horizontally, and additional lines of text beyond the first are stacked vertically.

4.	 To modify the position of the caption in the video frame, click a Text Placement arrow.

The caption is repositioned in the video frame.

Important: CEA-608 captions that overlap spatially and temporally may create position and 
timing errors.
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Add or delete a caption

You can also add new captions or delete captions in an existing captions file.

1.	 In the Compressor preview area, drag the playhead  to a point in your video where you 
want to insert a new caption.

2.	 Select the captions file in the batch area.

3.	 Click  above the captions list in the Captions inspector.

4.	 Enter the new caption in the Caption Text field.

The new caption with a default duration of two seconds appears in the preview window 
at the timecode start point.

Important: Adding a new caption with too many characters may introduce position 
errors. And adding a caption that overlaps spatially or temporally with an existing 
caption may introduce position or timing errors. Captions with errors are highlighted  
in red in the captions list. For more information about caption timing, see Adjust  
caption timing.

5.	 To delete a caption, select it in the captions list, then press Delete.

Choose an animation style (CEA-608 closed captions only)

The CEA-608 format allows for several different styles of caption animation.

1.	 In the Compressor batch area, select the captions file.

2.	 In the Captions inspector, select one or more captions from the captions list.

Each line in the list, which represents a single caption, displays the caption’s timecode 
start point, end point, and text.

3.	 In the Formatting area, click the Caption Style pop-up menu, then choose an option:

•	 Pop-On: The caption appears suddenly on the screen at the caption’s timecode start 
point. If multiple captions overlap in time, they’re stacked vertically onscreen, with 
each new caption appearing beneath the previous caption.

•	 Paint-On: The caption appears letter by letter from left to right, beginning at at the 
caption’s timecode start point. If multiple captions overlap in time, they’re stacked 
vertically onscreen, with each new caption “painting on” beneath the previous 
caption.

•	 Roll-Up: The caption appears letter by letter from left to right (like Paint-On). 
Additionally, if multiple captions overlap in time, newly appearing captions push 
older captions up line by line. When you choose Roll-up, an additional pop-up menu 
appears, letting you choose how many caption lines can appear onscreen at a time: 
2, 3, or 4 lines.

Note: Modifying the caption animation style may introduce position or timing errors. 
Captions with timing errors are highlighted in red in the Captions list. For more information 
about caption timing, see Adjust caption timing.
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Adjust caption timing in Compressor
When you add captions to a job in Compressor, the timecode values in the imported 
captions file are synchronized to the timecode in the video source file.

You can modify the timing of captions and fix timing errors by adjusting a caption’s 
timecode start point, end point, or duration.

Change a caption’s start point, end point, or duration

1.	 In the Compressor batch area, select the captions file.

2.	 In the Captions inspector, click the caption you want to modify.

The playhead  in the preview area jumps to the timecode start position of the caption 
you selected, and the caption’s timing information appears in the Caption Start, Caption 
End, and Caption Duration fields in the Formatting area of the inspector.

3.	 To modify the Caption Start and Caption End timecodes, type directly into their fields, 
click the arrows next to the fields, or click and drag over the timecodes themselves.

Changing the start point also modifies the end point (the caption moves to an earlier or 
later position in time, but its duration remains the same).

Changing the end point also modifies the duration of the caption (the start point 
remains the same, but the end point changes, which shortens or lengthens the  
caption’s duration).

4.	 To modify the Caption Duration value, type directly into its field, click the arrows next to 
the field, or click and drag over the value itself.

Changing a caption’s duration also modifies its end point.

Modify the timing of multiple captions at the same time

1.	 In the Compressor batch area, select the captions file.

2.	 In the Captions inspector, select multiple captions.

 Tip: Shift-click or Command-click to select multiple captions.

If the selected captions have different timecode values, the Caption Start, Caption End, 
and Caption Duration fields in the Formatting area of the inspector display dashes.
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3.	 To modify the caption start points or end points of the selected captions proportionally, 
do any of the following:

•	 Adjust the start points or end points in single-frame increments: Click the down 
arrow or up arrow on either side of the Caption Start or Caption End field.

•	 Change the start points or end points in larger increments: Position the pointer over 
the hours, minutes, seconds, or frames area of timecode in the Caption Start or 
Caption End field, then drag left or right.

The affected timecodes of all selected captions are modified by equal amounts.

4.	 To modify the caption durations proportionally, do any of the following:

•	 Modify the caption durations in single-frame increments: Click the down arrow or up 
arrow on either side of the Caption Duration field.

•	 Modify the caption durations in larger increments: Position the pointer over the 
hours, minutes, seconds, or frames area of timecode in the Caption Duration field, 
then drag left or right.

The affected timecodes of all selected captions are modified by equal amounts.

Adjust the global timing of captions (CEA-608 closed captions only)

Occasionally, an imported set of closed captions may be out of sync with the source video 
by a few seconds throughout the program. The CEA-608 format lets you offset all captions 
forward or backward in time to manually restore sync.

1.	 In the Compressor batch area, select the captions file.

2.	 In the Captions inspector, do any of the following in the Offset field:

•	 Adjust the offset in single-frame increments: Click the down arrow or up arrow.

•	 Modify the offset in larger increments: Drag left or right over the hours, minutes, 
seconds, or frames area of timecode.

•	 Modify the offset by a precise value: Select the hours, minutes, seconds, or frames 
area of timecode, enter a new two-digit number, then press Return.

Important: Modifying caption durations may introduce timing errors (such as captions that 
overlap in time or captions that extend beyond the duration of video). Captions with errors 
are highlighted in red in the captions list at the bottom of the inspector. Captions that 
extend beyond the duration of video in a job are dimmed in the list. If you don’t fix timing 
errors, your transcoding job will fail.

Export captions in Compressor
In a standard Compressor batch, the transcode preset and captions format you choose 
determines how Compressor outputs a job with captions. Only CEA-608 closed captions 
can be embedded in your video output, and only the Apple Devices, MPEG-2, MPEG-4,  
and QuickTime Movie preset formats support captions exporting.
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Embed CEA-608 captions in a transcoded file

1.	 In the Compressor batch area, select an output row from a job with a CEA-608  
captions file.

2.	 In the General inspector, make sure “Embed CEA-608 closed captions” is selected in 
the Captions area.

3.	 Click Start Batch.

Your transcoded file will have captions data embedded in the video.

Note: iTT subtitles and SRT subtitles can’t be embedded in a video file, so it’s not 
recommended that you use this format unless you’re creating an iTunes Store package.

Output a separate captions file with your transcoded file

1.	 Select a job with any type of captions file in the Compressor batch area.

2.	 In the Job inspector, select “Save captions to disk” in the Action area.

Note: You can’t export captions if the job already has a job action assigned to it.

3.	 Click Start Batch.

Work with interlaced footage

Use deinterlacing in Compressor
When working with interlaced video, you can deinterlace, or remove the fields from an 
interlaced video clip, by converting it to a progressive frame rate.

1.	 In Compressor, select an applied or custom preset.

2.	 In the Video Properties section of the Video inspector, choose an option from the  
“Field order” pop-up menu:

•	 Automatic: Selects the most appropriate field order based on the field order of  
the source.

•	 Progressive: The video is displayed in complete frames with all lines sampled at the 
same instant in time.

•	 Top First: The video is interlaced and displayed as two separate interleaved fields. 
The field containing the top line (even lines) is sampled at an earlier instant in time 
than the field containing the bottom line (odd lines). This field order is commonly 
used for high-definition video and standard-definition PAL video.

•	 Bottom First: The video is interlaced and displayed as two separate interleaved 
fields. The field containing the bottom line (odd lines) is sampled at an earlier  
instant in time than the field containing the top line (even lines). This field order  
is commonly used for standard-definition NTSC video.
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Use reverse telecine in Compressor
Telecine is the process of converting motion picture film to the NTSC video format used 
in broadcast television. You can use Compressor to perform a reverse telecine frame rate 
conversion on telecined footage.

When film is telecined to NTSC video, it has a constant cadence. This means that the 3:2 
pattern is consistent and uninterrupted. It’s relatively easy to remove the telecine from a 
constant-cadence clip because you need only determine the pattern once.

If you take these telecined clips and edit them as NTSC video, the result is a final video  
file that has a broken cadence with an inconsistent 3:2 pattern. It’s much more difficult  
to remove the telecine from such a clip because you have to constantly verify the  
cadence to make sure you don’t inadvertently choose incorrect fields when creating  
the 23.98 fps video.

The reverse telecine feature in Compressor automatically detects broken cadences and 
adjusts processing as needed.

1.	 In Compressor, select an applied or custom preset.

2.	 In the Video Properties section of the Video inspector, click the “Frame rate” pop-up 
menu, then choose 29.97.

3.	 In the Quality section of the Video inspector, click the “Retiming quality” pop-up menu, 
then choose Reverse Telecine.

When using the reverse telecine feature in Compressor, consider these issues:

•	 Because of the unpredictable nature of the processing when reversing the telecine, 
segmented encoding doesn’t work as efficiently as it does when reverse telecine is not 
being used.

•	 If you pause the transcoding process, the transcode must start from the beginning 
when you restart it.

Create iTunes Store packages

Build an iTunes Store package in Compressor
You can use Compressor to assemble your media and supplemental materials into an 
iTunes Store package. After creating the package, you can work with a delivery partner to 
submit it to the iTunes Store. During submission, the delivery partner includes additional 
required metadata and other materials to ensure your package is complete. The delivery 
partner can also provide billing and support services after your video becomes available 
for sale.

For more details about the entire creation and submission process, see iTunes Connect 
Resources and Help and Apple TV for Partners.

https://itunespartner.apple.com/tv-movies/support/guides
https://itunespartner.apple.com/tv-movies/support/guides
https://tvpartners.apple.com
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Create an iTunes Store package

1.	 In Compressor, choose File > New iTunes Store Package.

An iTunes Store package job appears in the batch area.

2.	 To add the primary video of your submission, click Set on the right side of the Feature 
row, select a video file from the dialog that appears, then click Open.

 Tip: You can also add your video by dragging it from the Finder onto the Feature row.

An output row containing the selected video file is added to the job.

3.	 To configure the job properties of your iTunes Store package, select the feature 
filename to reveal the Job inspector, then set the file’s language and country, and 
optionally make adjustments to the timecode, color space, and burned-in text.

4.	 To modify video or audio properties of the primary video, select the feature filename, 
open the Video or Audio inspector, then adjust the property values.

Important: The iTunes Store requires specific video and audio presets in your package 
submission. Unless you know exactly what presets to change and why, it’s not advisable 
to make changes to the video or audio properties of the Feature or Preview items in 
your iTunes Store Package job.

5.	 To add supplemental files like subtitles, closed captions, or alternative audio, click 
Add or Set on the right side of the corresponding row, select a file from the dialog that 
appears, then click Open.

 Tip: You can also add supplemental files by dragging them from the Finder onto the 
Subtitles, Closed Captions, or Alternative Audio row.

You can add multiple files in each category (for example, to include subtitles or  
closed captions for multiple languages). A supplemental file row is created for  
each file you add.

Important: Subtitle files must be iTT (iTunes Timed Text) subtitles, and closed-caption 
files must be CEA-608 closed captions.

6.	 By default, the primary audio track of an iTunes Store package is audio included with 
the main feature. To choose different a primary audio track for your package, select 

 in the center of the corresponding Alternative Audio row. The speaker button of the 
primary audio track turns blue and adds a checkmark: .

To reselect the audio track from the main feature as the primary audio, select  in the 
feature row.
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7.	 To add a short preview video, click Add on the right side of the Previews row, select a 
video file from the dialog that appears, then click Open.

 Tip: You can also add a preview video by dragging it from the Finder onto the 
Previews row.

Compressor adds a row containing the selected video file to the job. You can adjust its 
properties by selecting the preview video filename, then making changes in  
the inspector.

For more information on creating iTunes Store packages with HDR or stereoscopic footage, 
see Build an HDR package and Build a stereo-3D package.

Configure subtitles, closed captions, and alternative audio tracks

After you add subtitles, closed captions, or alternative audio tracks to a job, you must 
configure those elements to ensure that they’re labeled with the correct language and 
other settings.

1.	 In the Compressor batch area, select a row under the Subtitles heading to reveal the 
Subtitles inspector.

2.	 In the Subtitles inspector, choose options from the Language pop-up menu, the Country 
pop-up menu, and the Purpose pop-up menu.

There are three available options in the Purpose pop-up menu:

•	 Translation (Full): Outputs a full translation of all words spoken in the film using the 
language of the intended territory. During playback, viewers can turn these subtitles 
on or off (unlike burned-in subtitles).

•	 Forced: Use when a person in the video speaks a language different from the main 
language of the video—for example, for a French speaker in an otherwise English-
language film. Forced subtitles can’t be turned off because they’re necessary to 
understand the content of the video.

•	 Deaf and Hard of Hearing (SDH): Use for a full translation of all the words spoken in 
the video, as well as song lyrics and sound effects (owl hooting, scream in distance, 
and so on). During playback, viewers can turn subtitles for the deaf or hard of 
hearing (SDH) on or off.

 Tip: In the Subtitles inspector, you can also edit subtitle text, color, and placement 
and adjust subtitle timing.

3.	 In the batch area, select a row under the Closed Captions heading to reveal the Closed 
Captions inspector.

4.	 In the Closed Captions inspector, choose options from the Language pop-up menu and 
the Country pop-up menu.

 Tip: In the Closed Captions inspector, you can also edit subtitle text, color, 
animation, and placement and adjust subtitle timing.

5.	 In the batch area, select a row under the Alternative Audio heading to reveal the 
Alternative Audio inspector.
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6.	 In the Job pane of the Alternative Audio inspector, do the following:

•	 Choose options from the Language pop-up menu and Country pop-up menu.

•	 If the alternative audio track is descriptive audio, select the “Descriptive audio” 
checkbox (in the Alternative Audio Properties area).

You can add multiple descriptive audio tracks (for example, in multiple languages).

•	 If you want the alternative audio track to be the primary audio for the package, 
select  in the corresponding row. When an alternative audio track is selected  
as the primary audio track, it’s locked to the language of the feature video.

Note: An alternative audio track can’t be selected as both descriptive audio and the 
primary audio track. Selecting the “Descriptive audio” checkbox will automatically 
deselect the track as primary audio.

•	 If your alternative audio track is a Dolby Atmos track, you can select downmixing 
options. The “Downmix to Stereo” checkbox is selected by default, but you can 
select the “Downmix to 7.1” or “Downmix to 5.1” checkboxes if you want the  
iTunes Store to downmix in those formats as well.

Important: For a Dolby Atmos track to be the primary audio for the package, 
“Downmix to Stereo” must be selected. If “Downmix to Stereo” is deselected,  
the track is also deselected as primary audio.

 Tip: You can choose which subtitles or closed captions file to see in the preview area by 
clicking . You can choose which audio to preview by clicking .

Configure an iTunes Store package

After you create an iTunes Store package and add media, you need to add identifying 
production data to the package.

1.	 In the Compressor batch area, click the top of the iTunes Store Package to reveal the 
iTunes Store Package inspector.

2.	 In the iTunes Store Package inspector, enter a name for the project in the Name field.

Note: This name will be used only to represent the job within Compressor.
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3.	 In the Package Properties section of the inspector, enter a short name that corresponds 
to the party who will ultimately submit the package to the iTunes Store.

The short name is generated and supplied by the iTunes Store and is used for internal 
identification. If you do not have an account with an assigned short name, enter 
placeholder text here, and your delivery partner will add the correct information to the 
package before submitting it to the iTunes Store.

4.	 Enter a Vendor ID.

The Vendor ID is a unique identifier for the movie you are submitting to the iTunes Store. 
This ID is used for tracking your assets and sales reporting.

If you don’t know your vendor ID, you can enter any placeholder text here and your 
delivery partner will add a valid vendor ID to the package before submission to the 
iTunes Store.

Important: The vendor ID can contain only alphanumeric characters and underscore 
marks; it can’t contain spaces, dashes, ampersands, other punctuation, or symbols. The 
vendor identifier is case-sensitive and must not start with an underscore. If a vendor 
ID is numeric, it’s treated as a string, not numbers (for example, a vendor identifier of 
000000000123456 is not the same as 123456). Vendor IDs must be at least six ASCII 
characters in length but not longer than 100 ASCII characters.

5.	 In the Version pop-up menu, if the package media is for a standalone video, choose 
“Film.” If the package is part of a subscription, choose “Subscription video.”

6.	 Select the “SDR delivery” checkbox if you want the iTunes Store to create an SDR 
version of the video from an HDR source and Dolby Vision metadata.

7.	 Click Choose, then select the location on your computer where you want to save  
the package.

Add chapter markers to the feature video

iTunes Store videos must include chapters so that viewers can jump directly to specific 
sections of the movie. If your source video file already has chapter markers, those will  
be used. If your source video file doesn’t have chapter markers, you can add them  
in Compressor.

1.	 In the Compressor batch area, select the feature filename or a preview video filename.

2.	 In the preview area, navigate to the frame where you want to begin the chapter.

3.	 Click the arrow next to the Marker button , then choose Add Marker.

4.	 In the Marker inspector, enter a name for the marker.

5.	 Click the Image pop-up menu, then choose Frame or File to assign a preview image 
associated with the chapter marker.

Important: Chapter markers must have an image associated with them (and not a black 
frame) to be compliant with iTunes Store submission requirements.

6.	 Repeat steps 2–5 to add additional chapter markers as required.

For more information about chapter markers, see Add markers.
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Build an iTunes Store package

After your package is properly loaded and configured, you can build the package.

•	 In the Compressor batch area, click Start Batch.

Compressor transcodes all the files, combining them into a single package file.

Correct or augment an iTunes Store package

You can add or update components in a completed iTunes Store package using 
Compressor. For example, if you want to add another subtitle file to a completed package, 
you can append the new file to the package. As long as the data in the package properties 
matches that in the original package, Compressor automatically combines the items and 
ensures that the package is correctly configured and ready for uploading.

1.	 In Compressor, choose File > New iTunes Store Package.

An iTunes Store package is added to the batch area.

2.	 In the batch area, click the top of the iTunes Store Package to reveal the iTunes Store 
Package inspector.

3.	 In the iTunes Store Package inspector, enter a name, then set the package properties to 
precisely match the values in the package you want to augment or change.

4.	 In the batch area, add the new or modified subtitle files, closed-caption files, or 
alternate audio files.

Note: If you create a package with no feature video, the preview area displays a missing 
media warning. Because you’re deliberately generating a package without video, this is 
not an error, so you can ignore this warning.

5.	 In the iTunes Store Package inspector, click Choose, then select the same location 
where the original package was saved.

6.	 At the bottom of the batch area, click Start Batch.

The existing package is updated to include the new or changed elements from the  
new batch.

Note: You can’t remove elements from a package after it has been created. If you  
want to remove an element from an existing package, you must create a new package 
from scratch.

Compressor can’t directly submit a package to the iTunes Store; most content creators 
use a delivery partner to submit their iTunes Store package. For a list of approved delivery 
partners, see iTunes Store delivery partners.

Additionally, a complete iTunes Store package consists of both assets and metadata. 
Compressor generates a package without some essential metadata such as the title, 
synopsis, cast and crew lists, and so on. That data must be submitted via iTunes Connect 
by an authorized user (usually the delivery partner).

https://itunespartner.apple.com/movies/partner-search
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Build an iTunes Store package with HDR content in 
Compressor
You can use Compressor to prepare HDR (high dynamic range) content packages  
for submission to the iTunes Store. Users with HDR-capable devices—Apple TV 4K 
connected to an HDR-compatible television, recent iOS and iPadOS devices, or recent  
Mac computers—can purchase or rent HDR content in high-definition or 4K resolution.  
The iTunes Store plays the highest-quality version compatible with a user’s device.

When you submit an HDR video to the iTunes Store, you must also include a standard-
dynamic-range version of the video, unless the SDR version is already available in the 
iTunes Store and you’re submitting a supplemental HDR upgrade package, or you’re using 
iTunes to create the SDR delivery from the HDR source and Dolby Vision metadata. Your 
HDR video must include HDR metadata.

For complete information about HDR delivery requirements, see the iTunes Video and Audio 
Asset Guide.

Build a combined SDR/HDR package

If you’re submitting new video content, you must include both an SDR version and an HDR 
version in the iTunes Store package. The SDR version is considered the “master,” defining 
the video duration, frame rate, and frame size; the SDR master also provides the audio 
track. The HDR version provides only the higher-resolution video (and doesn’t require an 
audio track).

1.	 In Compressor, choose File > New iTunes Store Package.

An iTunes Store Package job appears in the batch area.

2.	 To add the SDR feature video to the package, click Set on the right side of the Feature 
row, select an SDR video file, then click Open.

An output row containing the selected video file (and an SDR badge) is added to  
the job.

3.	 To add the HDR feature video to the package, click Set on the right side of the Feature 
row, select an HDR video file, then click Open.

An output row containing the selected video file (and an HDR badge) is added to  
the job.

 Tip: You can also add SDR and HDR videos by dragging them from the Finder onto 
the Feature row.

https://help.apple.com/itc/videoaudioassetguide/
https://help.apple.com/itc/videoaudioassetguide/
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Separate summaries for both the SDR and HDR source files appear in the Job inspector.

4.	 In the Job inspector, review the SDR Video Properties and HDR Video Properties areas 
to ensure that Compressor has correctly detected the native color space of each file.

If a source file has metadata identifying its native color space, Compressor adds an 
asterisk next to the option shown in the SDR or HDR “Color space” pop-up menu. If 
a source file is untagged or tagged with an unrecognized color space, Compressor 
assigns a color space based on its assessment of the media and then adds a dagger (†) 
next to the item the pop-up menu. You can override Compressor’s choices by choosing 
a different option from either pop-up menu.

Note: Changing these properties doesn’t convert the exported files to a different color 
space. To transcode to a different color space, see the next step.
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5.	 If you want to modify the color space of either video for the iTunes Store package,  
open the Video pane of the inspector and choose new options from the following  
pop-up menus:

•	 SDR color space: Choose a different SDR color space.

•	 HDR color space: Choose either Rec. 2020 PQ or P3 D65 PQ. Either option is 
compatible with the two HDR formats supported by the iTunes Store—Dolby Vision 
and HDR10.

6.	 Set the HDR format:

•	 HDR10: By default, iTunes Store packages transcode HDR video to the HDR10 
format, so no further modifications are required.

•	 Dolby Vision: Open the Job inspector, then in the Dolby Vision Metadata area, 
click Choose, navigate to an XML file formatted using the Dolby Vision metadata 
specifications, and click Open. When you attach a Dolby Vision metadata file, 
Compressor transcodes your iTunes Store package to a format compatible with  
both HDR10 and Dolby Vision. When a user rents or purchases HDR content,  
the iTunes Store plays the highest-quality version compatible with the user’s  
display device.

Note: Dolby Vision submissions must be mastered at a Dolby Vision-certified facility. 
See the Dolby Vision website.

7.	 In the Video inspector, click Choose in the “QuickTime presets” area, then choose either 
Apple ProRes 4444 or Apple ProRes 4444 XQ from the pop-up menu.

HDR package submissions to the iTunes Store must use the Apple ProRes 4444 
or Apple ProRes 4444 XQ codec. If you choose a different codec, your package 
submission will fail.

8.	 Complete your iTunes Store package by configuring package presets; adding subtitles, 
closed captions, alternative audio tracks, and chapter markers; and then building  
the package.

Note: If the SDR version of your feature video is already available in the iTunes Store, you 
can submit the HDR version by itself as a supplemental upgrade package.

https://www.dolby.com/us/en/technologies/dolby-vision/dolby-vision-for-creative-professionals.html
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Build a combined SDR/HDR package from an HDR-only source

If the you have an HDR video file and Dolby Vision metadata, you can build a combined 
SDR/HDR package.

1.	 In Compressor, choose File > New iTunes Store Package.

An iTunes Store Package job appears in the batch area.

2.	 Click Set on the right side of the Feature row, select an HDR video file, then click Open.

An output row containing the selected video file (and an HDR badge) is added to  
the job.

3.	 If you want to modify the color space of the video for the iTunes Store package, open 
the Video inspector, click the “HDR color space” pop-up menu, then choose either Rec. 
2020 PQ or P3 D65 PQ.

4.	 Open the Job inspector, then in the Dolby Vision Metadata area, click Choose,  
navigate to an XML file formatted using the Dolby Vision metadata specifications,  
then click Open.

When you attach a Dolby Vision metadata file, your iTunes Store package transcodes to 
SDR, and a format compatible with both HDR10 and Dolby Vision. When a user rents or 
purchases HDR content, the iTunes Store plays the highest-quality version compatible 
with the user’s display device.

Note: Dolby Vision submissions must be mastered at a Dolby Vision-certified facility. 
See the Dolby Vision website.

5.	 Select the “Use iTunes to create SDR delivery from HDR source and Dolby Vision 
metadata” checkbox.

6.	 In the Video inspector, click Choose in the “QuickTime presets” area, then choose either 
Apple ProRes 4444 or Apple ProRes 4444 XQ from the pop-up menu.

HDR package submissions to the iTunes Store must use the Apple ProRes 4444 
or Apple ProRes 4444 XQ codec. If you choose a different codec, your package 
submission may fail.

7.	 Complete your iTunes Store package by configuring package presets; adding subtitles, 
closed captions, alternative audio tracks, and chapter markers; and then building  
the package.

Build an iTunes Store package with stereo-3D content in 
Compressor
There are several steps required to properly configure stereoscopic video in an  
iTunes Store package.

1.	 In Compressor, choose File > New iTunes Store Package.

An iTunes Store Package job appears in the batch area.

https://www.dolby.com/us/en/technologies/dolby-vision/dolby-vision-for-creative-professionals.html
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2.	 Click Set on the right side of the Stereoscopic Feature row, select either the right or 
left video file of the stereoscopic pair from the dialog that appears (ensuring that Video 
Track pop-up menu in the dialog is set to Left or Right accordingly), then click Open.

3.	 In the Job inspector, under Stereoscopic Properties, click Choose next to the eye view 
you didn’t upload, select a video file from the dialog that appears, then click Open.

4.	 In the Job inspector, click the Hero Eye pop-up menu, then choose the eye view (Left or 
Right) to use as the hero eye.

5.	 Complete your iTunes Store package by configuring package presets; adding subtitles, 
closed captions, alternative audio tracks, and chapter markers; and then building  
the package.

Important: The iTunes Store ignores audio from stereoscopic files. If you want audio in 
a package with a stereoscopic feature, either add a traditional HDR or SDR feature video 
that includes audio and leave it as the primary audio, or choose an alternative audio file 
and make it the primary audio for the package.

Work with video with burned-in text in Compressor
If your feature video contains text already rendered into the video (sometimes called 
burned-in or baked-in titles), it’s important to identify the language and intent of those 
titles before submitting your package to the iTunes Store.

1.	 In the Compressor batch area, select the feature filename to reveal the Job inspector

2.	 In the Job inspector, scroll down to Feature Video Properties, then deselect Textless.

3.	 Do any of the following:

•	 For burned-in subtitles, choose a Language option and then a Country option in the 
“Burned subtitles” area.

•	 For burned-in forced narratives, choose a Language option and then a Country 
option in the “Burned forced narratives” area.

•	 If your project contains health warning text as required by Indian law, select the 
“India health warning” checkbox.

In general, you should avoid using burned-in text, which can confuse viewers when the text 
doesn’t match the language they’re expecting (other than opening titles or ending credits). 

Furthermore, burned-in titles can conflict with subtitles or closed-caption text added to 
the video during playback. If both text elements appear at the same time and in the same 
place on the screen, the titles may overlap, and neither will be legible.
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However, burned-in text is sometimes unavoidable. For example, traditional subtitles 
might already be burned into your video. Or you might need to include forced narratives, 
onscreen text that identifies a scene’s location or time (“Brooklyn, 1959” or “Later that 
night…”). Or you might require translation dialog that doesn’t match the primary language 
used in a film (known as foreign dialog translation).

Create IMF packages

Build an IMF package in Compressor
An Interoperable Master Format (IMF) package is a container format standard for digital 
delivery and storage of audio-visual masters, including movies and TV episodes.

You can use Compressor to create an original IMF package, as well as edit an existing 
IMF package to create a new original IMF package or a supplemental IMF package. 
Supplemental IMF packages allow you to add additional audio files in different languages.

You can create your IMF package using a video that includes audio or video content, or that 
references separate audio and video files.

You can also import a composition playlist (CPL) which references other media that is 
part of the package. For more details, see the Apple Support article Create complete IMF 
packages with Compressor and third-party tools.

Create an IMF package from a video file

1.	 In Compressor, choose File > New IMF Package.

An IMF package job appears in the batch area.

2.	 To add the video to your package, click Set on the right side of the Video row, select a 
video file from the dialog that appears, then click Open.

 Tip: You can also add your video by dragging it from the Finder onto the Video row.

An output row containing the selected video file is added to the job.

Note: You can’t remove video elements from a package after it has been created. If 
you want to remove a video element from an existing package, you must create a new 
package from scratch.

https://support.apple.com/101750
https://support.apple.com/101750
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3.	 To add the audio to your package, click set on the right side of the Audio row, select an 
audio file from the dialog that appears, then click Open.

 Tip: You can also add your audio by dragging it from the Finder onto the Video row.

An output row containing the selected audio file is added to the job. To remove an audio 
element from a package, click Remove on the right side of the Audio row.

4.	 To modify video or audio properties, select the video or audio in the batch area, open 
the Video or Audio inspector, then adjust the property values.

Important: To create a valid IMF package, you must select a language for the audio in the 
Job inspector, and you must also provide values for all Multichannel Audio Description 
fields in the Audio inspector.

Create a new IMF package using a CPL from an original or supplemental  
IMF package

1.	 In Compressor, choose File > New IMF Package.

An IMF package job appears in the batch area.

2.	 To add an original or supplemental IMF package to your new IMF package, click Set  
on the right side of the Video row, select a CPL file from the dialog that appears, then 
click Open.

 Tip: You can also add your CPL file by dragging it from the Finder onto the  
Video row.

An output row containing the selected files is added to the job. If the CPL contains 
multiple audio files, Compressor creates a separate track for each audio file.

After importing the CPL, all supplemental audio tracks are set to “Link to original 
package” in the IMF Supplemental property in the Job inspector by default. This means 
that a reference to the original audio file is exported into the IMF package. This results 
in a smaller IMF package; however you can’t adjust any of the audio file properties for 
the exported files. If you want to modify any of the audio properties, click “Copy of 
original package” in the IMF Supplemental property in the Job inspector.
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3.	 To add additional audio files to your package, click Set on the right side of the  
Audio row, select an audio file from the dialog that appears, then click Open.

An output row containing the selected audio file is added to the job.

4.	 To remove an audio element from a package, click Remove on the right side of the  
Audio row.

5.	 To modify video or audio properties, select the video or audio in the batch area, open 
the Video or Audio inspector, then adjust the property values.

Important: To create a valid IMF package, you must select a language for the audio in the 
Job inspector, and you must also provide values for all Multichannel Audio Description 
fields in the Audio inspector.

Configure an IMF package or a supplemental IMF package

After you create an IMF package and add media, you must add identifying production data 
in the inspector.

A valid IMF package must include valid values in the “Package name” and “Content title” 
fields of the IMF Package inspector. If you don’t know the correct information, you can 
enter placeholder text.

1.	 In the Compressor batch area, click the top of the IMF Package item to reveal the  
IMF Package inspector.

2.	 In the IMF Package inspector, enter a name for the project in the Name field.

Note: This name will be used only to represent the job within Compressor.

3.	 In the Package Properties section of the inspector, enter a name for the package, a 
content title, and a content originator.

4.	 Choose a content kind and a timecode preference from the “Content kind” and “Start 
timecode” pop-up menus.
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5.	 Click Choose, then select the location on your computer where you want to save  
the package.

6.	 To turn on job segmenting, select the “Allow job segmenting” checkbox.

Build an IMF package or a supplemental IMF package

After your package is properly loaded and configured, you can build the package.

•	 In the Compressor batch area, click the Start Batch button.

When you’re transcoding an IMF package containing supplemental files and 
you’ve selected the “Link to the original package” property, Compressor creates 
a supplemental IMF package that includes both references and copies of the 
supplemental files as determined by their IMF Supplemental property. Only those 
supplemental files with “Copy of original package” are included in the supplemental IMF 
package. However, the CPL file created for the supplemental IMF package lists all the 
referenced and supplemental files.

Prepare an IMF package containing HDR content
You can use Compressor to prepare IMF packages that include HDR (high dynamic  
range) video.

Build a package with HDR content

1.	 In Compressor, choose File > New IMF Package.

An IMF Package job appears in the batch area.

2.	 To add the HDR feature video to the package, click Set on the right side of the Video 
row, select an HDR video file, then click Open.

 Tip: You can also add your HDR video by dragging it from the Finder onto the  
Video row.

An output row containing the selected video file (and an HDR badge) is added to  
the job.
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3.	 In the Job inspector, review the HDR Video Properties area to ensure that Compressor 
has correctly detected the native color space and the camera LUT used by the  
source file.

If a source file has metadata identifying its native color space, Compressor adds an 
asterisk (*) next to the option shown in the HDR “Color space” pop-up menu. If a source 
file is untagged or tagged with an unrecognized color space, Compressor assigns a 
color space based on its assessment of the media and then adds a dagger (†) next to 
the item the pop-up menu. To override the Compressor selection, choose a different 
option from either pop-up menu. You can also choose a camera log format.

Note: Changing these properties doesn’t convert the exported files to a different color 
space. To transcode to a different color space, see the next step.

4.	 If you want to modify the color space of the video for the IMF package, open the Video 
inspector and choose new options from the following pop-up menu:

•	 Color space: Choose either Rec. 2020 PQ, Rec. 2020 HLG or P3 D65 PQ. Either 
option is compatible with both Dolby Vision and HDR10.

5.	 Review the properties in the HDR Metadata section of the Job inspector and make 
adjustments as needed.

For more information, see View or modify HDR metadata.

6.	 Complete your IMF package by configuring package presets and then building  
the package.

Note: To create a valid IMF package, you must select a language for the audio in the Job 
inspector, and you must also provide values for all Multichannel Audio Description fields in 
the Audio inspector.
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Use distributed processing

Create additional instances of Compressor
By default, when “Enable additional Compressor instances” is unchecked, Compressor 
attempts to optimize performance by segmenting transcoding jobs between all available 
media engines. Under certain circumstances, you can achieve better performance by 
manually enabling additional instances of the Compressor app. Enabling additional 
instances of Compressor doesn’t install multiple copies; instead, it creates additional 
services that can be accessed by Compressor.

The number of available Compressor instances is determined by your computer’s cores 
and memory. After meeting the minimum system requirement (four cores and 2 GB of 
memory), you can add one additional instance for every additional four cores and 2 GB  
of memory.

1.	 Choose Compressor > Settings.

2.	 Click Advanced.

3.	 Select the “Enable additional Compressor instances” checkbox, then choose a number 
of instances from the pop-up menu.

Note: If you don’t have enough cores or memory, the “Enable additional Compressor 
instances” checkbox in the Advanced settings pane is dimmed.

Important: Creating additional instances of Compressor may increase processing  
power, or it may, in fact, reduce processing power, depending on the specific batches 
Compressor is processing, and the specifications of your computer. It’s recommended  
that you first disable all the additional instances and transcode several test batches.  
Then, if performance is slow, increase the number of instances to use more of your 
computer’s resources.

Transcode batches with multiple computers in Compressor
Transcoding a series of large files on one desktop computer can be processor-intensive 
and time-consuming. Distributed processing decreases the time it takes to transcode a 
batch by distributing the work between multiple computers in a shared computer group. 
After you set up a distributed processing system, Compressor sends portions of your 
batch to each of the available computers in your group of shared computers. When the 
transcoding is complete, the output files appear in the location you specified when you  
set up the batch.

The simplest shared computer group in Compressor uses two computers: two physical 
computer systems each running Compressor. A more complex system can include  
many computers.

To set up distributed processing, you turn on access to each computer and then create a 
set of shared computers. If you can’t find a computer on your network, you can manually 
add one to the computer list.

Important: Before you begin, verify that all the computers to be used for distributed 
processing have the same version of Compressor installed.
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Make a computer available to other computers on your network

If you want to use a Mac on your network for distributed processing, Compressor  
must be open and batch processing must be enabled. To have Compressor open 
automatically when you log in to your Mac, add Compressor to your list of login items. 
On macOS 10.15 or later, using distributed processing may require you to grant network 
access. See the Apple Support article If you can’t transcode batches with multiple 
computers in Compressor.

1.	 Choose Compressor > Settings.

2.	 Select My Computer.

3.	 If necessary, turn on “Allow other computers to process batches on my computer.”

4.	 To control access to your computer, select the Require Password checkbox and enter a 
password in the text field.

The password is required by other computers to use your computer for transcoding.

5.	 To add Compressor to your list of login items, do the following:

a.	 Choose Apple menu  > System Settings.

b.	 Click General, then click Login Items.

c.	 At the bottom of the list of login items, click , navigate to Compressor, then  
click Open.

Create a group of shared computers

You can create a group of shared computers to use to transcode your batches.

1.	 Choose Compressor > Settings.

2.	 Select Shared Computers.

3.	 At the bottom of the list of shared computers (on the left), click .

A new “Untitled” group is added to the list.

4.	 Double-click the “Untitled” group to select it, type a new name for the group, then 
press Return.

5.	 In the list of available computers (on the right), select the checkbox next to each 
computer that you want to add to the set.

6.	 If you want to add a computer that doesn’t appear in your list of computers, click  at 
the bottom of the list of networked computers (on the right), then in the window that 
appears, enter the computer’s host name or IP address, and click Add.

Important: When you first add a new computer to a computer group, you need to trust 
its security certificate before you can use it (see the next task).

To temporarily disable the computer that you manually added to the group, deselect the 
computer’s checkbox.

If you need to remove a group of shared computers, select the group and click  in the list 
of computer groups.

If you need to remove a computer from a group, select the computer and click  in the list 
of computers.

https://support.apple.com/101648
https://support.apple.com/101648
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Trust a computer that you add to a shared group

When a computer is first added to a shared computer group, it’s untrusted. For Compressor 
to use it, you need to trust its security certificate.

1.	 In the Shared Computers settings in Compressor, select the checkbox of a newly added 
computer in the list of computers.

2.	 A window appears asking if you’re sure you want to trust the server certificate. Click 
Show Certificate.

3.	 Click Always trust, then Continue.

4.	 Enter your credentials to allow the change.

You can now use the newly added computer in a shared computer group.

Transcode a batch using a group of shared computers

After you’ve created a shared computer group and added computers to the group, you can 
configure and submit a batch of jobs for transcoding as you normally would.

Note: Distributed processing can’t be used for jobs sent to Compressor from Final Cut Pro 
or Motion.

1.	 In Compressor, before clicking the Start Batch button, click the “Process on” pop-up 
menu and choose the group of computers that you want to use to process your batch.

2.	 Click Start Batch.

If this is the first time you’ve started a job using distributed processing or you’ve 
recently updated Compressor, you may receive a prompt to install a helper tool. If so, 
enter your password and click Install Helper.
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View the progress or history of a batch that was transcoded by a group of  
shared computers

After submitting a batch to be transcoded by a group of shared computers, you can find 
information about the transcoding status.

•	 In Compressor, open any of the following views:

•	 Active view: After you submit a batch, the Compressor window automatically 
switches to Active view to show the progress of the transcode.

•	 Completed view: Click the Completed button at the top of the Compressor window. 
After a batch is transcoded, information about the job, including the presets and job 
action used to transcode the source file, is displayed here.

•	 Network Encoding Monitor: Choose Window > Network Encoding Monitor. The 
Network Encoding Monitor displays information about how your computer is being 
shared, including processor usage, batch processing information, disk space usage, 
and data activity.

•	 Logs window: Click the Open All Logs button in the Network Encoding Monitor 
to display the Logs window. You can use the log information displayed here for 
troubleshooting distributed processing issues. You can save this information to  
a file and process it with XML tools and UNIX scripts.

Important: The log file is deleted when you close the Logs window.

Configure file sharing in Compressor
Compressor supports file sharing on network-attached storage (NAS) devices, storage 
area networks (SANs) such as Apple’s Xsan, and multiple computers. For example, if you 
have a file server or SAN, you can use it to hold your source files and any files transcoded 
from those source files. This allows you to provide a file-sharing strategy that best suits 
your environment.

File sharing requires that your computer and the other machines be in the same shared 
computer group using the same file-sharing protocol. The SMB file-sharing protocol is 
built into into macOS. However, you are not limited to SMB, so if you have NAS, SAN, or 
computers that offer maximized throughput using a different protocol, you can use that 
one. See the documentation for your devices for information on how to configure them  
for networking and mount the shared volumes.

Important: You must use the common shared volume (or volumes) on all of the computers 
for the location of the source files and for the location of the transcoded files. If you don’t 
do this, computers in your shared computer group won’t be able to read or write the files 
needed for your batch.
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Manually configure SMB file sharing

Important: If you’ve already set up your own file-sharing system, you can skip this task and 
go to the next one.

1.	 Choose Apple menu  > System Settings.

2.	 Go to General > Sharing.

3.	 In the Sharing settings pane, select the File Sharing button to turn on file sharing.

You can confirm that SMB sharing is on by clicking the Info icon next to File Sharing, 
then clicking Options and verifying that “Share files and folders using SMB” is  
turned on.

4.	 Click the Info icon to see File Sharing options, then click  under Shared Folders to add 
folders that you want to share.

For more information on turning on SMB file sharing, see Set up file sharing on Mac in the 
macOS User Guide.

Manually mount the SMB volume you enabled

For each computer in your shared computer group, or for any computer you wish to have 
access to the shared volume, do the following:

1.	 In the macOS Finder, choose Go > Connect to Server.

2.	 In the window that appears, enter the server address for the SMB volume that you want 
to mount, then click Connect.

For example, you could enter “smb://MySuperServer.”

3.	 In the window that appears, select an authentication method, enter appropriate 
credentials to access the shared volume, and click Connect.

4.	 In the window that appears, select the volume that you want to mount and click OK.

If you are using one computer for submitting Compressor batches and another computer 
for file sharing, be sure to mount the shared volume on the computer you’re using to 
submit Compressor batches.

Use the command line to submit Compressor jobs

Submit a job to Compressor in Terminal
If you’re accustomed to doing your work from Terminal shells, you can run the Compressor 
application from the command line using the Compressor command. There are a number 
of command-line options for submitting jobs.

https://support.apple.com/guide/mac-help/mh17131/
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Below is a synopsis of the Compressor command for submitting a job for transcoding. 
Angle brackets < > indicate a mandatory argument in a command, and brackets [ ] indicate 
an optional argument. The Compressor command is located in <PATH>/Compressor.app/
Contents/MacOS.

Important: The command below must be executed on one line.

Compressor [-computergroup <name>] [-batchname <name>]

    [-priority <value>] -jobpath <file>[?frameRate=<frame rate>

    |?audio=<file>|?frameRate=<frame rate>\&audio=<file>]

    -settingpath <path> -locationpath <file>

    [-info <xml>] [-scc <file>] [-startoffset <hh:mm:ss:ff>]

    [-in <hh:mm:ss:ff> [-out <hh:mm:ss:ff> [-annotations <file>]

    [-chapters <file>]

Compressor -checkstream <file>

Compressor -findletterbox <file>

Compressor -help

Compressor [-resetBackgroundProcessing [cancelJobs]]

    [-sharing <on|off>] [[-requiresPassword <password>]

    | [-noPassword]] [-instances <value>] 

    [-networkInterface <bsd name>] [-portRange <starting port>

    <count>]

These three arguments are the minimum required to submit a job:

Compressor ‑jobpath <path> ‑settingpath <path> ‑locationpath <path>

Important: If you’re using an image sequence as a source file, you must use a URL for the 
path in -jobpath.

Here’s an example of code you would use to submit a Compressor job:

/Applications/Compressor.app/Contents/MacOS/Compressor

    -batchname "My First Batch" -jobpath ~/Movies/

    MySource.mov -settingpath ~/Library/Application\

    Support/Compressor/Settings/Apple\ Devices\ HD\ \

    (Custom\).cmprstng -locationpath ~/Movies/MyOutput.m4v

What this command does:

•	 Identifies where Compressor is located

•	 Assigns the batch name “My First Batch” (The quotation marks are used because of the 
spaces.)

•	 Finds the file “MySource.mov” for the job at ~/Movies

•	 Uses the “Apple Devices HD (Custom)” preset at ~/Library/Application\ Support/
Compressor/Presets (The “\” character is used to retain the space in “Application 
Support.”)

•	 Writes the output file, “MyOutput.m4v,” to the ~/Movies folder
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Common command options used with Compressor
This table shows the most used command options for submitting jobs in Compressor:

Submission command option Description

-computergroup <name> Specifies the name of the group of shared computers.

-batchname <name> Specifies the name of the batch.

‑priority <value> Specifies the priority level for a job.

‑jobpath <url> Specifies the location of the source file.

‑settingpath <url> Specifies the location of the presets for the job.

‑locationpath <url> Specifies the destination file URL for the job.

‑relabelaudiotracks <layout>] Relabels audio channel layouts. Supported audio 
channel layout values:

•	 L (left channel)

•	 R (right channel)

•	 C (center channel)

•	 LFE (low frequency effects channel)

•	 Ls (left surround channel)

•	 Rs (right surround channel)

•	 Lc (left center channel)

•	 Rc (right center channel)

•	 Lt (left total channel)

•	 Rt (right total channel)

•	 Rls (rear surround left channel)

•	 Rrs (rear surround right channel)

•	 mono (mono channel)

•	 stereo (L R stereo channel configuration)

•	 LtRt (Lt Rt Matrix stereo configuration)

•	 SMPTE (L R C LFE Ls Rs Lt Rt 7.1 surround 
configuration)

•	 5_0 (L R C Ls Rs 5.0 surround configuration)

•	 5_1_D (C L R Ls Rs LFE 5.1 surround configuration)

•	 5_1_A (L R C LFE Ls Rs 5.1 surround configuration)

Unless -locationpath is specified, the relabeled 
audio tracks overwrite the ones in the original source 
file. All other parameters are ignored.
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Submission command option Description

‑relabelcolorspace <primaries> <transfer> 
<matrix>

Relabels the color space of a QuickTime movie file. 
Use -jobpath <url> to locate the source file. 
Unless -locationpath is specified, the relabeled file 
overwrites the original source file. All other parameters 
are ignored.

Supported values for color primaries:

•	 ITU_R_709_2 (1)

•	 EBU_3213 (5)

•	 SMPTE_C (6)

•	 ITU_R_2020 (9)

•	 DCI_P3 (11)

•	 P3_D65 (12)

•	 P22 (22)

Supported values for transfer functions:

•	 ITU_R_709_2 (1)

•	 SMPTE_240M_1995 (7)

•	 Linear (8)

•	 IEC_sRGB (13)

•	 SMPTE_ST_2084_PQ (16)

•	 SMPTE_ST_428_1 (17)

•	 ITU_R_2100_HLG (18)

Supported matrix values:

•	 ITU_R_709_2 (1)

•	 ITU_R_601_4 (6)

•	 SMPTE_240M_1995 (7)

•	 ITU_R_2020 (9)

See ISO/IEC standard 23091-2 for more information.

‑renametrackswithlayouts Renames tracks with new audio channel layouts.

‑help Displays all Compressor command-line options.

This table shows command options for configuring shared computers to use with 
Compressor:

Submission command option Description

-resetBackgroundProcessing [cancelJobs] Resets background processing and optionally cancels 
queued jobs.

-requiresPassword [password] Requires a password to share this computer.

-noPassword Turns off the password requirement.

-sharing <on | off> Turns sharing of this computer on or off.

-instances <number> Enables additional Compressor instances.

-networkInterface <bsdname> Specifies which network interface is used. If “all” 
is specified as a <bsdname>, all available network 
interfaces are used.

-portRange <startNumber> <count> Specifies the starting port range and the number of 
ports to use.



126Compressor User Guide

Settings and shortcuts

Compressor settings

Change settings in Compressor
You can modify Compressor settings to customize your workflow.

Change Compressor settings

•	 In Compressor, choose Compressor > Settings, then click a button at the top of the 
window to open a pane.

There are four panes in the Settings window:

•	 Use the General pane to set basic application settings.

•	 Use the My Computer pane to allow other computers to use your computer to 
process batches.

•	 Use the Shared Computers pane to set up groups of shared computers for 
distributed processing.

•	 Use the Advanced pane to adjust additional distributed processing settings.

Change privacy and analytics settings

Apple collects a variety of data, some of which is associated with your Apple Account. You 
can limit the use of certain analytics data or reset your identifier specifically used by apps 
in Apple Creator Studio.

1.	 In Compressor, choose Compressor > Privacy & Analytics.

2.	 Do any of the following:

•	 Turn off analytics: Deselect Share Analytics Data.

•	 Reset your identifier: Click Reset Identifier.

If you use iCloud Passwords & Keychain, turning off analytics or resetting your identifier 
affects your devices with iCloud Passwords & Keychain turned on. To see how your data is 
managed, go to https://www.apple.com/legal/privacy/data/compressor.

https://www.apple.com/legal/privacy/data/compressor
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General settings in Compressor
Use the controls in the General settings pane in Compressor to specify job or watch folder 
locations, to reset warning dialogs, and more.

Option Description

Preset Use this pop-up menu to specify a default preset for new jobs.

Location Use this pop-up menu to specify a default location for new jobs.

Clear batch in the Current tab Select this checkbox to automatically remove batch information from the 
Current view after a batch is transcoded.

Switch to the Active tab Select this checkbox to have Compressor switch to Active view when a 
batch is transcoding.

Reset all dialog warnings Some warnings contain a checkbox for suppressing future instances of the 
same error. Use this pop-up menu to reset any suppressed warnings so 
they will appear again.

Active queue limit Use this pop-up menu to specify how many batches can be in the active 
queue. You can select 100, 500, 1000, or an unlimited number of batches.

Default Output Location Use this pop-up menu to specify the default location for the watch folder 
output folder. You can choose one of the following options:

•	 Automatic: The output folder is created at the same directory level as 
the watch folder.

•	 Desktop: The output folder is created on the desktop.

•	 Movies: The output folder is created in the Movies folder.
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Option Description

Start processing after [numeral] 
seconds idle

Use this pop-up menu to set how many seconds Compressor waits after it 
stops detecting changes before it starts transcoding.

When an app (Final Cut Pro, for example) saves or exports a file to a 
watch folder, Compressor does not begin processing the file until the 
save or export is complete. However, because some apps begin the save 
or export, then pause the process before resuming, you can choose a 
time delay (10, 30, or 60 seconds) from this pop-up menu to ensure that 
Compressor doesn’t start transcoding prematurely.

Note: It’s possible an application may pause longer than 60 seconds 
when saving or exporting files. If that happens, save or export the files to 
another folder before manually dragging them to the watch folder.

Play a sound when Watch Folders 
start processing

Select this checkbox to hear an audio notification when a watch folder 
begins transcoding.

My Computer settings in Compressor
Use the controls in the My Computer pane in Compressor to allow other computers to use 
your computer to process batches:

Option Description

Allow other computers to process 
batches on my computer

Click the switch to On to make your computer available to other computers 
for distributed processing. Switching this on automatically enables 
the “When sharing my computer” controls in the Advanced pane. See 
Advanced settings.

Require Password Select this checkbox and then type a password in the text field to make 
other people enter a password before using your computer for encoding.
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Shared Computers settings in Compressor
Use the controls in the Shared Computers pane in Compressor to create groups of shared 
computers for distributed processing. See Transcode with multiple computers.

Advanced settings in Compressor
Use Advanced settings in Compressor to adjust additional settings for distributed 
processing. See Transcode with multiple computers.

Option Description

Enable additional Compressor 
instances

Check this box to activate additional instances of the Compressor 
application, which can also potentially speed transcoding. After selecting 
the checkbox, you can choose the number of additional instances from the 
pop-up menu. See Create Compressor instances.

When this box is unchecked, Compressor automatically attempts to 
process transcoding jobs using all available cores of your computer’s 
graphics processing engine. On Macs with M-series Max or Ultra chips, 
this may be the fastest transcoding option. 

Note: If your system doesn’t have enough memory or processor cores, this 
option is dimmed and unavailable.
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Option Description

Server Certificate If you have multiple server certificates on your computer, use this pop-up 
menu to choose between them, or to rename the certificates. If you have 
no additional server certificates, the server certificate that Compressor 
automatically creates is shown.

Use network interfaces Use this pop-up menu to restrict distributed processing activity to  
a specific network interface (when you’ve allowed others to share  
your computer).

Enable port range from Select this checkbox to set the ports on which distributed processing is 
run (when you’ve allowed others to share your computer). After selecting 
the checkbox, enter the number at which you want to start the port range 
and the number of ports you want the range to contain.

Reset Queue Click to reset the queue of Compressor jobs. After you click this button, 
you can choose to reset the queue and cancel all pending jobs, or reset 
the queue and then restart any pending jobs.

Update Droplets Click to update all droplets on the local computer to be compatible with 
the current version of Compressor. Outdated droplets that are not updated 
may not function properly. After droplets are updated, they’ll no longer 
work on computers using older versions of Compressor. See Create and 
use droplets.

Keyboard shortcuts

Built-in keyboard shortcuts in Compressor
You can use keyboard shortcuts to quickly accomplish many tasks in Compressor. 
Keyboard shortcuts for common commands are listed in the table below.

Compressor general keyboard shortcuts

Action Shortcut

Add a file Command-I

Add a set of image sequence files Option-Command-I

Add a set of surround sound files Control-Command-I

Navigate up the list of jobs (in the batch area) Up Arrow

Navigate down the list of jobs (in the batch area) Down Arrow

Play/Pause the video Space Bar

Play the video in reverse J

Stop playback K

Play the video L

Set the In point I

Set the Out point O
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Action Shortcut

Add a marker M

Go to the previous marker or In/Out point Control-Semicolon (;)

Go to the next marker or In/Out point Control-Apostrophe (’)

Start transcoding the batch Command-B

Compressor window keyboard shortcuts

Action Shortcut

Show the Current view Command-1

Show the Active view Command-2

Show the Completed view Command-3

Show or hide the inspector pane Command-4

Show or hide the Presets/Locations pane Command-5

Show Presets Shift-Command-1

Show Locations Shift-Command-2

Show the Errors & Warnings window Command-E

Show the Compressor Settings window Command-Comma (,)

Minimize the Compressor window Command-M

Close the Compressor window Command-W

Quit Compressor Command-Q

Note: You can set the window layout back to its default state by choosing Window > Reset 
to Default Layout.
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Customize keyboard shortcuts

View keyboard shortcuts in the Compressor Command Editor

Compressor provides a wide variety of menu commands and keyboard shortcuts that let 
you control almost every aspect of your transcoding workflow. You can use the Command 
Editor to modify existing shortcuts, create new shortcuts, and save multiple sets of 
keyboard shortcuts that you can export for others to use. You can also import a set of 
shortcuts that someone else created.

The Command Editor provides a set of keyboard shortcuts for Compressor in English, 
Japanese, French, and German. The language shown is determined by your computer’s 
operating system. To learn how to change the language used by Compressor, see Change 
the language your Mac uses in the Mac User Guide.

View keyboard shortcuts

1.	 Choose Compressor > Command Sets > Customize.

The Command Editor appears.

https://support.apple.com/guide/mac-help/mh26684
https://support.apple.com/guide/mac-help/mh26684
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2.	 Do any of the following:

•	 View keyboard shortcuts by command group: Select one of the command groups in 
the lower-left corner of the Command Editor.

The commands in the selected group (and their keyboard shortcuts) appear in the 
center list. When you select a command in the center list, a description appears in 
the Command Detail list in the lower-right corner of the Command Editor.

•	 View commands associated with a specific key: Click a key on the virtual keyboard.

The commands mapped to that key appear (along with the necessary modifier keys, 
if any—Control, Option, Shift, and Command) in the Key Detail list in the lower-right 
corner of the Command Editor.

When you hold down any modifier buttons on the keyboard, the key colors update 
in the Command Editor. Key colors correspond with command classifications; for 
example, playback commands, such as Play/Pause (Space bar), are purple. The 
Command Groups window on the left side of the Command List contains a clickable 
color key for reference.

•	 Search for a keyboard shortcut: Enter a command name, key name, or descriptive 
keywords in the search field in the upper-right corner of the Command Editor.

As you type, commands that match the search term appear in Command List at the 
bottom of the Command Editor.

 Tip: To show the keys that correspond with the items in the Command List, click 
the Keyboard Highlight button to the left of the search field.

Modify keyboard shortcuts in the Compressor Command Editor

You can customize keyboard shortcuts for Compressor in the Command Editor. If you want 
to add a few custom commands to the default set in Compressor, you can duplicate the 
default set and assign keyboard shortcuts to some of the unassigned commands. You can 
also create a new set that contains only your commands.

Duplicate a command set

1.	 Choose Compressor > Command Sets > Customize.

The Command Editor appears.

2.	 Click the pop-up menu in the top-left corner of the Command Editor, then choose a 
command set to duplicate.

The command set you selected should have a checkmark to the left of its name in the 
pop-up menu.

3.	 In the same pop-up menu, choose Duplicate.

4.	 In the dialog that appears, type a name for the command set, then click OK.

The duplicate set is added to the Commands submenu of the Compressor menu and to 
the pop-up menu in the Command Editor.
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Delete a command set

1.	 Choose Compressor > Command Sets > Customize.

The Command Editor appears.

2.	 Click the pop-up menu in the top-left corner of the Command Editor, then choose a 
command set to delete.

The command set you selected should have a checkmark to the left of its name in the 
pop-up menu.

3.	 In the same pop-up menu, choose Delete.

4.	 In the dialog that appears, click Delete.

The command set is removed.

Export and import command sets in Compressor

You can export a command set to create a backup or to share the set with another user. 
Exported command sets are saved in a file that can be imported back into Compressor at  
a later time. You can also import a command set.

Export a command set

1.	 Choose Compressor > Command Sets > Customize.

The Command Editor appears.

2.	 Click the pop-up menu in the top-left corner of the Command Editor, then choose a 
command set to export.

The command set you selected should have a checkmark to the left of its name in the 
pop-up menu.

3.	 In the same pop-up menu, choose Export.

4.	 Type a name for the command set in the Save As field, navigate to the location where 
you want to save the exported set, then click Save.

The file is saved in the location you chose, with the filename extension .commandset.

Import a command set

1.	 Choose Compressor > Command Sets > Import.

2.	 In the window that appears, navigate to the location where you’ve stored a command 
set file, select it, and click Open.

If you’re already using a command set with the same name, a window appears and asks 
you to rename the command set.

The new command set is added to the Command Sets submenu of the Compressor 
menu and to the pop-up menu in the Command Editor.
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View shortcuts for a different command set

In Compressor, if your system has multiple command sets, you can easily switch 
between them.

Do one of the following:

•	 Choose Compressor > Command Sets, then choose a command set from the submenu.

The Command Editor window appears, showing the command set you chose.

•	 If you’ve already opened the Command Editor, click the pop-up menu at the top-left 
corner of the window, then choose a command set.

Touch Bar shortcuts in Compressor
If your MacBook Pro has a Touch Bar, you can use familiar gestures like swipe and tap 
to perform common tasks in Compressor. The controls visible in the Touch Bar change 
depending on which windows, views, or states are active in the app. See Use the Touch Bar 
on Mac.

The tables below show the Touch Bar controls in Compressor grouped by different app states.

Empty batch

When you first launch Compressor, or when you have no items in the batch area, the Touch 
Bar shows the Add Item button:

Item Name Description

Add Item Opens controls in the Touch Bar for 
adding media files to your batch. 
See Add item.

Add item

After you tap the Add Item button, the following buttons appear in the Touch Bar:

Item Name Description

Close Returns you to the previous Touch 
Bar screen.

Add File Opens a dialog to select a file to 
add as a new job.

Add Image Sequence Opens a dialog to select a sequence 
of images to add as a new job.

Add Surround Sound Group Opens a dialog to select the files 
needed for a new surround sound 
group.

https://support.apple.com/guide/mac-help/mchlbfd5b039/
https://support.apple.com/guide/mac-help/mchlbfd5b039/
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Item selected in a job

When you have an item selected in a job in the batch area in Compressor, the following 
controls appear in the Touch Bar:

Item Name Description

Add Item Opens controls in the Touch Bar for 
adding media files to your batch. 
See Add item.

Add Outputs Opens a dialog to add presets to 
your job.

Add Poster Frame Adds a poster frame at the current 
playhead position. See Set a poster 
frame.

Add Marker Adds a default marker at the current 
playhead position. (If a marker 
is already present at the current 
frame, that marker is deleted.) 
Touch and hold to display controls 
for adding a marker different 
from the default type. See Add 
nondefault markers.

Preview Navigation Available when the batch contains 
media, opens preview controls 
in the Touch Bar. See Preview 
navigation.

Add nondefault markers

When you touch and hold , additional buttons appear in the Touch Bar; tap one to add a 
marker different from the default marker type.

Item Name Description

Chapter Marker Adds a chapter marker, and sets 
the default marker type to Chapter. 
(If a marker is already present at 
the current frame, that marker is 
deleted.)

Compression Marker Adds a compression marker, and 
sets the default marker type to 
Compression. (If a marker is already 
present at the current frame, that 
marker is deleted.)

Edit Marker Adds an edit marker, and sets 
the default marker type to Edit. 
(If a marker is already present at 
the current frame, that marker is 
deleted.)
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Item Name Description

Podcast Marker Adds a podcast marker, and sets 
the default marker type to Podcast. 
(If a marker is already present at 
the current frame, that marker is 
deleted.)

See Add markers.

Preview navigation

When you tap , the following controls appear in the Touch Bar:

Item Name Description

Close Returns you to the previous Touch 
Bar screen.

Preview Navigation bar Displays a timeline for the selected 
media. Poster frames, markers, and 
the current playhead position are 
indicated with icons.

Add Poster Frame Adds a poster frame at the current 
playhead position. See Set a poster 
frame.

Add Marker Adds a default marker at the current 
playhead position. (If a marker 
is already present at the current 
frame, that marker is deleted.) See 
Add markers.

Item selected in the Presets pane

When you select a preset or destination in the Presets pane, the following buttons appear 
in the Touch Bar:

Item Name Description

New Preset Opens controls in the Touch 
Bar for adding custom presets, 
destinations, or groups to the 
Preset pane. See New preset.

Add to Batch Adds the currently selected preset 
or destination to all jobs in the 
batch area.
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Item Name Description

Add to Selected Adds the currently selected preset 
or destination to selected jobs in 
the batch area. (This button appears 
in the Touch Bar only when one or 
more jobs are selected in the batch 
area.)

Save as Droplet Saves the currently selected preset 
or destination to a droplet. See 
Create and use droplets.

New preset

When you tap the New Preset button, the following controls appear in the Touch Bar:

Item Name Description

Close Returns you to the previous Touch 
Bar screen.

Add Preset Opens a dialog to add a new custom 
preset to the Presets pane.

Add Destination Opens a dialog to add a new custom 
destination to the Presets pane.

Add Group Opens a dialog to add a new folder 
in the Presets pane.

iTunes Store Package

When you add an iTunes Store package to the batch area, the following controls appear in 
the Touch Bar:

Item Name Description

Add iTMS Files Opens Touch Bar controls for 
adding iTMS (iTunes Media Store) 
files. See iTMS files options.

Add Poster Frame Available when your iTunes Store 
package contains media. Adds 
a poster frame at the current 
playhead position. See Set a  
poster frame.
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Item Name Description

Add Marker Available when your iTunes Store 
package contains media. Adds 
a default marker at the current 
playhead position. (If a marker 
is already present at the current 
frame, that marker is deleted.) 
Touch and hold to display controls 
for adding a marker different 
from the default type. See Add 
nondefault markers.

Display Preview Available when your iTunes Store 
package contains media. Opens 
preview controls in the Touch Bar. 
See Preview navigation.

iTMS files options

When you tap the Add iTMS Files button, the following controls appear in the Touch Bar:

Item Name Description

Close Returns you to the previous Touch 
Bar screen.

Add Feature Opens a dialog to select a video 
file to use as the feature in your 
package.

Add Subtitles Opens a dialog to select an .itt file 
for your package.

Add Closed Caption Opens a dialog to select a closed-
caption file for your package.

Add Alternative Audio Opens a dialog to select an 
alternative audio file for your 
package.

Add Preview Opens a dialog to select a video file 
to use as a preview in your package.

See Build an iTunes Store package.
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Active view

When you select an item in Active view while Compressor is transcoding a batch, the 
following controls appear in the Touch Bar:

Item Name Description

Pause Processing Appears only when the selected 
batch is processing. Tap to pause 
processing.

Resume Processing Appears only when the selected 
batch is paused. Tap to resume 
processing.

Cancel Processing Tap to stop processing.

Completed view

When you select an item in Completed view in Compressor, the following controls appear in 
the Touch Bar:

Item Name Description

Reuse Adds the currently selected item (in 
Completed view) to the batch area 
as a new, unprocessed batch.

Show in Finder Displays a Finder window with all 
exported files highlighted.
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Glossary

360° video  Footage captured by special cameras that point lenses in all directions to 
create a panoramic sphere of video. A viewer can watch 360° video in any of several ways:

•	 Through a virtual-reality (VR) headset: This hardware device displays video on a face-
mounted screen that’s updated dynamically to show different parts of a scene as the 
viewer turns their head. Some VR headsets can also display stereoscopic (3D) 360° 
video, enhancing the immersive experience.

•	 In a rectangular window: This viewing method is used on a smart phone, tablet, or 
computer. The viewer scrolls the window to see different parts of the scene.

•	 On a standard display: This viewing method, with the audience unable to control viewing 
angles, is similar to watching conventional video, with the added benefit of giving the 
filmmaker more options for angle choices during editing.

AAC (Advanced Audio Coding)  Also called MPEG-4 Audio. A standard way of compressing 
and encoding digital audio. AAC-encoded files generally sound as good as or better than 
MP3 files encoded at the same or even a higher bit rate.

AC-3 (Audio Codec 3, Advanced Codec 3, Acoustic Coder 3)  A Dolby Digital compressed 
audio format often used for encoding surround sound.

AIFF (Audio Interchange File Format)  A cross-platform audio file format developed by 
Apple. Like WAV files, AIFF files contain “chunks” of information such as the Sound Data 
Chunk, which contains the actual sample data, and the Common Chunk, which contains 
sample rate and bit depth information.

ALAC (Apple Lossless Audio Codec)  A lossless audio codec developed by Apple. ALAC 
supports up to eight channels of audio, with a maximum sample depth of 32 bits and a 
maximum sample rate of 384 kHz.

alternative audio  Translated dialog tracks, commentary, or audio descriptions (for the 
visually impaired) included in an iTunes Store package.

Apple ProRes codecs  Codecs that provide an unparalleled combination of multistream, 
real-time editing performance, impressive image quality, and reduced storage rates. 
Apple ProRes codecs take full advantage of multicore processing and feature fast, 
reduced-resolution decoding modes. All Apple ProRes codecs support any frame size 
(including SD, HD, 2K, and 4K) at full resolution. The data rates vary based on codec type, 
image content, frame size, and frame rate.
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Apple ProRes includes the following formats:

•	 Apple ProRes 4444 XQ: The highest-quality version of Apple ProRes for 4:4:4:4 image 
sources (including alpha channels), with a very high data rate to preserve the detail 
in high-dynamic-range imagery generated by today’s highest-quality digital image 
sensors. Apple ProRes 4444 XQ preserves dynamic ranges several times greater than 
the dynamic range of Rec 709 imagery—even against the rigors of extreme visual 
effects processing, in which tone-scale blacks or highlights are stretched significantly. 
Like standard Apple ProRes 4444, this codec supports up to 12 bits per image channel 
and up to 16 bits for the alpha channel. Apple ProRes 4444 XQ features a target data 
rate of approximately 500 Mbps for 4:4:4 sources at 1920 x 1080 and 29.97 fps.

•	 Apple ProRes 4444: An extremely high-quality version of Apple ProRes for 4:4:4:4 
image sources (including alpha channels). This codec features full-resolution, 
mastering-quality 4:4:4:4 RGBA color and visual fidelity that is perceptually 
indistinguishable from the original material. Apple ProRes 4444 is a high-quality 
solution for storing and exchanging motion graphics and composites, with excellent 
multigeneration performance and a mathematically lossless alpha channel up to 16 bits. 
This codec features a remarkably low data rate compared to uncompressed 4:4:4 HD, 
with a target data rate of approximately 330 Mbps for 4:4:4 sources at 1920 x 1080  
and 29.97 fps. It also offers direct encoding of, and decoding to, both RGB and Y’CBCR 
pixel formats.

•	 Apple ProRes 422 HQ: A higher-data-rate version of Apple ProRes 422 that preserves 
visual quality at the same high level as Apple ProRes 4444, but for 4:2:2 image 
sources. Apple ProRes 422 HQ offers visually lossless preservation of the highest-
quality professional HD video that a single-link HD-SDI signal can carry. This codec 
supports full-width, 4:2:2 video sources at 10-bit pixel depths, while remaining visually 
lossless through many generations of decoding and reencoding. The target data rate of 
Apple ProRes 422 HQ is approximately 220 Mbps at 1920 x 1080 and 29.97 fps.

•	 Apple ProRes 422: A high-quality compressed codec offering nearly all the benefits of 
Apple ProRes 422 HQ, but at 66 percent of the data rate for even better multistream, 
real-time editing performance. The target data rate of Apple ProRes 422 is 
approximately 147 Mbps at 1920 x 1080 and 29.97 fps.

•	 Apple ProRes 422 LT: A more highly compressed codec than Apple ProRes 422, with 
roughly 70 percent of the data rate and 30 percent smaller file sizes. This codec is 
perfect for environments where storage capacity and data rate are at a premium. The 
target data rate of Apple ProRes 422 LT is approximately 102 Mbps at 1920 x 1080 and 
29.97 fps.

•	 Apple ProRes 422 Proxy: An even more highly compressed codec than 
Apple ProRes 422 LT, intended for use in offline workflows that require low data 
rates but full-resolution video. The target data rate of Apple ProRes 422 Proxy is 
approximately 45 Mbps at 1920 x 1080 and 29.97 fps.

Note: Apple ProRes 4444 and Apple ProRes 4444 XQ are ideal for the exchange of motion 
graphics media because they are virtually lossless, and are the only Apple ProRes codecs 
that support alpha channels.

AVCHD  A high-definition (HD) video format that uses Advanced Video Coding (AVC) 
compression (also known as MPEG-4 part 10 or H.264). Many Blu-ray players can play  
red laser discs with AVCHD format content.
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baseline  In stereoscopic footage, the horizontal distance between the two camera lenses 
used to capture the images (also known as the interaxial distance).

batch  In Compressor, one or more jobs to be processed. All jobs contained within the 
batch (shown in the batch area of the Compressor window) are submitted collectively  
when you begin the transcoding process.

bit rate  The number of bits per second in the transmission of a digital video or audio 
signal. The higher you set the bit rate, the better the quality of the output file. However, 
higher bit rates require larger file sizes.

CAF (Core Audio Format)  A flexible file format for storing and manipulating digital audio 
data. CAF provides high performance and flexibility, and is scalable to future ultra high-
resolution audio recording, editing, and playback.

captions  Onscreen text superimposed over a video and synchronized to the video and 
audio. Compressor supports three industry-standard caption formats: CEA-608 closed 
captions, iTT (iTunes Timed Text) subtitles, and SRT (SubRip Text) subtitles.

CEA-608 closed captions  An industry-standard format for delivering onscreen text 
synchronized to a video. Originally developed for people who are deaf or hard of hearing, 
CEA-608 closed captions (also known as Line 21 text) are frequently used on televisions 
in loud environments (such as bars and airports). CEA-608 closed captions, which use 
the .scc filename extension, offer numerous formatting options. Viewers can turn closed 
captions on or off while watching television shows, movies, web videos, and other 
programs. In Compressor, CEA-608 closed captions are compatible with iTunes Store 
packages and many transcode presets.

codec  Short for compressor/decompressor, or encode/decode. A software component 
used to translate video or audio from its current form to a different, digitally compressed 
form. A codec encodes a data stream or signal for transmission, storage or encryption, or 
decodes it for playback or editing. A similar term, encoder, is used to describe hardware 
that performs the same activity.

color depth  The number of bits used to represent color in each color channel—red, green, 
and blue.

color space  The range of colors available for an image, sometimes called gamut. A wider 
gamut allows for more possible color values and permits more accurate representation  
of color.

Composition playlist (CPL)  An XML file that defines the playback order for the media 
assets of an Interoperable Master Format (IMF) package. It also contains metadata 
associated with the playback order. The CPL allows IMF packages to combine multiple 
assets into a single playback of a program.

cubic projection  A spatial projection mode that represents spherical data as an unfolded 
cube with six faces.

delivery partner  A content aggregator or encoding house certified by the iTunes Store 
and authorized to submit iTunes Store packages to the store for sale. These partners 
ensure your content is properly configured and formatted to meet the stringent submission 
requirements of the iTunes Store. They can also provide billing and support services after 
your video becomes available for sale.
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descriptive audio  An alternative audio track that includes voice narration to help visually 
impaired consumers understand what’s happening onscreen. Descriptive audio narration 
is usually delivered during the natural pauses in dialog or between critical sound elements. 
An iTunes Store package can contain multiple descriptive audio tracks (in multiple 
languages, for example).

destination  In Compressor, a group of one or more transcode presets plus a post-
transcoding action. If you use a destination to transcode a file, one or more new files are 
created to the preset’s specifications and then an action is automatically performed on 
the transcoded file. For example, the Add to TV Home Videos destination creates a file 
optimized for viewing on Apple TV. After the file is processed, the Add to TV Home Videos 
action automatically copies the output file to your Home Videos library on Apple TV.

display aspect ratio  The ratio between an image’s width and height. For example, 
standard-definition (SD) video typically has an aspect ratio of 4:3. High-definition (HD) 
video typically has an aspect ratio of 16:9. If SD video is played on an HD display, the 
image is either stretched, or is appended with black borders on left and right sides 
(pillarboxing). If HD video is played on an SD display, the image will be squeezed or  
black borders will appear at the top and bottom (letterboxing).

distributed processing  A method of transcoding that accelerates processing of 
Compressor batches by distributing the work among multiple computer processors. A 
system can distribute parts of a batch to multiple instances of the Compressor application 
on a single computer, or to two or more networked computers (each running one or more 
instances of Compressor).

dithering  A deliberately applied form of noise that simulates additional colors in a limited 
palette by blending color transitions. For example, a pattern of yellow and blue can be 
applied to give the impression that green appears in the image.

Dolby Digital  See AC-3.

Dolby Digital Enhanced  See E-AC-3.

Dolby Vision 8.4  A high-dynamic-range video format developed by Dolby Laboratories 
and optimized for Apple devices.

downmix  The process of outputting fewer audio channels than are contained in the source 
file. For example, you can use a source file containing surround sound (5.1 channel layout) 
to output a file containing a stereo file with a left and right channel or a mono file with a 
single channel.

drop frame timecode  A timecode format that prioritizes representing time elapsed instead 
of frames elapsed when a clip is not 30 fps. Drop frame timecode typically displays a 
semicolon between seconds and frames.

droplet  A lightweight, standalone app created by Compressor to apply specific presets or 
destinations to media files. You can drag and drop media files onto the droplet icon in the 
macOS Finder to begin processing.

dynamic range  The difference, in decibels, between the loudest and softest parts of  
a recording.

E-AC-3  A Dolby Digital compressed audio format often used for encoding surround sound. 
E-AC-3 supports up to fifteen channels of audio.

encoder  See codec.
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equirectangular projection  A spatial projection mode that squeezes and distorts the 
spherical data like a flat map of the spherical earth.

field of view  In stereoscopic footage, the horizontal field of view of the lenses used to 
capture the images.

file format  The output format used to transcode your source media file. Also called a 
transcoding format.

FLAC (Free Lossless Audio Codec)  A lossless audio format that supports up to 8 channels 
of audio and up to 32 bit sample depth.

frame-packed  A term used to describe stereoscopic video formats that "pack” both eye 
views into the same frame. Common frame-packed formats are Over/Under, in which one 
eye view (typically the left eye) is placed on top of the other eye, and Side by Side, in 
which both eye views are placed next to each other.

group of pictures (GOP)  A file compression method that groups frames, or “pictures,” in 
encoded video to remove redundant frames. There are three GOP frame types: I-frames 
(intra-coded frames), P-frames (predictive frames), and B-frames (bidirectional predictive 
frames). These are collectively called a group of pictures (GOP). MPEG-2 and H.264 
encoding in Compressor combine frames into groups of pictures during the encoding 
process to output a highly compressed file.

H.264  A video compression standard in widespread use for recording, distribution, and 
internet streaming of high-definition (HD) video. Also known as MPEG-4 Part 10 or AVC 
(Advanced Video Coding).

HDR (high dynamic range)  Video stored in a format that processes higher levels of 
luminance (brightness) per color component to provide significant improvements in 
contrast, detail, and light levels over standard-dynamic-range (SDR) video. HDR can 
represent luminances as high as 10,000 nits (candelas per square meter) with a dynamic 
range of 14 stops or more, creating more realistic color transitions and revealing more 
detail in both shadows and highlights. HDR video is typically combined with wide-gamut 
color spaces such as Rec. 2020 or P3 D65 to deliver video any of several formats, 
including HDR10, Dolby Vision, and HLG (hybrid log-gamma).

hero eye  The default eye view in a stereoscopic pair of video files. An MV-HEVC file 
contains two layers: the base layer encodes the hero-eye view, and a second layer encodes 
only the portions of the other eye view that differ from the hero eye. This improves 
playback and encoding efficiency. The hero eye is typically designated with a tag assigned 
by the cameras during video capture, but you can reassign the hero eye in Compressor 
prior to encoding. When stereoscopic footage is used in a 2D project, the hero eye’s layer 
and metadata is used.

HEVC  High-Efficiency Video Coding (also known as H.265), a video compression standard 
designed to reduce file size while retaining a high-quality image. HEVC also supports 
larger frame sizes (including 8K) and HDR10 metadata for high-dynamic-range video. The 
Apple Devices transcode preset in Compressor includes three built-in options for HEVC 
output. You can also customize the MPEG-4 and QuickTime Movie presets to use the HEVC 
encoder. HEVC encoding in Compressor requires macOS 10.13 or later. HEVC playback 
requires an Apple device with macOS 10.13, iOS 11, iPadOS 13, tvOS 11, or later.
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HLG (hybrid log-gamma)  A mathematical HDR transfer function that converts image 
signal values in a video file to scene-relative light levels. HLG, which was developed by 
the BBC and the NHK (Japan Broadcasting Corporation), requires no metadata and is also 
compatible with SDR displays. In Compressor, HLG is used with the Rec. 2020 color space 
to create video files in the hybrid log-gamma HDR standard.

horizontal disparity  In stereoscopic footage, the amount of horizontal shift in left- and 
right-eye images to set the perceived depth of a 3D scene (also called convergence). 
When horizontal disparity is negative, content in the footage appears closer; when it’s 
positive, content seems farther away.

HTTP Live Streaming  An HTTP-based media streaming communications protocol, 
commonly used to send audio and video over HTTP from an ordinary web server for 
playback on a variety of computers and devices. HTTP Live Streaming supports multiple 
alternate streams at different bit rates, allowing the client software to switch streams 
intelligently as network bandwidth changes.

i-frame (intra-coded picture)  One type of frame used to define the GOP (Group of 
Pictures) pattern used during MPEG-2 or H.264 encoding. A GOP pattern can also include 
P-frames (predictive coded picture) and B-frames (bipredicitive coded picture).

inspector pane  An area on the right side of the window when Compressor is in Current 
view. When you select a preset, location, batch, job, or other item anywhere in Compressor, 
you can view more information about it or customize its parameters in the inspector pane. 
The contents of the inspector pane change depending on the item you select.

interlaced video  A technique developed for legacy NTSC or PAL televisions to double the 
perceived frame rate without increasing bandwidth by combining two half-frames called 
fields into a single frame. The odd (or upper) field contains lines 1, 3, 5, 7, 9 and so on, and 
the even (or lower) field contains lines 2, 4, 6, 8, 10, and so on. When the video is played 
back, the TV displays the fields in an alternating (interlaced) pattern, which creates an 
effective illusion of smooth movement. Viewing interlaced video on a computer screen that 
displays both fields simultaneously may reveal a combing effect. Progressive video frame 
rates store the video in a series of whole frames instead these two-fields. You can remove 
the fields from an interlaced video clip by converting it to a progressive frame rate.

Interoperable Master Format (IMF) package  A container format standard for digital 
delivery and storage of audio-visual masters, including movies and TV episodes. Created 
by the Society of Motion Picture and Television Engineers (SMPTE), IMF specifies a set 
of individual components, contained within a folder, which together create a complete 
IMF package. Compressor can create these packages, provided you have all the requisite 
components (video files and audio files).

iTT (iTunes Timed Text) subtitles  An industry-standard format for delivering onscreen 
text synchronized to a video. iTT subtitles can be used to deliver foreign-language 
translations or a transcript of dialogue, narration, or audio descriptions to people who 
are deaf or hard of hearing. iTT subtitles, which use the .itt filename extension, offer 
more limited formatting options than CEA-608 captions. In Compressor, you can specify 
whether to let viewers turn iTT subtitles on or off (for example, for full foreign-language 
translations) or force subtitles to appear onscreen (for example, for specific characters in 
a movie who speak a different language). In Compressor, iTT subtitles are compatible with 
iTunes Store packages and many transcode presets.
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iTunes Store package  The prescribed submission format that developers must use when 
delivering video content to the iTunes Store. Compressor can create these packages, 
provided you have all the requisite components (video files, audio files, subtitle files, 
closed-caption files, and so on).

job  In Compressor, the media source file and transcoding instructions used to output 
a file.

job action  In Compressor, an action that is performed on a media file after it’s transcoded. 
For example, a job action can add a transcoded file to your Home Videos library on 
Apple TV or automatically send the transcoded file in an email.

keyframe interval  In video compression, the frequency at which complete frames 
(keyframes) are inserted in a video sequence. A keyframe preserves all the visual 
information of a single frame, and the frames after it store incremental changes in the 
image, until the next keyframe occurs in the sequence. Thus, when the image in the video 
changes dramatically—for example, when switching between images—a new keyframe is 
created to represent the change.

location  In Compressor, the location where your transcoded media file is saved. You can 
either use the default location (the same folder the source media file is in) or choose a 
custom location.

log profile  A picture profile option in many digital cameras that increases the  
amount of tonal data included in the captured image, allowing for greater flexibility  
in post-production.

lookup table (LUT)  A mathematical formula that converts a set of encoded values to 
a different set of values for display. Compressor supports camera and creative LUTs. A 
camera LUT converts camera-encoded data from a non-linear log curve—which allocates 
more dynamic range to light values where the human eye is more sensitive—to a color 
space that allows those values to be displayed properly. Camera raw video is typically 
stored in a log color space using a proprietary curve specifically optimized to a camera’s 
light sensor, with metadata indicating the name and model of the source camera. A creative 
LUT is used to give video a specific look.

lower third  A television industry term for a graphic placed in the lower area of the screen, 
usually to convey details about subjects or products. A common use of lower thirds is to 
identify individuals on the screen with their names and job titles.

marker  A visual indicator in the preview area of Compressor that flags a specific timing 
location in a source file. You can append a marker with editing notes or other descriptive 
information. Additionally, when you output the source file to an H.264, MPEG-2, or MPEG-
4 video format, each marker forces the creation of an I-frame. Added I-frames improve 
compression quality, but can increase overall file size.

monoscopic video  2D video captured using a single camera with one lens. The term is 
typically used in contrast with stereoscopic video, which captures video with two cameras 
to create a perceived sense of depth.

MP3  Refers to the MPEG-1 or MPEG-2 Audio Layer 3 compression standard and file 
format. Like AAC, MP3 uses perceptual audio coding and psychoacoustic compression  
to remove superfluous information that the human ear doesn’t hear.
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MV-HEVC  Multiview High Efficiency Video Coding, a video compression standard based 
on HEVC (H.265), but with additional support for stereoscopic video. MV-HEVC encodes 
two different views (one for each eye) in separate layers of the same file, allowing 
for efficient storage and playback of stereo 3D video files, including spatial video on 
Apple Vision Pro. Working with MV-HEVC encoded video in Compressor requires a Mac 
with Apple silicon and macOS 14 or later.

nit  A unit of measure describing the luminance (light intensity) of a video display. One nit 
is equal to one candela per square meter.

output row  In the Compressor batch area, a row containing all the elements required 
for one transcoding output, including a preset that specifies properties defining how to 
transcode the source media file, a location where the transcoded file will be saved, and a 
filename for the transcoded file. A single job can contain multiple output rows (for example, 
if you want to transcode one media source into several different video formats).

P3 D65  Also known as Display P3, a wide-gamut color space based on the DCI-P3 color 
standard developed for digital movie projection. P3 D65 is the display color space of Apple 
devices such as the iMac (with Retina 4K or 5K display), MacBook Pro, and iPad Pro.

PQ (perceptual quantizer)  A mathematical transfer function that converts image signal 
values in a video file to absolute light levels on an HDR-capable display. Designed to 
approximate the sensitivity of human eyes, PQ allows for better levels of contrast at all light 
levels. In Compressor, PQ is used with the Rec. 2020 and P3 D65 wide-gamut color spaces 
to create video files in the industry-standard HDR formats, HDR10+ and Dolby Vision.

preset  In Compressor, a group of preconfigured properties that you can apply to a source 
media file. Presets are used to transcode files into commonly used audio and video formats 
for Apple devices, podcasting, internet streaming, post-production, and so on. Each  
preset includes adjustable properties like output file format, retiming instructions, and 
optional effects.

Presets/Locations pane  An area on the left side of the window when Compressor is in 
Current view that shows presets, destinations, and locations. The Presets pane shows a  
list of built-in destinations, built-in presets, custom destinations, and custom presets.  
The Locations pane shows a list of built-in save locations and custom save locations.

preview area  In Compressor, the area where you can play your source file and preview 
your output file. After you apply effects or change the properties of the preset that will 
transcode your source file, you can compare the “before” and “after” versions by clicking 
the Comparison button (under the timeline). The screen is divided by a vertical white line, 
with the source file shown on the left and the preview of the transcoded file shown on  
the right.

QuickTime  The cross-platform multimedia technology that allows macOS and Windows 
applications to capture and play back video, audio, and still-image files.

Rec. 709  Short for ITU-R Recommendation BT.709, the standard broadcast format for 
high-definition (HD) television.

Rec. 2020  Short for Rec. ITU-R Recommendation BT.2020, a color space standard with a 
very large gamut (range of color).
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resolution  Also referred to as frame size, the number of pixels in an image. Resolution is 
expressed in terms of the width and height of the image in pixels (for example, 640 x 360 
pixels). Higher-resolution images contain more detail but also create larger files that take 
longer to download. Your electronic devices (computer, iPhone, iPad, and so on) also 
have screen resolution. Ideally, you should match the image resolution of your media to 
the resolution of your playback device. When you add a preset to a source media file, 
Compressor determines appropriate resolution sizes you can use, based on the image  
sizes used in the movie and on the preset that you’re using to output the file.

reverse telecine  The process of removing telecine synchronization from video. Telecine 
is legacy method of transferring film footage shot at 24 frames per second (fps) to 
interlaced NTSC video (29.9 frames per second) or PAL video (25 frames per second) for 
broadcast television. However, because computers, HDTVs, 4K TVs, and other modern 
display devices support progressive frame rates (like 24 fps), it’s often desirable to remove 
the interlacing from telecined clips and restore the video to its original 24 fps rate. This 
process is known as reverse telecine.

sample rate  The number of times per second that music waveforms (samples) are 
captured digitally. The higher the sample rate, the higher the quality and the larger the 
file size.

sample size  The number of bits in each audio sample; determines the potential dynamic 
range of the sound.

SDR (standard dynamic range)  The conventional technique for processing luminance 
(levels of brightness) and color values in images, developed in the mid-1900s, with an 
upper luminance limit of 100 nits (candelas per square meter) and a dynamic range of  
6–10 stops.

segment duration  Specifies the length (in seconds) of the chunks of media used in file 
streaming. A shorter segment duration typically decreases latency at the expense of 
quality, while longer segment durations increase quality but take longer to load.

spatial video  A type of stereoscopic video unique to Apple that’s designed to make it easy 
for users to capture and share 3D video on iPhone 15 Pro, iPhone 16, iPhone 16 Pro, and 
Apple Vision Pro. Spatial video includes special metadata to render a specific presentation 
style on Apple Vision Pro that mitigates common causes of stereo discomfort.

SRT (SubRip Text) file format  An industry-standard format for delivering onscreen text 
synchronized to a video. SRT subtitles can be used to deliver foreign-language translations 
or a transcript of dialogue, narration, or audio descriptions to people who are deaf or 
hard of hearing. SRT subtitles, which use the .srt filename extension, offer more limited 
formatting options than CEA-608 captions. In Compressor, you can specify whether to let 
viewers turn SRT subtitles on or off (for example, for full foreign-language translations) 
or force subtitles to appear onscreen (for example, for specific characters in a movie who 
speak a different language). In Compressor, many built-in presets and destinations support 
SRT subtitles, including Apple Devices (in both the H.264 and HEVC codecs), ProRes, and 
other presets that use the QuickTime Movie, MPEG-2, and MPEG-4 formats.

stereoscopic video  Video captured using two closely positioned parallel cameras, 
resulting in two video views (left and right) that have slightly different perspectives of the 
same image. These two linked files are then combined to produce a sense of depth and 
dimension greater than that of a single monoscopic video file.
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storage aspect ratio (SAR)  The ratio between an image’s width and height when it’s 
stored. Storage aspect ratio can differ from display aspect ratio (DAR) resulting in a file 
that must be stretched or squeezed during playback to appear correct. This disparity can 
allow a camera format limited to 4:3 recording to successfully record a widescreen image 
by “squeezing” the image during recording. If the image is unsqueezed during playback it 
will display correctly in its widescreen aspect ratio. This is called an anamorphic image.

telecine  The process of converting motion picture film to the NTSC video format used in 
broadcast television. The most common telecine approach to converting film’s standard 
24 fps frame rate to NTSC video’s 29.97 fps frame rate is to perform a 3:2 pulldown (also 
known as a 2:3:2:3 pulldown). If you alternate recording two fields of one film frame and 
then three fields of the next, the 24 frames in 1 second of film end up filling the 30 frames 
in 1 second of video.

transcoding  The process of converting files from their original format to a different 
format. Closely related terms include compression, which specifically refers to data 
reduction, and encoding, a term that is essentially synonymous with transcoding, but 
doesn’t emphasize the conversion aspect.

uncompressed 8-bit and 10-bit 4:2:2  Video formats used to store 8-bit or 10-bit 4:2:2 
Y’CBCR video without employing data compression. Bypassing compression reduces the 
computer’s processing load but increases the data rate considerably. A large-capacity 
RAID storage system is typically required to work effectively with uncompressed video. In 
many cases, Apple ProRes is a better choice. The data rate of uncompressed 4:2:2 video 
varies according to frame size and frame rate. For example, at a frame size of 1920 x 1080 
and a frame rate of 29.97 fps, the data rate is 1.0 Gbps for uncompressed 8-bit 4:2:2 video 
and 1.3 Gbps for uncompressed 10-bit 4:2:2 video.

WAVE (or WAV)  An audio file format most commonly used for storing uncompressed linear 
pulse code modulation (LPCM) audio data.

wide color gamut  A video color space capable of reproducing a broader palette of 
colors than traditional standard-gamut color spaces. Many display devices—including 4K 
televisions and computer monitors, newer Mac, iOS, and iPadOS devices, and Apple TV 4K 
(when connected to a wide-gamut television)—can render more vivid and lifelike hues (in 
addition to all the hues that standard-gamut devices can display). Accordingly, the video 
industry has adopted a wide-gamut color standard called Rec. 2020.
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